


Safety Precautions 
Observe the following notices to ensure personal safety or to prevent accidents. 
To ensure that you use this product correctly, read this User’s Manual thoroughly before use. 
Make sure that you fully understand the product and information on safety. 
This manual uses two safety flags to indicate different levels of danger. 

WARNING 
If critical situations that could lead to user’s death or serious injury is assumed by 
mishandling of the product. 
-Always take precautions to ensure the overall safety of your system, so that the whole 
system remains safe in the event of failure of this product or other external factor. 
-Do not use this product in areas with inflammable gas. It could lead to an explosion. 
-Exposing this product to excessive heat or open flames could cause damage to the lithium 
battery or other electronic parts. 

CAUTION 
If critical situations that could lead to user’s injury or only property damage is 
assumed by mishandling of the product. 
-To prevent excessive exothermic heat or smoke generation, use this product at the values 
less than the maximum of the characteristics and performance that are assured in these 
specifications. 
-Do not dismantle or remodel the product. It could cause excessive exothermic heat or smoke 
generation. 
-Do not touch the terminal while turning on electricity. It could lead to an electric shock. 
-Use the external devices to function the emergency stop and interlock circuit. 
-Connect the wires or connectors securely. 
The loose connection could cause excessive exothermic heat or smoke generation. 
-Do not allow foreign matters such as liquid, flammable materials, metals to go into the inside 
of the product. It could cause excessive exothermic heat or smoke generation. 
-Do not undertake construction (such as connection and disconnection) while the power 
supply is on. It could lead to an electric shock. 
 

Copyright / Trademarks 
-This manual and its contents are copyrighted. 
-You may not copy this manual, in whole or part, without written consent of Panasonic 

Industrial Devices SUNX Co., Ltd. 
-Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. 
-All other company names and product names are trademarks or registered trademarks of 
their respective owners. 
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Glossary 

Configurator PM 
Configurator PM is a setting tool for Positioning Unit (Interpolation type). Using the Configurator PM 
enables the settings for positioning data and various parameters, and various monitoring. As a tool 
operation mode to activate a motor without using ladder programs is provided in this tool, it is convenient 
especially to confirm the operation at the time of an initial start-up.  
 
E point control 
This is a method of control which is initiated up to an end point, and in this manual is referred to as “E 
point control”. This method is used for a single - speed acceleration/deceleration. It is also called a 
trapezoidal control.  

 
 
P point control 
This refers to control which passes through a “Pass Point”, and is called “P point control” in this manual. 
This method is used when a multi-stage speed is to be specified in the same motion.  

 
 
C point control 
This refers to control which passes through a “Continuance Point”, and is called “C point control” in this 
manual. This method is used for executing continuous E point controls by one-time start.  

 



J point control (JOG positioning control) 
This refers to control which passes through a “JOG Operation Point”, and is called “J point control” in this 
manual. Executing the J point control performs the speed control until a “J pont positioning start contact” 
turns on.   

 
 
Acceleration time/deceleration time 
For the E point control or C point contro, the acceleration time is the time during which the speed 
changes from the startup speed of a motor to the target speed. The deceleration time is the time during 
which the speed changes from the target speed to the stop. For the P point control, the acceleraiton time 
is the time during which the speed accelerates form the current speed to the next target speed, and the 
deceleration time is the time during which the speed decelerates from the current speed to the next 
target speed.  
 
CW, CCW 
Generally, these indicate the direction in which the motor is rotating, with CW referring to clockwise 
rotation and CCW to counterclockwise rotation. 
 
CW/CCW output method (2-pulse output method) 
This is a method in which control is carried out using two pulses, a forward rotation pulse and a reverse 
rotation pulse. With the FP2 positioning unit, this is specified using the control codes of the shared 
memory according to the driver specifications. 
 
Pulse/Sign output method (1-pulse output method) 
This is a method in which control is carried out using one pulse to specify the speed and ON/OFF signals 
to specify the direction of rotation. With the FP2 positioning unit, this is specified using the control codes 
of the shared memory according to the driver specifications.  

 
 
Absolute method (absolute value control method) 
This is a control method in which the target position is specified as an absolute position from the home 
position. This is specified on the positioning data editing screen of the Configurator PM. 
 



  

Increment method (relative value control method) 
This is a control method in which the distance from the current position to the target position is specified 
as a relative position. This is specified on the positioning data editing screen of the Configurator PM.  

 
 
Line driver output 
This is one output format used in pulse output signal circuits, in which the push - pull output of the line 
driver is used. Because this format offers better resistance to noise than the open collector output format, 
a larger distance to the driver is possible. The line driver must be supported on the motor driver side. 
Most servo motor drivers are equipped with this format. 
 
Open collector output 
This is one output format used in pulse output signal circuits, enabling to make connections in 
accordance with the voltage of the power supply being used by connecting an external resistance. This 
is used when connecting a driver that does not have line driver input, such as a stepping motor. 

 
 
Automatic operation 
This is an operation to be automatically executed, and means a position control. 
  
Manual operation 
This is an operation to be executed for an initial boot or adjustments. The home return, JOG operation 
and pulser operation are manual operations. 
Position control 
This is a generic term for the E point contro, P point control and C point control. For each control, the 
control of a single axis and the interpolation control of multiple axes are available.The interpolation 
control can be selected from a 2-axis linear interpolation, 2-axis circular interpolation, 3-axis linear 
interpolation and 3-axis sprial interpolation. 
 



JOG operation 
This refers to an operation in which the motor is rotated only while operation commands are being input. 
This is used to forcibly rotate the motor using input from an external switch, for instance when to make 
adjustments. Depending on the circumstances, this can also be applied to unlimited feeding in some 
cases. 
 
JOG positioning operation 
This refers to an operation to transfer a JOG operation to a positioning operation by an input from the 
external switch. 
 
Home return 
The reference position for positioning is called a Home position and an operation to travel to a Home 
position is called Home return. The home position should be set in advance. This operation moves to the 
home position and its coordinate is set to be 0. 
The motor rotation is reversed automatically when the limit input (+) or the limit input (-) is input and the 
home position or the near home position is searched to return to the home position automatically. 
 
Pulser operation 
A manual operation is available using a device (pulser) which generates pulses manually. The output 
similar to an encoder is obtained from the pulser, and the positioning unit RTEX is equipped with 
exclusive input terminals. It is also called a manual pulse generator. 
 
Deceleration stop 
This is a function that interrupts the operation in progress, slows the rotation and brings it to a stop. The 
deceleration time is the deceleration time during the operation. 
 
Emergengy stop 
This is a function that interrupts the operation in progress, slows the rotation and brings it to a stop. 
Generally, a time shorter than a time for a deceleration stop is set. The deceleration time can be 
specified individually. 
 
Positioning table (Table) 
A series of positioning data such as acceleration/deceleration time, target speed and interpolation 
operation that is necessary for a position control is managed as a positioning table. For example, one 
table is necessary for the E point control, and multiple tables are necessary for the P point control and C 
point control depending on the number of pass points and continuance points. 
 
Limit input (+), limit input (-)  
This is an input to set a limit the motor movement. Limit input (+) is the maximum limit and the limit  input 
(-) is the minimum limit. They are connected to the AMP for the positioning unit RTEX. 
 
Near home (DOG) input 
In order to stop the table at the home position, a position at which deceleration begins is called the near 
home position. This is connected to an external input switch or sensor. It is connected to the AMP for the 
positioning unit RTEX. 
 
Dwell time 
In case of the E point control, a time from the completion of a position commande until the operation 
done flag turns on can be specified as a dwell time.In case of the C point control, a time from the 
deceleration stop until the next table activates can be specified. 



 

Auxiliary output code, auxiliary output contact 
They are used to check the operation of a position control.  
The auxiliary output code is a 16-bit code that can be specified for each positioning table, and enables to 
monitor which positioning table is being executed. 
The exeuction fo the position control can be confirmed by turning an exclusive auxiliary output contact on 
for a constant time. 
 
Software limit 
Limits can be set for the absolute coordinate managed within the positioning unit RTEX. When 
exceeding the setting range of the software limit, an error occurs, and the system decelerates and stops. 
The decelration time can be set individually. 
 
Linear interpolation 
This is the interpolation control that controls positions as the locas of the operations of the 2-axis motor 
with the grouped X axis and Y axis or 3-axis motor with the grouped X axis, Y axis and Z axis becomes a 
straight line. There are two setting methods, which are a composition speed specification and long axis 
speed specification. 
 
Circular interpolation 
This is the inerpolation control that controls positions as the locas of the operation of the 2-axis motor 
with the grouped X axis and Y axis becomes a circular arc. Therea re tow setting methods, which are a 
center point specification and pass point specification.  
 
Spiral interpolation 
This is the interpolation control that controls positions as the loca of the operation of the 3-axis motor 
with the grouped X axis, Y axis and Z axis becomes a spiral. Arbitrary 2 axes describe an arc, and the 
remaining one axis moves to achieve a spiral There are two setting methods, which are a center point 
specification and pass point specification. 
 
Edge type 
This is one of the methods to detect the request signals allocated to this unit. It executes each requested 
process by detecting a trigger that is the leading edge when the request signal turns on. 
Therefore, the next request cannot be accepted until the request signal turns off. 
 
Level type 
This si one of the methods to detect the request signals allocated to this unit. It executes each requested 
process by detecting a trigger that the request signal is on, and continues the requested process while 
the request signal is on. 



Transfer multiple 
With the FP2 positioning unit, this can be specified when the pulser operation function is used. 
Outputting the number of pulses doubled by the number of pulser input signals, the transfer multiple is 
said to be “2”, and when the number of pulses is five times that of the pulser input signals, the transfer 
multiple is said to be “5”. 
Example: Transfer multiple function of the FP positioning unit pulser input 

 
 
Feedback pulse input 
This counts the feedback pulse from the encoder. 2-phase input, direction distinction input and individual 
input can be handled.   
 
2-phase input method 
This counts the signal of 2 pulses in the different phase (A phase, B phase). when A phase preceeds B 
phase, the motor is rotated clockwise(count increment) and  when B phase preceeds A phase,  the 
motor is rotated counter-clockwise (count decrement). 

 
 
Direction distinction input method 
This is a method to count using ON/OFF signal specifying the pulse signal and count direction. 

 
 
Individual input method 
This is a method to count using the count increment pulse signal and the count decrement pulse signal. 
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1.1 Functions of FP2 Positioning Unit 

1.1.1  Functions of Unit 

Positioning can be controlled through the combination of a servo motor and a stepping motor 
with a driver using the pulse train input method.  
- Positioning control using a stepping motor 

 
 
- Positioning control using a servo motor 

 
 
2-axis and 4-axis types are available. 
Multiple axes (up to 4 axes) can be controlled with a single unit. 
- 2-axis type 

 
 
- 4-axis type 

 
Transistor output type (Open collector) and Line driver output type are available. 
The unit has 2 types; one is the Line driver output type, can handle the high-speed control, and another  
is the Transistor output type, can handle the driver can be connected with only the open collector such  
as a stepping motor. When either can be used, we recommend the Line driver output type. 
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Can confirm operations without ladder programs 
Using the tool operation function of the Configurator PM enables a test run without a ladder program, 
and enables to confirm various items such as the rotating direction, various input contacts or automatic 
operation settings. 
 

 
 
Two-axis and three-axis interpolation controls 
The 2-axis linear interpolation, 2-axis circular interpolation, 3-axis linear interpolation and 3-axis spiral 
interpolation contols can be performed. 
 

1.1.1  Unit Types 

FP2 Positioning Unit (Interpolation type) 
Type Function Part number Product number 

2-axis transistor output type 2-axis control FP2-PP2T AFP243710 
4-axis transistor output type 4-axis control FP2-PP4T AFP243720 
2-axis line driver output type 2-axis control FP2-PP2L AFP243711 
4-axis line driver output type 4-axis control FP2-PP4L AFP243721 

 
Setting software 

Name Applicable Ver. Specifications Product number 
Control Configurator PM Ver. 1.2 English AFPS66510 
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1.2 Restrictions on Units Combination 
For the FP2, when the system is configured, the other units being used should be taken into 
consideration, and a power supply unit with a sufficient capacity should be used.  
 
FP2 Positioning Unit (Interpolation type) 

Type Part number Product number Current consumption (from power supply) 
2-axis type FP2-PP2T AFP243710 300 mA 
2-axis type FP2-PP2L AFP243711 300 mA 
4-axis type FP2-PP4T AFP243720 300 mA 
4-axis type FP2-PP4L AFP243721 300 mA 
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2.1 Parts and Functions 

 
 

 Operation status display LEDs 
These display operation conditions for two axes. 
 

 Operation status display switch (for FP2-PP4T, FP2-PP4L only) 
This switches operation display between for axes 1 and 2, and for axes 3 and 4. 
 

 User interface connector for 1-axis/2-axis 
This connector is used to connect a motor driver or external interface. 
 

 User interface connector for 3–axis/4–axis (for FP2-PP4T, FP2-PP4L only) 
This connector is used to connect a motor driver or external interface 
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2.2  Operation Status Display LEDs 
Information on two axes can be displayed at once on the LEDs. For a 4-axis type, display can be 
switched between axes 1 and 2, and axes 3 and 4 with the switch. The LEDs show the same information 
for each axis. 
 

 
Unit front 
 
Operation Status Display LEDs 

LED Description Color LED ON LED OFF LED blinks 

A 

Pulse 
output  
signal A  
display 
Note1) 

When set to 
pulse/sign output 
method 

Green ― During stop 
During pulse 
output 

When set to 
CW/CCW output 
method 

Green ― 
During stop 
(forward) 

During pulse 
output (forward) 

B 

Pulse 
output  
signal B 
display 
Note1) 

When set to 
pulse/sign output 
method 

Green
Reverse 
direction 
command 

Forward 
direction 
command 

― 

When set to 
CW/CCW output 
method 

Green ― 
During stop 
(reverse) 

During pulse 
output (reverse) 

CL 
Counter clear signal output 
display 

Green Output: ON 
Output: 
OFF 

― 

D Near home status display Note2) Green ON OFF ― 
Z Home input status display Note2) Green ON OFF ― 

PA 
Pulse input A signal display 
Note3) 

Green
Displays the input status of the pulse inupt A 
signal. 

PB 
Pulse input B signal display 
Note3) 

Green
Displays the input status of the pulse inupt B 
signal. 

ERR Setting value error display Red Error occurs Normal ― 

ALARM Hardware error display Red 
Hardware 
error occurs  

Normal ― 

Note1) The pulse output signal display LEDs (A and B) blink at the output frequency (speed). For this 
reason, they may appear to light steadily at high-speed output. 

Note2) The near home (D) and home input (Z) LEDs light when the respective input becomes valid. The 
input valid logic is specified using the control codes in the program.  
(In the manual,”Z” is described as “ZSG”,and “D” is described as “DOG”.) 

Note3) Pulse input signal (PA) and (PB) display the pulse signal input status. 
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 Wiring 
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3.1 Connecting using Connector for a Discrete-Wire 

3.1.1  Specifications of Connector for Discrete-wire 

This is a connector that allows loose wires to be connected without removing the wire’s insulation. The 
pressure connection tool (AXY52000FP) is required to connect the loose wires. 

  
 
Suitable wire (twisted wire) 
Size Official cross section area Insulation thickness Rated current 
AWG22 0.3 mm2

1.5 to 1.1 dia. 3A 
AWG24 0.2 mm2

 
Discrete-wire connector (attached with a unit) 

Manufacturer Component parts Unit type and required quantit 
2-axis type 4-axis type 

Panasonic Electric 
Works SUNX Co., Ltd. 

 Housing(40P) 1 pc   x 1 1 pc   x 2 
Semi-cover(40P) 2 pcs x 1   2 pcs x 2 
Contact (for AWG22 and AWG24) 5pin 8 pcs x 1 8 pcs x 2 

* 1 connector set and 2 connector sets are supplied with the 2-axis type unit and 4-axis type unit, 
respectively.  

 
Dedicated tool 
Manufacturer Product number 
Panasonic Electric Works SUNX Co., Ltd. AXY52000FP 
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3.1.2 Assembly of Discrete-Wire Connector 

The wire end can be directly press-fitted without removing the wire’s insulation, saving labor. 
Procedure: 
1. Bend the contact back from the carrier, and set it in the pressure connection tool. 

 
 
2. Insert the wire without removing its insulation until it stops, and lightly grip the tool. 

 
 
3. After press-fitting the wire, insert it into the housing. 

 
 
4. When all wires has been inserted, fit the semi-cover into place. 
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3.2  Input/Output Specifications and Terminal Layout 

3.2.1  Input /Output Specifications 

 
 
2 connectors are used to connect 4-axis type and 1 connector to connect 2-axis type. The signal pins for 
2 axes are assigned to 2-axis type connector. AX1 and, and AX3 and 4 connectors for 4-axis type has 
the completely same pin assignments, so that the same pin No. functions the same. Between the 
Transistor type and the Line driver type, the pulse output terminal performace is different, but the input 
terminal and the power supply terminal are in the same specifications. 
 
Output terminals （Transistor Output type） 

Pin number 
Circuit Signal name  Item Description 

1/3 axis 2/4 axis 

A1 A10 

 

Pulse output A: 
5V DC output 

O
ut

pu
t S

pe
ci

fic
at

io
ns

 Output format Open collector 

B1 B10 
Pulse output A: 
Open collector 

Operating voltage range 
4.75 V DC to  
26.4 V DC 

A2 A11 
Pulse output B: 
5V DC output 

Max. load current 15 mA 

B2 B11 
Pulse output B: 
Open collector 

ON Max. voltage drop 0.6 V 

 
Output terminals （Line driver output type） 

Pin number 
Circuit Signal name  Item Description 

1/3 axis 2/4 axis 

A1 A10 

 

Pulse output A: 
Line driver (+) 

O
ut

pu
t S

pe
ci

fic
at

io
ns

 

Output format 

Line driver 
output 
Equivalent to 
AM26C31 

B1 B10 
Pulse output A: 
Line driver (-) 

A2 A11 
Pulse output B: 
Line driver (+) 

B2 B11 
Pulse output B: 
Line driver (-) 



 3-5 

Output terminals (common) 
Pin number 

1/3 axis 2/4 axis 
Circuit Signal name  Item Description 

Output format Open collector 
A7 A16 

Deviation 
counter clear (+)

Operating voltage range 
4.75 V DC to 
26.4 V DC 

Max. load current 10mA 
B7 B16 

Deviation 
counter clear 
（-） O

ut
pu

t S
pe

ci
fic

at
io

ns
 

ON Max. voltage drop 1V 

Note) The deviation counter clear signal is output when the Home Return is complete. Its ON time can 
be selected using the Control code of the shared memory, from the range of 1 to 100 ms.  
 
Power supply terminals and Earth terminals （common） 

Pin number Circuit Signal name  Item Description 

A19/B19 
F.E.  
(Field Earth) 

― ― 

A20  
External power 
supply input: 
24 V DC (+) 

Power supply voltage 
range 

21.4 V DC to 
26.4 V DC 

B20  

External power 
supply input:  
24 V DC (-) 

P
ow

er
 s

pe
ci

fic
at

io
ns

 

Current consumption 

4-axis type: 
90 mA or less 
2-axis type:  
50 mA or less 

Note) F.E.s and the External power supply input terminals between 2 connectors are respectively 
conducted internally for 4-axis type. 
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Input Terminals（common） 
Pin number 

1/3 axis 2/4 axis 
Circuit Signal name Item Description 

Operating voltage range 21.6V DC to  
26.4V DC 

Min. ON voltage/current 19.2V DC/5.5mA 

Max. OFF voltage/current 2V DC/2mA 

Input impedance Approx 3kΩ 

A3 A12 
Home input:  
24 V DC (+) 
(Z24) 

In
pu

t s
pe

ci
fic

at
io

ns
 

Min. input pulse width 100µs or more 

Operating voltage range 
3.5V DC to 5.25 
(5V DC,Line driver 
specifications) 

Min. ON voltage/current 3V DC/4mA 

Max. OFF voltage/current 1V DC/0.5mA 

Input impedance Approx. 390Ω 

A4 A13 
Home input:  
5V DC (+) 
(Z5) 

In
pu

t s
pe

ci
fic

at
io

ns
 

Min. input pulse width 100µs or more 

B3 B12 Home input
（−） - - - 

B4 B13 COM - - - 

Operating voltage range 21.6V DC to 26.4V 
DC 

A5 A14 Near home input 
(DOG) 

Min. ON voltage/current 

Near home input 
(DOG) 
19.2V DC/5.0mA 
 
Over limit input (+) 
(Limit +) 
Over limit input (−) 
(Limit − ) 
19.2V DC/2.6mA 

A6 A15 Over limit input 
(+) (Limit +) Max. OFF voltage/current 2V DC/1.5mA 

B6 B15 Over limit  input 
( −) (Limit − ) 

In
pu

t s
pe

ci
fic

at
io

ns
 

Input impedance 

Near home input 
(DOG) 
Approx 3.6kΩ 
 
Over limit input (+) 
(Limit +) 
Over limit input (−) 
(Limit − ) 
Approx 6.8kΩ 

B5 B14 - - - - 

A8 A17 Pulse input A (+) Operating voltage range 
3.5 to 5.25 V DC 
(5V DC, Line driver 
specifications) 

B8 B17 Pulse input A (−) Min. ON voltage/current 3V DC/4mA 
A9 A18 Pulse input B (+) Max. OFF voltage/current 1V DC/0.5mA 

Input impedance Approx 390Ω 
B9 B18 Pulse input B (−)

In
pu

t s
pe

ci
fic

at
io

ns
 

Min. input pulse width 0.5µs(max. 1MHz 
each phase) 
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Note: Please use under the specifications for pulse input A, B signal.  
 
- 2 phases input method 
 

 
 
 
 
 
 
- Direction distinction input method 
 

 
 
 
 
 
 
- Individual input method 
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3.3  Supplying Power for Internal Circuit Drive 
Always make sure an external +24V DC power supply is connected to the pins for external input power 
supply (pin No. A20 and B20). 
 
The applied 24V DC passes through an internal DC/DC converter and is converted to 5 V DC voltage. It 
is then supplied to the various internal circuits as a power supply for internal circuit drive of the pulse 
command output pin. 
 

3.3.1  Line Driver Output Type 

  

3.3.2 Transistor Output Type 

The power supply for the pulser command output circuit can be taken from the 5V DC out put pins (pin 
No. A1, A2, A10 and A11) 

 

 Note: 
When open collector pulse output (Transistor output) is used, the value of 15 mA per signal should be 
used as a guide. If exceeds the 15 mA, the appropriate resistance should be added. 
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3.4  Connection of Pulse Command Output Signal 
Two types of output types are available for the FP2 positioning unit due to two types of the interfaces of 
motor driver. Select and connect one or the other, depending on the interface of the motor driver being 
used. 
Note: 
We recommend using twisted - pair cables as the wiring between the positioning unit output and the 
motor driver, or twisting the cables to be used. 
 

3.4.1 Line Driver Output type 

 
 

3.4.2 Transistor Output Type 

 
Note: 
A value of 15 mA per signal should be used as a guide. If exceeds this, resistance should be added. 
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3.5  Connection of Deviation Counter Clear Output Signal 
(for servo motor) 
This is an example showing connection of the counter clear input to the servo motor driver. An external 
power supply (+5 V DC to +24 V DC) must be provided for the connection. 
 

 
 
Note: 
Always use twisted - pair cables for wiring. 
The Current which can be conducted as the deviation counter clear output signal is 10 mA max. 
If 10 mA is exceeded, resistance should be added. 
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3.6 Connection of Home Input/Near Home Input Signals 
This is the home signal input connection for the home return. 
It should be connected to the Z phase output (Line driver output or Transistor output) of the motor driver, 
or to an external switch and sensor. 
Note: 
We recommend using twisted - pair cables as the wiring between the positioning unit output and the 
motor driver, or twisting the cables used. 
 

3.6.1  Connection of Home Input (When connecting to motor driver Z phase 
output) 

 
 

3.6.2  Connection of Home Input (When connecting to an external 
switch/sensor) 
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3.6.3  Connection of Near Home Input Signal 

 
 

Note) No. B4 and B13 are common for the Near home input, Over limit input(+),Over limit input(-) and 
Positioning control start input (Timing input). 

 

3.6.4  Connection of Over limit Input Signal 

  
Note) No. B4 and B13 are common for the Near home input, Over limit input(+),Over limit input(-) and 

Positioning control start input (Timing input). 
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3.7 Connection of Pulse Input 
The signal output style may differ depending on Pulser or Encoder. Connect in accordance with the 
output style. Line driver type, Transistor open collector type and Transistor-resistance pull-up type are 
available for the output styles. 
The same pulse input terminal is used for Pulser input operation and Feedback pulse count, so it is used 
for either. 
Note: 
- We recommend using twisted - pair cables for connections, or twisting the cables used. 
- When counting the 2-phase input such as the input from the encoder, set the pulse input transfer 

multiple to “4 multiple setting” (x 4) or “2 multiple setting” (x 2) using the control code to prevent 
counting error.   

3.7.1  Line Driver Type 

  

3.7.2  Transistor Open Collector Type 

  

3.7.3  Transistor - resistor Pull - up Type 
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3.8 Precausions on Wiring 
Connect the wire in less than or the following length between the Transistor output type and the motor 
driver , and between the Line driver output type and the motor driver.  
 
<Signals applicable> 
- Transistor output 
- Line driver output 
- Deviation counter clear output 
 

Output type Product number Wiring length 
AFP243710 

Transistor output type 
AFP243720 
AFP243711 

Line driver output type 
AFP243721 

10 m 
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4.1 Safety Circuit Design 
Example of a safety circuit 
Installation of the Over limit switch 
 

 
 
Safety circuit based on Positioning unit 
Install Over limit switches as shown above. 
Connect them to Over limit input(+) and Over limit input (-) of the Positioning unit. 
 
Safety circuit based on external circuit 
Install the safety circuit recommended by the manufacturer of the motor being used. 
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4.2  Before Turning ON the Power 
Items to check before turning ON the power 
System configuration example 
 

 
 

 Checking connections to the various devices 
Check to make sure the various devices have been connected as indicated by the design. 

 Checking the installation of the external safety circuit  
Check to make sure the safety circuit (wiring and installation of Over limit switch) based on an external 
circuit has been installed securely. 

 Checking the installation of the safety circuit based on the Positioning unit. 
Check to make sure the connection of the Positioning unit with Over limit switches.  
Check to make sure that Over limit switches have been properly installed.  

 Checking the procedure settings for turning ON the power supplies 
Make sure settings have been entered so that power supplies will be turned ON according to the 
procedure outlined in section 5.3.1, “Procedure for Turning ON the Power”. 

 Checking the CPU mode selection switch 
Set the CPU in the PROG. mode. Setting it in the RUN mode can cause inadvertent operation. 
 

 Note: 
When the power to the PLC is turned ON, internal data in the shared memory will be cleared (set to 
zero). Check to see whether the start flag for the various operations of the positioning unit are OFF. If 
they are ON, a set value error will occur for the positioning unit, unless the data settings for the shared 
memory have been entered. 
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4.3  Procedure for Turning ON the Power 
When turning ON the power to the system incorporating the positioning unit, the nature and statuses of 
any external devices connected to the system should be taken into consideration, and sufficient care 
should be taken that turning ON the power does not initiate unexpected movements or operations. 
 

4.3.1 Procedure for Turning ON the Power 

Procedure: 
1. Turn ON the power supplies for input and output devices connected to the PLC (including the power 

supply for the line driver output or open collector output). 
2. Turn ON the power supply for the PLC. 
3. Turn ON the power supply for the motor driver. 
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4.3.2  Procedure for Turning OFF the Power 

Procedure: 
1. Check to make sure the rotation of the motor has stopped, and then turn OFF the power supply for the 

motor driver. 
2. Turn OFF the power supply for the PLC. 
3. Turn OFF the power supplies for input and output devices connected to the PLC (including the power 

supply for the line driver output or open collector output). 
 

 
 
Precautions when rebooting the system 
The flags of the operation memory are initialized simply by initializing the CPU, but the flags of the 
shared memory for the positioning unit are retained. 
If the positioning unit is operated with data still in the shared memory, operation may be carried out 
based on any set values which have been retained, in some cases. The flags of the shared memory can 
be cleared when the power supply is turned OFF. 
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5.1 Confirming while the Power is ON 
Items to check when the power is ON 
System configuration example 
 

 
 
Checking should be carried out in the four general stages described below. 
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5.2 Pulse Output Mode and Switch Logic Settings 
The direction which an elapsed value increases is called CW and the direction which it decreases is 
called CCW on the positioning unit. Therefore, the limit input in the CW direction is Limit (+) valid, and 
the input in the CCW direction is Limit (–) valid. 
 
The following settings for the positioning unit iare required for the establishment of the system. 

- Pulse output mode  
- Various input valid logics 

 
[Parameter setting area] 
1st axis 

Bank 
Offset 
address 

Name Descriptions 

02H 015H Pulse output 
control code 

 

  
 
2nd axis 

Bank 
Offset 
address 

Name Descriptions 

0CH 015H Pulse output 
control code Refer to the 1st axis. 

 
3rd axis 

Bank 
Offset 
address 

Name Descriptions 

16H 015H Pulse output 
control code Refer to the 1st axis. 

 
4th axis 

Bank 
Offset 
address 

Name Descriptions 

20H 015H Pulse output 
control code Refer to the 1st axis. 

 
 

 Reference:  <17.6.2 Parameter Setting Area> 
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5.3 Setting the Pulse Input Mode 
The positioning unit supports the pulse input for every axis, and various input devices can be connected. 
The followings are input targets. It is necessary to specify which input is selected. 

Input target Description 
Pulser - Set for using the manual pulser. 

- Using the pulser operation setting code enables to specify the pulse of an axis (ch) to 
be used. 

- The manual pulser is supported for 2-phase input (phase A/pahse B) and multiple 
(x4) only. 

Feedback 
pulse 

- Set for connecting an encoder to monitor the rotation of a motor. 
- The positioning unit performs the feedback pulse count for its axis using the pulse 

input, and detects the difference between a command value and the feedback value. 
(Moving amount automatic check function) 

- The encoder is supported for 2-phase input (phase A/phase B) only. 
High-speed 
counter 

- Set for using as a general-purpose counter input. 
It is availablel fro various input modes (2-phase input, direction discrimination input, 
individual input). 

- The positioning unit stores the input pulse in the monitor area. 
 
 [Parameter setting area] 
1st axis 

Bank Offset 
address Name Descriptions 

02H 007H Pulse input mode

Sets the pulse input signal. 
Set according to the application to be used as the pulse input.  

   
2nd axis 

Bank Offset address Name Descriptions 
0CH 007H Pulse output control code Refer to the 1st axis. 

 
3rd axis 

Bank Offset address Name Descriptions 
16H 007H Pulse output control code Refer to the 1st axis. 

 
4th axis 

Bank Offset address Name Descriptions 
20H 007H Pulse output control code Refer to the 1st axis.  

 Reference:  <17.6.2 Parameter Setting Area> 
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5.3.1 Restrictions on Pulse Input Setting 
The positioning unit supports various input mode and input purposes, however, the combinations of the 
settings are limited. 
 

Pulse input purpose  

Pulser Feedback 
pulser 

High-speed 
counter 

Forward A A A 
Rotation direction 

Reverse A A A 
2-phase input A A A 
Direction 
discrimination input 

N/A N/A A Input mode 

Individual input N/A N/A A 
X 1 N/A A A 
X 2 N/A A A 

Multiple 
X 4 A A 

Available only 
when setting the 

input mode to 
“2-phse input”. 

Allowed A A A Pulse input 
allowed/not allowed Not allowed N/A N/A A 

Clear N/A A N/A 

Pu
ls

e 
in

pu
t m

od
e 

pa
ra

m
et

er
 

Pulse count vaue 
set/clear Set N/A A A 

A: Available    N/A: Not available 
 
 
- When setting the pulse input purpose to “Pulser”, the settings other than the 2-phase input (direction 

discrimination input, individual input) cannot be specified for the pulse input mode. 
- When setting the pulse input purpose to “Feedback pulse”, the settings other than the 2-phase input 

(direction discrimination input, individual input) cannot be specified for the pulse input mode. 
- The pulse input transfer multiple (x4) can be specified only when setting the pulse input mode to “2-

phase input”. The “Direction discrimination input” and “Individual input” cannot be specified. 
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5.4 Checking the Safety Circuit 

5.4.1 Checking the External Safety Circuit 

Check the safety circuit recommended by the motor manufacturer to confirm the power supply cutoff of 
the motor driver and other functions by turnning ON the CW/CCW driving inhibition switch of an external 
circuit.  
 

5.4.2 Checking the Safety Circuit based on Positioning Unit 

Procedure 1 
Using forced operation of Over limit switch for the external safety circuit of the positioning unit, check to 
see if the Over limit input is being properly taken into the positioning unit. 
Whether or not Over limit input is taken can be confirmed by the input flag. In addition, the Over limit 
input valid logics can be changed using the control code in the user program. 
 
Procedure 2 
If necessary, input a program to start the JOG operation. Then operate the over Over limit input forcibly 
to check whether the motor will stop. 
It can be also checked by the tool operation of the Configurator PM, without programs. 
 
Procedure 3 
Using the JOG operation, check to see if the Over limit switch is functioning properly.  
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5.5 Operation Check 

5.5.1 Checking the Operation of the Near Home Switch and Home Switch 

Procedure 1 
Using forced operation of the home input and near home input, check to make sure the operation display 
LEDs on the positioning unit light. At the same time, using programming tools, monitor the X_6 and X_7 
flag (When X_6 is ON, the home input is properly done. When X_7 is ON, the near home input is 
properly done.), and check LEDs light. 
 
Procedure 2 
Input the home return program, and actually carry out a home return to check if near home input 
produces deceleration. 
Points to check 
The input valid logic for the home input and near home input is determined by the control codes of the 
program. 
 
 
Procedure 3 
Using repeated JOG operation and home return operation, check to make sure the table stops properly 
at the home position, with no offset. 
Points to check 
There may be times when near home input, the home input position, and the return speed cause offset 
from the home position. 
 
Procedure 4 
If the table does not stop precisely at the home position, either change the position of the near home 
input, or reduce the home return speed, so that the table stops precisely at the home  position. 
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5.5.2 Procedure 5: Checking Rotating and Moving Directions and Moving 
Distance 

Procedure 1 
Check whether the rotating and moving direction of the motor and the moving distance is correct or not. 
The operations can be easily confirmed using the tool operation function of the Configurator PM without 
programs. 
 
Procedure 2 
Confirm the rotating direction and moving direction of the motor by the JOG operation. Select the 
“Online” → “Tool operation” on the menu of the Configurator PM, and make the servo on for the 
corresponding axis to execute the the JOG operation. When using the program, turn on the forward JOG 
and reverse contact after turning on the servo on contact. 
Points to check 
The rotating direction is determined according to the installation of the ball screw or the “CW/CCW 
direction setting” of the parameter. 
 
Procedure 3 
Confirm whether the moving distance is as designed or not by the position control. Set the table 1 of the 
positioning data using the Cofigurator PM, and select the “Online” → “Tool operation” on the menu of the 
Configurator PM after downloading the table to the positioning unit, and make the servo on for the 
corresponding axis to execute the the JOG operation. When using the program, set the position control 
starting table, and then turn on the positioning start contact after turning on the servo on contact. 
Points to check 
The moving distance is determined according to the pitch of the ball screw, deceleration gear rate or 
setting movement amount of the positioning data. 
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5.6 Procedure 6: Settings of Parameters and Positioning 
Data 
Procedure 1 
Set the parameters and positioning data in accordance with the actual operation. 
Points to check 
The parameters and positioning data is stored in the shared memory of the positioning unit. Although 
there are two methods to store the data in the shared memory, it is recommended to set the parameters 
that are not changed so often using the Configurator PM.  
- Use the Configurator PM 
- Use the program to write into the shared memory 
 
Procedure 2.1 
When using the Configurator PM 
Boot the Configurator PM, and select “Set axis” → “Parameter settings” on the menu to set the various 
parameters. Also, create the table for the positioning table on the positioning data editing screen. After 
setting the parameters and data, download them to the positioning unit. 
Points to check 
After the parameters and posiioning data was downloaded, the display to select whether to write them 
into the FROM (flash memory) or not is shown. When they are written into the flash memory, the 
parameters and positioning data in the flash memory will be automatically reflected to the shared 
memory when the power supply of the PLC turns on. When they are not written into the flash memory, 
the parameters and positioning data finaly stored in the flash memory will be reflected when the power 
supply of the PLC turns on. 
 
Procedure 2.2 
When using the ladder program to write into the shared memory 
Use the F151 instruction to write various parameters and positioning data into the shared memory. 
 

 Reference:  
• For the information on the storage addresses of various parameters and postioning data,  

<17.6 Details of Each Axis Setting Area in Shared Memory> 
• For the information on writing positioning data using ladder programs, 

<14.1.3. How to Use Standard Area and Extended Area of Positioning Data> 
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6.1 Occupied I/O Area 
The input (X)/output (Y) should be allocated to use the Positioning Unit (Interpolation type) as well as 
other I/O units. 256 points (128-point input/128-point output) are occupied for any axis types. 
 

Type Number of occupied points (allocated using a tool software) 
2-axis type 
4-axis type 

Input: 128 points 
Output: 128 points 
(128SX/128SY) 

 
The I/O numbers vary depending on the installed position of the positioning unit. 
 

 Reference:  <FP2/FP2SH User’s Manual  ARCT1F320> 
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6.2 Allocation of Each Contact 
Followings are occupied I/O when FP2 Positioning unit (Interpolation type) is installed in the slot 0. 

Contact 
allocation 

Target 
axis Name Descriptions 

X0 All axes Positioning 
preparation ready 

Indicates that the initial preparation within the positioning unit was 
completed, and announce the system started running. 

X1 - - - 
X2 - - - 

X3 All axes Write FROM Announces that data such as positioning parameters in the shared memroy 
is being written in FROM. 

X4 All axes Tool operation 
Contact to indicate the Tool operation from Configurator PM. 
The start-up from I/O is not available during the Tool operaiton. If it 
performs, a warning will occur.  

X5 - - - 
X6 - - - 

X7 All axes Recalculation 
done 

If the recalculation request contact (Y_7) turns on, the positioning data of 
the shared memory (standard area) will be restructured. This contact will 
turn on after restructuring completes. 
If the recalculation request contact (Y_7) turns on again, this contact will be 
off once. 
Note) It is used only when the positioning data has been rewritten by laddar 
programs. 

X8 - - - 
X9 - - - 
XA - - - 
XB - - - 
XC - - - 
XD - - - 
XE - - - 

W
X

0 

XF - - - 
X10 - - - 
X11 - - - 
X12 - - - 
X13 - - - 
X14 - - - 
X15 - - - 
X16 - - - 
X17 - - - 
X18 1 axis 
X19 2 axis 
X1A 3 axis 
X1B 4 axis 

BUSY Turns on when the corresponding axis is operating. 

X1C - - - 
X1D - - - 
X1E - - - 

W
X

1 

X1F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

X20 1 axis 

X21 2 axis 

X22 3 axis 

X23 4 axis 

Operation done 

Turns on when the operation command for the corresponding axis 
completed and the position error became in the specified completion width.  
For P point control and C point control of the automatic operation, turns on 
when the operation for all the tables completed. 
After this contact turned on, the on-state continues until the next control 
activates. 

X24 - - - 
X25 - - - 
X26 - - - 
X27 - - - 
X28 1 axis 
X29 2 axis 
X2A 3 axis 
X2B 4 axis 

Home return done 
Turns on when the home return operation for the corresponding axis 
completed. After this contact turned on, the on-state continues until the next 
control activates. 

X2C - - - 
X2D - - - 
X2E - - - 

W
X

2 

X2F - - - 
X30 1 axis 
X31 2 axis 
X32 3 axis 
X33 4 axis 

Home The contact to monitor the external home input signal for the corresponding 
axis. 

X34 - - - 
X35 - - - 
X36 - - - 
X37 - - - 
X38 1 axis 
X39 2 axis 
X3A 3 axis 
X3B 4 axis 

Near home The contact to monitor the external near home input signal for the 
corresponding axis. 

X3C - - - 
X3D - - - 
X3E - - - 

W
X

3 

X3F - - - 
X40 - - - 
X41 - - - 
X42 - - - 
X43 - - - 
X44 - - - 
X45 - - - 
X46 - - - 
X47 - - - 
X48 1 axis 
X49 2 axis 
X4A 3 axis 
X4B 4 axis 

Auxiliary contact

Turns on when the corresponding positioning table of the corresponding 
axis was executed. 
Use Configurator PM or directly write in the shared memory for setting to 
able/disable the auxiliary contact. 

X4C - - - 
X4D - - - 
X4E - - - 

W
X

4 

X4F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

X50 Limit + 
X51 

1 axis 
Limit - 

X52 Limit + 
X53 

2 axis 
Limit - 

X54 Limit + 
X55 

3 axis 
Limit - 

X56 Limit + 
X57 

4 axis 
Limit - 

Monitor contact of the limit + and – for the corresponding axis. 
During the positioning operation, JOG operation or pulser operation, 
performs the deceleration stop when the limit input that is an extension of 
the operating direction turned on. 
The deceleration stop time during the limit input can be changed in the 
shared memory. 
It will be the contact for the automatic inversion when performing the home 
return. 

X58 - - - 
X59 - - - 
X5A - - - 
X5B - - - 
X5C - - - 
X5D - - - 
X5E - - - 

W
X

5 

X5F - - - 
X60 1 axis 
X61 2 axis 
X62 3 axis 
X63 4 axis 

Error annunciation

Turns on when an error occurs on the corresponding axis. 
The contacts of all axes turn on if an error occurs on all axes. 
The details of the error can be confirmed in the error annunciation area of 
the shared memory. 

X64 - - - 
X65 - - - 
X66 - - - 
X67 - - - 
X68 1 axis 
X69 2 axis 
X6A 3 axis 
X6B 4 axis 

Warning 
annunciation 

Turns on when a warning occurs on the corresponding axis. 
The contacts of all axes turn on if a warning occurs on all axes. 
The details of the warning can be confirmed in the warning annunciation 
area of the shared memory. 

X6C - - - 
X6D - - - 
X6E - - - 

W
X

6 

X6F - - - 
X70 - - - 
X71 - - - 
X72 - - - 
X73 - - - 
X74 - - - 
X75 - - - 
X76 - - - 
X77 - - - 
X78 - - - 
X79 - - - 
X7A - - - 
X7B - - - 
X7C - - - 
X7D - - - 
X7E - - - 

W
X

7 

X7F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y80 All axes System stop Contact for requesting the system stop. When it turns on, all axes will stop 
at the deceleration time 0. 

Y81 - - - 
Y82 - - - 
Y83 - - - 
Y84 - - - 
Y85 - - - 
Y86 - - - 

Y87 All axes Recalculation 
request 

Turn on this signal when each positioning data (standard area) in the shared 
memory was changed. 
The positioning data after the table number starting the recalculation 
specified in the shared memory can be restructured and will be executable 
by turning on this signal. 
When restructuring of the positioning data completes, the recalculation done 
contact (X_7) will turn on. 
 
Note) It is used only when the positioning data has been rewritten by ladder 
programs. 

Y88 - - - 
Y89 - - - 
Y8A - - - 
Y8B - - - 
Y8C - - - 
Y8D - - - 
Y8E - - - 

W
Y

8 

Y8F - - - 

Y90 1 axis 

Y91 2 axis 

Y92 3 axis 

Y93 4 axis 

Positioning start-
up 

Requests the positioning control for the corresponding axis. 
The starting table is specified in the area for specifying the position control 
starting table number in the shared memory. 
(The operation is the edge type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y94 - - - 
Y95 - - - 
Y96 - - - 
Y97 - - - 

Y98 1 axis 

Y99 2 axis 

Y9A 3 axis 

Y9B 4 axis 

Home return start-
up 

Requests the home return for the corresponding axis. 
The settings for the direction or pattern of the home return are specified by 
Configurator PM or the home return operation setting area in the shared 
memory. 
(The operation is the edge type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y9C - - - 
Y9D - - - 
Y9E - - - 

W
Y

9 

Y9F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y100 JOG forward 
Y101 

1 axis 
JOG reverse 

Y102 JOG forward 
Y103 

2 axis 
JOG reverse 

Y104 JOG forward 
Y105 

3 axis 
JOG reverse 

Y106 JOG forward 
Y107 

4 axis 
JOG reverse 

Requests the JOG operation for the corresponding axis. 
The settings for acceleration time, etc are specified by Configurator PM or 
the JOG operation settings in the shared memory. 
(The operation is the level type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y108 - - - 
Y109 - - - 
Y10A - - - 
Y10B - - - 
Y10C - - - 
Y10D - - - 
Y10E - - - 

W
Y

10
 

Y10F - - - 
Y110 1 axis 
Y111 2 axis 
Y112 3 axis 
Y113 4 axis 

Emergency stop 

Requests the emergency stop for the corresponding axis. 
The deceleration time for the emergency stop is specified in the emergency 
stop deceleration time area in the shared memory. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y114 - - - 
Y115 - - - 
Y116 - - - 
Y117 - - - 
Y118 1 axis 
Y119 2 axis 
Y11A 3 axis 
Y11B 4 axis 

Deceleration stop

Requests the deceleration stop for the corresponding axis. 
The deceleration time for the deceleration stop is the deceleration time in 
the operation. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y11C - - - 
Y11D - - - 
Y11E - - - 

W
Y

11
 

Y11F - - - 
Y120 1 axis 

Y121 2 axis 
Y122 3 axis 
Y123 4 axis 

Pulser operation 
enabled 

Requests the permission for the pulser operation of the corresponding axis. 
The multiple setting and other settings for the pulser operation are specified 
by Configurator PM or the pulser operation setting area in the shared 
memory. 
(The operation is the level type.) 

Y124 - - - 
Y125 - - - 
Y126 - - - 
Y127 - - - 
Y128 1 axis 
Y129 2 axis 
Y12A 3 axis 
Y12B 4 axis 

J point speed 
change 

Request the change in the speed during the JOG positioning operation. 
The JOG positioning operation is specified in the JOG positioning operation 
target speed area. 
(The operation is the level type.) 

Y12C - - - 
Y12D - - - 
Y12E - - - 

W
Y

12
 

Y12F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y130 - - - 
Y131 - - - 
Y132 - - - 
Y133 - - - 
Y134 - - - 
Y135 - - - 
Y136 - - - 
Y137 - - - 
Y138 1 axis 
Y139 2 axis 
Y13A 3 axis 
Y13B 4 axis 

J point positioning 
start 

Requests to start the next positioning operation during the JOG positioning 
operation. 
(The operation is the edge type.) 

Y13C - - - 
Y13D - - - 
Y13E - - - 

W
Y

13
 

Y13F - - - 
Y140 1 axis 

Y141 2 axis 

Y142 3 axis 

Y143 4 axis 

Request error 
clear 

Requests the error clear for the corresponding axis. 
The processing to recover from errors is performed and the error logs are 
cleared by turning on this signal. 
 
Note) Unrecoverable errors cannot be recovered even if this signal turned 
on. 

Y144 - - - 
Y145 - - - 
Y146 - - - 
Y147 - - - 
Y148 1 axis 
Y149 2 axis 
Y14A 3 axis 
Y14B 4 axis 

Request warning 
clear 

Requests the warning clear for the corresponding axis. 
The warning logs are cleared by turning on this signal. 

Y14C - - - 
Y14D - - - 
Y14E - - - 

W
Y

14
 

Y14F - - - 
Y150 - - - 
Y151 - - - 
Y152 - - - 
Y153 - - - 
Y154 - - - 
Y155 - - - 
Y156 - - - 
Y157 - - - 
Y158 - - - 
Y159 - - - 
Y15A - - - 
Y15B - - - 
Y15C - - - 
Y15D - - - 
Y15E - - - 

W
Y

15
 

Y15F - - - 
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7.1 Connection With Computer 
 

 
 
 
Install the Configurator PM on a computer as well as a programming tool. 
For the FP2, connect to the tool port of the FP2 CPU unit. 
 



7.2 Functions of Configurator PM 

7.2.1 Overview 

The Configurator PM is the Windows®-compliant setting software. 
Using the Configurator PM enables to make the settings for the FP2 positioning unit (Interpolation type) 
and FP2/FPΣ positioning unit RTEX. 
The positioning operations can be set by the input method similar to Microsoft® Excel. 
 
Copy & Paste 
Copies and pastes the data you are editing into Microsoft® Excel, etc. 
Also, pastes the position data calculated in Microsoft® Excel into Configurator PM. 
 
Parameters and data transfer 
Transfers the setting parameter or positioning data to the positioning unit (Interpolation type). 
Also, reads the parameters or positioning data within the positioning unit (Interpolation type). 
 
Batch checking of parameters and data 
Checks the contents of parameters and positioning data all at once. 
Jumps to the place automatically if there are parameters or data out of the range. 
Also, this function is automatically executed when sending parameters or positioning data to the 
positioning unit. 
 
Verify function 
Verifies the parameter or positioning data you are editing with the files on the disk or the settings values 
in the positioning unit. 
You can jump the cursor to the data with differences from the dialog of the result of verification. 
 
Search and Replace functions 
The search or replacement for data item each is possible. Twenty search strings and twenty replace 
strings can be memorized, so it is convenient for the repeated search or replacement. 
 
Showing comments for all parameters and positioning data 
Shows the guidance for all parameters and positioning data when making the settings. 
 
Up to 100 one-byte characters of data comments can be input. 
Up to 100 one-byte characters (50 two-byte characters) of comments can be input for thepositioning data 
of 1 table each. 
It is useful for the revision or the control of programs. 
However, the comments cannot be stored within the positioning unit. 
 
Tool operation 
The tool operation enables to check the operation at the time that the system is installed or the operation 
of setting parameters without any ladder program. 
Also, the teaching function is provided, which reflects the current position to the movement amount of 
data item.  
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7.2.2 Basic Specifications 

Operating environment 
Applicable OS Windows®98 

Windows®Me 
Windows®2000 
Windows®XP 

Required HDD capacity 20MB or more 
Recommended CPU Pentium 200MHz or higher 
Recommended resolution 800 * 600 or more 
Recommended memory 64MB or more (Depending on OS) 
Recommended display colors 256 colors or more 

 
 
Application specifications  
No. of characters of data comment 100 bytes/table 
No. of histories of search/replace strings 20 each 
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7.3 Installing Configurator PM 
Procedure for installing Configurator PM in a personal computer 
The Configurator PM is installed in a personal computer using the procedure outlined below. 
For Windows® 2000, Windows® XP, please be aware that the Configurator PM cannot be installed 
unless you log in at the Administrator level when booting the system 
 
1. Exit any applications currently running. 
If there are any applications currently running, exit them. 
 
2. Insert the setup CD. 
Insert the Configurator PM setup CD in the CD drive. 
 
3. Select “Run”. 
Click on the “Start” button at the lower left of the screen, or press the Ctrl + ESC keys to display the start 
menu of Windows® Operation System. Select “Run”. 
 

    
 
4. Enter the name of the file on which the function is to be run. 
When “Run” is selected, the dialog box shown at the left is displayed. Enter d:\setup.exe and click on 
the [OK] button. 
 

    
 

 Note: 
The drive name “d” varies depending on the computer configuration. 
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5. A confirmation message is displayed. 
When the setup program is booted, a confirmation dialog box is displayed. Confirm the contents and 
click on the [Next] button. To interrupt the installation, click on [Cancel]. 
 

 
 
6. Confirm the licensing agreement. 
The licensing agreement confirmation box is displayed. If you agree to all of the items in the displayed 
license agreement, click on [Yes].  
The setup process begins. 
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7. Register the user information. 
A user information dialog box is displayed. Fill in the [User Name], [Company Name] and [Serial 
Number] items, and click on the [Next] button. 
The serial number is noted on the user card included in the Configurator PM package. Make sure it is 
entered correctly. 
 

 
 
The contents entered here can be confirmed under “Version Information” on the splash screen, and in 
the Help function, when the Configurator PM is booted. 
 
8. Select the installation destination. 
A dialog box is displayed where the folder to which the Configurator PM is to be installed can be 
confirrmed. To install the program in the displayed folder, click on the [Next] button. 
The standard destination is “c:\Program Files\Panasonic-EW SUNX Control”. 
To install the program in a different folder, click on the [Browse] button and specify a folder. 
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9. Select the program folder. 
A dialog box is displayed where the program folder name can be confirmed. To use the displayed folder 
name, click on the [Next] button. 
The standard folder name is “Panasonic-EW SUNX Control”.  
To use a different folder name, simply enter that name. 
 

 
 
10. The installation process begins. 
A message is displayed on the screen indicating that the installation is in progress, and the Configurator 
PM setup begins. 
 

 
 



11. Display the Readme file. 
When the setup process has been completed, a dialog box showing the completion is displayed. 
 
The latest information is described in the Readme file. 
Click  on [Yes]. 
 

 
 
12. Reboot the computer. 
When all of the process has been completed, a dialog box is displayed, confirming that the computer will 
be rebooted. 
Select either radio button, reboot at once or reboot later, aand click on [Finish]. 
 

 
 

 Reference:  
The above group icon is displayed only when the installation completed. The procedures of the start-up, 
refer to the sections of “Starting Configurator PM” and “Exiting Configurator PM”. 
 

 Note: 
Never eject the CD during the installation process. 
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7.4 Starting Configurator PM 
Click the [Start] button on Windows, and click [Program], [Panasonic-EW SUNX Control] and [Setting 
software] in the order. And then click [Configurator PM]. The following dialog is shown. 
 

   
 
[New] Create a new setting data for the positioning unit. 
[Open] Read the existing setting data. 
[Upload from Unit] Read the setting data of the positioning unit. 
[Exit] End this software. 

 
 



7.5 Treating Files 

7.5.1 New 

Create a new file. 
 
1. Select [File] → [New] in the menu bar, or click [New file] icon in the toolbar. The [Select axes] 

dialog is shown. 
 

   
 
 
2. Select a unit type to be used. 

   
 
3. Check the axes to use, and click [OK]. 
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4. The [Interpolation group settings] dialog is shown. Set the grouping that the interpolation 
operation is executed for the selected axes in the above setting.  

     
Independent The area of the axes to be used as independent axes without performing 

the interpolation operation. 
Interpolation group The area of the groupings of the axes to perform the interpolation 

operation. Up to 4 groups can be specified. 
Synchronous group The area to be used for setting the synchronous operation. 
Synchronous 
operation 1 

It is used to set the synchronous operation group 1. Check the box to 
perform the synchronous operation. 

Synchronous 
operation 2 

It is used to set the synchronous operation group 2. Check the box to 
perform the synchronous operation. 

Synchronous mode It is used to set the synchronous operation mode. Select either Mode A or 
B. 

Master axis It is used to set the master axis for performing the synchronous operation. 
Slave axis It is used to set the slave axis for performing the synchronous operation. 

The slave axis can be specified for an independent axis only. 
Difference value It is used to set the maximum value of the difference between the master 

axis and the slave axis during the synchronous operation. 
Difference behavior It is used to set the operation to be performed when the difference 

between the master axis and slave axis exceeded the difference value. 
Initialize It is used to initialize the setting for the interpolation group and the 

synchronous operation. 
OK Determine the allocation of the interpolation groups. 
Cancel Back to the previous setting for the axes to use. 
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5. Drag the axis icon at the top of the window with the mouse and drop it in any area of the 
groups (A to D) at the bottom of the window to determine the axes of the interpolation groups.  

    
 
6. To perform the synchronous operation, check the synchronous operation and specify each 

setting. 
 

   
Clicking [OK] determines the interpolation group. 
 
7. The data setting screen is shown, which enables the setting. 
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7.5.2 Reading from Files 

Read the parameter settings or data settings from files. 
 
1. Select [File] → [Open] in the menu bar, or click [Open] icon in the toolbar. The following dialog 

is shown. 
 

   
 
2. Select the drive where the file is saved in the [Location of File] box. 
 
3. Select the file name in the box listing the folders and files under the [Location of File] box. 

If the file you want to read is not indicated, double-click the folder name where the file is saved. 
Double-click the sub-folder names until the sub-folder where the file is saved is open. 

 
4. Click the file name. 
The following contents are recorded in the positioning setting file (* npm) that can be used in this 
software. 
 ・Axis information 
 ・Parameter settings 
 ・Data settings 
 ・Data comments 
 
5. Click [Open]. 
 

 Key Point: 
Click the file name indicated at the bottom of the [File] menu to open the file that was previously active 
 

 Note: 
Both files for the positioning unit (Interpolation type) and the positioning unit RTEX are read, however, it 
is necessary to change the unit type to read the files for the positioning unit RTEX. 
 

 Reference: <7.9 Changing Axis Information> 
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7.5.3 Saving Files 

Save the parameter settings or data settings in files. 
The contents saved in files are axis information, parameter settings, data settings and data comments. 
 
1. The following methods are available to save files. 
(The operation procedures and the behaviors of this software differ depending on the case of overwrite 
save and the one saves as a new file.) 
 
Saving a file by overwriting an existing file. 
Select [File] => [Save] in the menu bar, or click the [Save] icon in the toolbar. 
 
Saving a file by naming a new name. 
Select [File] => [Save As] in the menu bar.  
 
When saving a file by overwriting an existing file, the operation completes when the function is selected. 
When saving a file by name a new name, the following dialog is shown. 
 

   
 
 
2. Input a new file name in the [File name] box. 
 
3. Click [Save]. 
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7.5.4 Setting File Properties 

Set the property of a file (creator and comment).  
 
1. Select [File] => [File property] in the menu bar to specify the file property. 

The following dialog is shown. 
 

   
 
2. Input the creator and comment, and click [OK]. 
Up to 10 one-byte characters (5 two-byte characters) for the creator and 40 one-byte characters (20 two-
byte characters) for the comment can be input. 
 
 
 

7.6 Exiting Configurator PM 
Select [File] → [Exit] in the menu bar to quit the Configurator PM. 
 
If the file is not unsaved, a message asking for the save is shown. 
・Click [Yes] to save the file. 
・Click [No] to end the Configurator PM without saving the file. 
 

7-16 



7.7 Connection to Positioning Unit 

7.7.1 Selecting Slot Number 

When accessing the positioning unit in the Configurator PM, specify the slot number that the positioning 
unit is installed in advance. 
 
Select [Online] → [Select slot] in the menu bar. The following dialog is shown.  
 

   
 
 
The positioning unit is installed on the CPU unit with the motherboard. The slot number for the unit 
installed on the right side of the CPU unit is the slot number 0, and then the slot number varies 
depending on the installed position of the motherboard. 
 

 7-17 



7.7.2 Communication Settings 

Set the condition to communicate with the PLC that the positioning unit has been installed. 
 
Select [Option] → [Communication settings] in the menu bar. The following dialog is shown. 
 

   
 
Name Setting value Default 
Port number Select a COM port to be used. COM1 
Baud rate 1200 to 115200 bps 9600 
Data length 7 bits, 8 bits: Set either 7 bits or 8 bits to send 1 byte. 8 bits 
Stop bit 1 bit, 2 bits 1 bit 
Parity None, Odd, Even Odd 
Timeout Set the communication timeout time with PLC (0 to 60 seconds). 5 seconds 
Automatic 
communication 
settings 

When the communication condition is different from the PLC, 
check the items to search the matched conditions. 
If all items are not checked, the communication condition is not 
automatically searched. 

All items are 
checked. 
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7.8 Parameter Settings 
Set the initial operation for the positioning unit. 
 
1. Select [Set axis] → [Parameter settings] in the menu bar, or click the [Parameter setting] icon 

in the toolbar. 
 
2. The parameter setting dialog is shown. Set the parameters. 
 

   
 
Setting items 
Parameter name Description 
Unit setting The unit to be used for setting each axis. 
Pulse number per rotation The pulse number per rotation. 

(It should be cancelled down with the movement amount per 
rotation.) 

Movement amount per rotation The movement amount per rotation. 
(It should be cancelled down with the pulse number per 
rotation.) 

Pulse output mode The output method for the pulse 
- Pulse/Sign method 
- CW/CCW method 
The rotation direction for the pulse output Pulse output rotation direction 
CW+: + direction is CW. 
CCW+: + direction is CCW. 

Limit switch Enable/disable the limit switch. 
Limit (+) valid logic The logic of the limit switch in “+” direction 
Limit (-) valid logic The logic of the limit switch in “-“ direction 
Home valid logic The logic of the home switch 
Near home valid logic The logic of the near home switch 
Pulse input purpose The purpose of the pulse input 
Pulse input rotation direction The rotation (CW/CCW) direction for the pulse input 
Pulse input mode The input method for the pulse input 
Pulse input transfer multiple The input transfer multiple for the pulse input 
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Parameter name Description 
Software limit (Positioning control) Enable/disable the software limit in the positioning control. 
Software limit (Home return) Enable/disable the software limit in the home return. 
Software limit (JOG operation) Enable/disable the software limit in the JOG operation. 
Upper limit of software limit The upper limit value of the software limit. 
Lower limit of software limit The lower limit value of the software limit. 
Auxiliary output mode Enable/disable the auxiliary output contact and auxiliary output 

code. 
Auxiliary output ON time (ms) The time that the auxiliary output contact is ON. 
Moving amount check The operation after checking the moving amount when using 

the moving amount check function. 
Moving amount check value (Pulse) The checking threshold for the moving amount check function. 
Moving amount check correction 
numerator 
Moving amount check correction 
denominator 

Execute the moving amount check function by multiplying the 
pulse input value by the following ratio. 
(Moving amount check correction numerator) / (Moving amount 
check correction denominator) 

Moving amount check time (ms) The time interval for executing the moving amount check 
function. 

Startup speed The startup speed for all operations (Initial speed) 
Home return – Setting code The pattern of the home return. 
Home return – Direction The operating direction of the home return. 
Home return – Acceleration time The acceleration time in the home return. 
Home return – Deceleration time The deceleration time in the home return. 
Home return – Target speed The target speed in the home return. 
Home return – Creep speed The speed to search the home position after the proximity 

input. 
Home return – Coordinate origin The current value after the completion of the home return. 
JOG operation – Acceleration/ 
Deceleration pattern settings 

The acceleration/deceleration pattern mode in the JOG 
operation. 

JOG operation – Acceleration time The acceleration time in the JOG operation. 
JOG operation – Deceleration time The deceleration time in the JOG operation. 
JOG operation – JOG target rate The target rate in the JOG operation. 
Emergency stop deceleration time 
(ms) 

The deceleration time when the emergency stop is requested 
by the input contact. 

Limit stop deceleration time (ms) The deceleration time for the deceleration operation when the 
limit is input. 

Error stop deceleration time (ms) The deceleration time for the deceleration operation when an 
error occurs 

J point control – Accel./Decel. 
Pattern 

The acceleration/deceleration pattern mode when performing 
the J point control (speed point) 

J point control – Acceleration time 
(ms) 

The acceleration time when performing the J pont control 
(speed point) 

J point control – Deceleration time 
(ms) 

The deceleration tiem when performing the J point control 
(speed pont) 

J point control – Target speed The target speed when performing the J point contro. (speed 
point) 

Pulser operation setting code The pulser input (1 to 3) in the pulser operation. 
Pulse input method The input method in the pulser operation 
Pulser operation ratio numerator 

Pulser operation ratio denominator 

No. of movement pulse is calculated by multiplying the No. of 
input pulse from the pulser by the ratio below. 
(Numerator of ratio of pulser operation)/(Denominator of ratio of 
pulser operation)  

Pulse operation maximum speed The maximum operation speed in the pulser operation 
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OK Update the parameter settings with the specified contents. 
Cancel Close this dialog without updating the parameter settings. 
Copy axis Specify the axes of the source and destination to copy the parameter setting 

between the axes.The following dialog is shown by clicking the [Copy axis] 
button. Specify the axes and click [OK]. 

   
Initialize Initialize the parameter settings. 
Help Indicate the help for this function. 

 
3. Click [OK] to determine the settings. 
Click [OK] to determine the edited settings.  
Click [Cancel] to cancel the edited settings. 
 
 
 

7.9 Changing Axis Information 
Change the used axes or the groups for the setting data being edited. 
 
Select [Set axis] → [Change axis] in the menu bar. The following dialog is shown. 
 

   
 
 

Unit type Select either one of the following unit type according to the model to be used. 
- Positioning unit RTEX 
- Positioning unit (Interpolation type) 

Axis selection Select the axis to be used. 
 
 
The editing dialog for the interpolation axis group is shown by clicking [OK] after selecting the 
used axes.  
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7.10 Setting Positioning Data 
Set the various data to perform the positioning operation. They are set on the data setting screen. 
 
This is an example for the interpolation group of 1 axis and 2 axis. 
Positioning data editing screen 
 

   
 
Setting items 
Parameter Name Description 
Operation pattern Select one from the following operation patterns. 

・End point control: Execute the trapezoidal control of only one table. 
・Continuance point control : Execute the trapezoidal control continuously. 

Specify the end point at the end of the continuance point control. 
・Pass point control: Execute the continuous speed change control. Specify 

the end point at the end of the pass point control. 
・J point: Execute the speed control. Specify the end point at the end of the 

J point control. 
Interpolation operation Select the operation of interpolation. 
X-axis control method Select either increment or absolute coordinate. 
X-axis movement 
amount 

Input the movement amount of X axis. The movement amount depends on 
the unit system specified in the parameter settings. 

X-axis auxiliary point It is used when the circular interpolation is selected, and ignored when the 
linear interpolation is selected. 
The details of the auxiliary points differ depending on the type of circular 
interpolation. 
・Circular interpolation (Center point): The auxiliary point is used as the X 

axis of the center point. 
・Circular interpolation (Pass point): The auxiliary point is used as the X 

axis of the pass point. 
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Parameter Name Description 
Y-axis movement 
amount 

Input the movement amount of Y axis. The movement amount depends on 
the unit system specified in the parameter settings. 

Y-axis auxiliary point It is used when the circular (spiral) interpolation is selected, and ignored 
when the linear interpolation is selected. 
The details of the auxiliary points differ depending on the type of circular 
interpolation. 
・Circular interpolation (Center point): The auxiliary point is used as the Y 

axis of the center point. 
・Circular interpolation (Pass point): The auxiliary point is used as the Y 

axis of the pass point. 
Acceleration/decelera-
tion pattern 

Select the pattern to accelerate/decelerate. 

Acceleration time (ms) Set the acceleration time. It is set in the ms unit. 
Deceleration time (ms) Set the deceleration time. It is set in the ms unit. 
Interpolation speed Set the interpolation speed. 
Dwell time (ms) Set the time from when the positioning command in the end point control 

completes till when the completion flag (Y contact) turns on. 
For the continuance point control, it is the wait time between each table. For 
the pass point control, the dwell time is ignored. 

Auxiliary output Set the auxiliary output code. When the auxiliary output is set to enable in 
the parameter settings, the auxiliary output code specified here is output. 

Comment Input the comments of tables. 
The comments are saved in the positioning setting file (*.npm) of the PC 
only. They are not saved in the positioning unit. 

Note) The details for the settings in each parameter are indicated in the guidance bar. 
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7.11 How to Edit Positioning Data 

7.11.1 Inputting Positioning Data 

The cursor on the positioning data editing screen can be moved by clicking, double-clicking with the 
mouse and with the arrow, Enter and Tab keys. 
 
Move the cursor to the data item. 
Using the arrow key enables to move the cursor to the adjacent cell in the direction of the arrow. 
 
Using the mouse enables to move the cursor only by clicking the cell. If the cell you want to specify is not 
in the data editing screen, scroll the screen using the scroll bar until you can see the cell. 
 
Input the data item. 
Pressing any character input key or double-clicking the mouse on the cell you want to input data enables 
to input the data as below. 
 

   
 
However, in the column with the combo box as below, the data item can be set only by inputting the 
initial character on the keyboard. For example, input [C] directly in the column of the pattern. Then the 
data item will be [C: Continuance point]. Also, it is possible to select with the arrow keys after the input is 
enable. 
 

   
 
Press [Enter] key to determine. Press [ESC] key to cancel. 
 
Click the tab of a sheet to change to the sheet. 
When using the keyboard, press [Ctrl]+[Page Up] or [Ctrl]+[Page Down]. 
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7.11.2 Copying Positioining Data 

The data contents can be stored in the clipboard by setting the preference field of the cells on the 
positioning data editing screen. The data stored in the clipboard are pasted in Microsoft® Excel as well 
as the data editing screen of this software. 
 

 Note: 
Pasting is not possible if the content in the clipboard is different from the attributes of the pasted area. 
If values are contained in the contents of the clipboard, the values can be pasted up to the maximum 
digit number of the data item. 
 

 Key Point: 
If the pasted area is different from the data in the clipboard, paste as shown below.  
 

   
 
 

7.11.3 Selecting All Cells 

All cells can be selected before the operations such as copy or paste are done.  
It is convenient to copy all the settings of the specified axis to another axis. 
 
Press [Ctrl] + [A] on the keyboard, or click the [Table No.] header on the upper-left corner of the data 
editing screen with the mouse to select all cells. 
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7.11.4 Searching Character Strings 

1. Select [Edit data] → [Find] in the menu bar, or click the [Find] icon in the toolbar. The following 
dialog is shown. 

 

   
 
2. Input the character string to search in the [Character string to find] box, and select the target 

line (setting item). 
3. Click [Next]. 
 

 Key Point: 
Press [Esc] to end the search. 
Press [Replace] to change the replacement screen. 
 
 

7.11.5 Replacing Character Strings 

1. Select [Replace] → [Find] in the menu bar. The following diaglo is shown. 
 

   
 
2. Input the character string to search in the [Character string to find] box. 
3. Input the character string after the replacement in the [Character string after replacement]. 
4. Select the target line (setting item). 
5. Click [Next] and [Replace], or [Replace all]. 
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7.11.6 Selecting Lines 

The cells in a line or multiple lines can be selected before the operations such as copy or paste are done.  
 
Click the [Table No.] header on the upper-left corner of the positioning data editing screen with the 
mouse to select the all the cells in one line. Drag the mouse up and down (holding down the left click) to 
select multiple lines. 
 

7.11.7 Selecting Colums 

It is convenient for editing data collectively before the operations such as copy and paste, or for data 
item each.  
 
Click the header on the upper corner of the data editing screen to select all the cells in one column. Drag 
the header holding down the left click on the mouse to select multiple columns. 
 

7.11.8 Editing Data Items Collectively  

Select a series of the data item in the same column and change them all at once. 
 

   
 
 
1. Select the part to change with the mouse or the up and down arrows on the keyboard. 
2. Input the data item. For example, press [A] on the keyboard to change the X-axis pattern from 

“I: Increment” to “A: Absolute”. 
3. Press the [Enter] key to determine the content of the data item. 
 
The data item can be edited collectively in the above procedure. 
 
 

 Key Point: 
When inputting the data item using the edit box (e.g. movement amount, acceleration time, etc.), input 
the data item directly using the numbered keyboard. 
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7.12 Customizing Software 
Changing Column Width 
Widen the column width to enable all the characters to be shown during data editing, or narrow it when 
the resolution of the PC you use is small. As the column width is saved when this software quits, the 
same width will be recreated at the next time of the start-up.  
 
1. The mouse cursor changes to a mark like “+” by moving the mouse cursor to the right end of 

the column you want to widen the width in the header on the upper corner of the data editing 
screen. 

2. Move the cursor left and right with clicking down the left button of the mouse. 
3. Release the left button of the mouse to finish the change in the column width. 
 

 Key Point: 
The column width returns to the one on start-up by double-clicking the mouse in the state of the above 
procedure 1. 
 
- Showing/Hiding Toolbar 
S
 

et to show or hide the toolbar. 

Select [View] → [Toolbar], and check or uncheck in the menu. 
The toolbar is indicated with the check, and it is not indicated without the check. 
 
- Showing/Hiding Status Bar 
S
 

et to show or hide the status bar. 

Select [View] → [Status Bar], and check or uncheck in the menu. 
The status bar is indicated with the check, and it is not indicated without the check. 
 
- Showing/Hiding Parameter-Status Bar 
S
 

et to show or hide the parameter-status bar. 

Select [View] → [Parameter-Status Bar], and check or uncheck in the menu. 
The parameter-status bar is indicated with the check, and it is not indicated without the check. 
 
- Showing/Hiding Guidance Bar 
S
 

et to show or hide the guidance bar on the main screen that provides guidance on various settings. 

Select [View] → [Guidance Bar], and check or uncheck in the menu. 
The guidance bar is indicated with the check, and it is not indicated without the check. 
 
- Configuration setting 
Select [Option] → [Configuration] in the menu bar. The following dialog is shown. 
The current folder in the setting data file can be changed. 
 

    
Current folder Specify a current folder to be used for this software. 
Tool operation monitoring time Set the communication error detection time in the Tool operation. 
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- Setting Font 
Select [Option] → [Font] in the menu bar. The following dialog is shown. 
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7.13 Checking Settings 

7.13.1 Checking Parameters and Data Values 

Collectively check the parameter setting first and then the positioning data if the values are within the 
range. If an error is found in the parameter setting, the parameter setting dialog is automatically indicated 
and the position where the error exists is focused. Also, if an error is found in the positioning data, the 
cursor moves to the position where the error exists. 
 
Select [Debug] → [Check Parameters and Data] in the menu bar, or click the [Check Parameter 
and Data] icon in the toolbar. 
 
Verifying File Contents 
Verify the file currently being edited, and the files on the disk or the information in the unit. The following 
procedure is for the verification with the files on the disk. 
Verify the axis information, parameters and positioning data collectively. 
 
Select [Debug] → [Verify] → [File] in the menu bar. 
The dialog to select the file to verify is shown as below. Select the file to verify.  
The contents of the file currently being edited are verified with the selected file and the result is indicated 
in the dialog below. 
 

   
 
Click [Close] to close the dialog. 
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7.14 Transferring Setting Data 

7.14.1 Uploading Setting Data from Positioning Unit 

Read the parameters and positioning data of the positioning unit. 
 
1. Make the connection between a PC and PLC, and configure the settings. Then, select [File] → 

[Upload from Unit] in the menu bar, or click the [Upload from Unit] icon in the toolbar. 
 
2. Execute reading the unit. 
 

 Note: 
The process of reading may take for a few minutes. Click [Cancel] to stop the read. 
 
3. When the read completes successfully, a message asking if the data comment will be held is 

indicated. 
- Click [Yes] to leave all the comments set in the data. 
- Click [No] to clear all the comments. 

 

 Note: 
To execute the upload, previously determine the target positioning unit by the communication settings 
and selecting the slot number.  
The data comments are not stored in the positioning unit. They are managed in the setting files of the PC. 
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7.14.2 Downloading Setting Data to Positioning Unit 

Transfer the setting parameters and positioning data to the positioning unit. 
 
1. Make the connection between a PC and PLC, and configure the settings. Then, select [File] → 

[Download to Unit] in the menu bar, or click the [Download to Unit] icon in the toolbar. 
The dialog is shown as below. 

 

   
 
Axis information + 
Parameter setting data Select this to download axis information and parameter only. 

Axis information + 
Parameter setting data + 
Positioning setting data 

Select this to download all setting data. The range of the positioning 
data to download can be specified. 

Positioning setting data range 
All Download all setting data. 
Table number range Download the positioning data in the specified range. 
OK Start downloading with the selected settings. 
Cancel Stop downloading. 

 
2. Click [OK] to start the download to the positioning unit. The time required for the download 

depends on the range of the positioning setting data. 
 

 Note: 
To execute the download, previously determine the target positioning unit by the communication settings 
and selecting the slot number. 
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3. Once the download completes, the following dialog is shown. 
 

   
 
Clicking [Yes] indicates the following dialog and save the setting data in the FROM (Flash Memory) 
within the positioning unit. The saved setting data is automatically read when the power supply of the 
PLC turns on. 
 

        ⇒           
 
Click [No] not to write the setting data to the FROM. The downloaded data is erased when the power 
supply of the PLC turns off. 
 

 Note: 
Writing to FROM is restricted up to 10000 times. The current number of write can be chekced with the 
data monitor. 
 

7.14.3 Writing Settings to FROM 

Save the setting data written in the positioning unit in the FROM (Flash Memory) within the positioning 
unit. The saved setting data is automatically read when the power supply of the unit turns on. 
 
Make the connection between a PC and PLC, and configure the settings. Then, select [Tool] → 
[Write to FROM] in the menu bar. The following dialog is shown. 
 

   
 
Clicking [Yes] indicates the following dialog and save the setting data in the FROM (Flash Memory) in 
the unit. The saved setting data is automatically read when the power supply of the PLC turns on.  
 

        ⇒           
 
Click [No] not to write the setting data to the FROM. The downloaded data is erased when the power 
supply of the PLC turns off. 
 

 Note: 
Writing to FROM is restricted up to 10000 times. The current number of write can be checked with the 
data monitor. 
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7.15 Data Monitor 
The internal data of the positioning unit can be monitored. 
Make the connection between a PC and PLC, and configure the settings. Then, select [Online] → 
[Data Monitor] in the menu bar. The following dialog is shown. 
 

   
 
Axis [Group] The axis No. and group names to be monitored. 
Synchronous group Synchronous group name and master/slave axis type 
Synchronous mode The operation mode of synchronous operation 
Synchronous condition Synchronous/Asynchronous condition 

Active table number The table number that the positioning data is being executed or has 
completed. 

Auxiliary output code Auxiliary output code 
Current value(pulse) The current value of the positioning unit 
Current value after unit 
conversion The current value of the positioning unit after the unit conversion 

Pulse input value Monitor the pulse value to be input. 

Deviation Monitor the deviation value when activating the automatic difference 
behavior function. 

State of axis The operating states of axes or error and warning occurrences. 
Error code The latest error code when an error occurred. 
Error clear Clear the error by clicking this button, when an error occurred. 
Warning code Indicate the latest warning code when a warning occurs. 
Warning clear Clear the warning by clicking this button, when a warning occurred. 
Help Indicate the help regarding this function. 
Close Close this dialog. 

 

 Note: 
If a recoverable error occurred in the positioning unit, click [Error Clear] to clear the error.  
If a warning occurred in the positioning unit, click [Warning Clear] to clear the warning.  
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7.16 Status Display 
The states of the motors of each axis can be monitored. 
Make the connection between a PC and PLC. Then, select [Online] → [Status Display] in the 
menu bar. The following dialog is shown. 
 

   
 
Model The model name of positioning unit 
Axis [Group] The axis number and group names to be monitored. 
Status The operating states of axes 
Home proximity The ON/OFF state of the near home switch 
Home The ON/OFF state of the home switch 
Limit + The ON/OFF state of the limit + switch 
Limit - The ON/OFF state of the limit - switch 

Number of writing to FROM The number of writing the setting data to FROM in the positioning 
unit. 

Firmware version The version of the software (firmware) for the positioning unit 
Hardware version The version of the hardware for the positioning unit 
Help Indicate the help regarding this function. 
Close Close this dialog. 
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7.17 Tool Operation 
As the positioning unit can activate without a ladder program in the tool operation, the operation can be 
checked quickly. 
Select [Online] → [Tool operation] in the menu bar, and click the [Tool operation] icon in the 
toolbar. The following dialog is shown. 

   
The followings are the operations that are selectable in the tool operation. 
 
Home return 
Move to the home position in the machine coordinate. 
 
Positioning  
Operate from the starting table number according to the settings of the data stored in the positioning unit. 
 
JOG operation 
The specified axis can be moved to the specified direction with the specified speed, while the operation 
command is on. 
 
Teaching 
Control the axis manually using the same operation as the JOG operation, and reflect the resulting 
positioning address on the data editing screen. 
 

 Note: 
It is not possible to change the mode to the tool operation mode during the ladder operation of PLC. 
If any communication error occurs during the tool operation, the positioning unit detects the error and 
stops automatically. 
If the previous tool operation did not finish properly due to a communication error, etc., the tool operation 
mode will be cancelled forcibly when the next tool operation starts. 
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7.17.1  Tool Operation – Home Return 

After the power supply of the positioning unit turned on, the zero (home) of the machine position 
(coordinate) does not always agree with the zero of the coordinate value in the positioning unit. 
Therefore, coordinate the home of the machine position with the home of the positioning unit. This 
etting is called Home return.  s 

1. Click [Home Return] in the tool operation dialog. The following dialog is shown. 

   
 
Axis [Group] The axis numbers and group names to be monitored. 
Synchronous 
group 

The group name and the master/slave axis type for the synchronous 
operation. 

Synchronous mode The operation mode for the synchronous operation. 

Synchronous 
condition 

Indicate the synchronous/asynchronous condition in the synchronous 
operation. For the synchronous operation in the operation mode A, clicking 
[Synchronous change] changes the condition. 

Current value 
Indicate the feedback value for every axis after unti conversion. 
Clicking [Coordinate origin] displays the dialog for inputting the value, and it 
enables to change the value after the home return. 

Unit The unit of position for each axis specified in the parameter settings. 

Deviation (Pulse) Indicate the deviation when activating the moving amount automatic check 
function. 

Home return mode Indicate the contents of the home return setting code registered in the 
positioning setting data. 

Start/Stop 

Execute the operation to start/stop the home return. 
・Click [Start] to execute the home return operation. The button name 

changes to [Stop]. 
・Click [Stop] to execute the deceleration stop operation. The button name 

changes to [Start]. 
State of axis The operating states of axes or error and warning occurrences. 
Error code The latest error code when an error occurred. 
Error clear Clear the error by clicking this button, when an error occurred. 
Warning code Indicate the latest warning code when a warning occurs. 
Warning clear Clear the warning by clicking this button, when a warning occurred. 

Speed rate 
The target speed of the home return specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the specified 
speed rate. 
Clicking [Speed rate] shows the dialog for inputting the value..  

 Note: 
If a recoverable error occurred in the positioning unit, click [Error Clear] to clear the error.  
If a warning occurred in the positioning unit, click [Warning Clear] to clear the warning.  
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2. Execute the home return. Click [Start] for the axis to execute the home return. 
 
3. Click [Close] to close the dialog. 
 

 Note: 
This dialog cannot be closed during the home return operation. 
 
 

7.17.2 Tool Operation - Positioning 

The test run is possible like actual positioning operations. 
Specifying the starting table number enables to check if the positioning/interpolation from the starting 
table operates properly. 
 

 Note: 
For the positioning operation, the setting data should be downloaded to the positioning unit in advance.  
The operations after the starting table number vary depending on the Operation patterns.  
 
1. Click [Positioning] in the Tool operation dialog. The following dialog is shown. 
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Axis [Group] The axis numbers and group names to be monitored. 

Synchronous group The group name and the master/slave axis type fot the synchronous 
operation. 

Synchronous mode The operation mode for the synchronous operation. 

Synchronous 
condition 

Monitor the synchronous/asynchronous condition in the synchronous 
operation.  
For the synchronous operation in the operation mode A, clicking 
[Synchronous change] changes the condition. 

Current value 
Monitor the feedback value for every axis after unit conversion. 
Clicking [Current value update] displays the dialog for inputting the value, 
and it enables to change the current value. 

Unit Indicate the unit of positions for the axes specified in the parameter settings 
each from the positioning unit. 

Deviation (Pulse) Indicate the deviation when activating the moving amount automatic check 
function. 

Active table number Indicate the table number during the operation or when it completes. 

Starting table number The starting table number for the positioning control. 
Click [Change] to change the starting table number. 

Operate/Stop 

Execute the operation to start/stop the home return. 
・Click [Operate] to execute the positioning operation. The button name 

changes to [Stop]. 
・Click [Stop] to execute the deceleration stop operation. The button name 

changes to [Operate]. 
State of axis The operating states of axes or error and warning occurrences. 
Error code The latest error code when an error occurred. 
Error clear Clear the error by clicking this button, when an error occurred. 
Warning code Indicate the latest warning code when a warning occurs. 
Warning clear Clear the warning by clicking this button, when a warning occurred. 

Speed rate 

The target speed of the home return specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the 
specified speed rate. 
Clicking [Speed rate] shows the dialog for inputting the value. 

 

 Note: 
If a recoverable error occurred in the positioning unit, click [Error Clear] to clear the error.  
If a warning occurred in the positioning unit, click [Warning Clear] to clear the warning.  
 
2. Click [Change] in the starting table number field to specify the starting table number. 
Specify the starting table number and click [Operate] to start the positioning opration. 
 

 Note: 
• In the positioning unit, the positioning operation for the interpolation group is performed to request the 

start and stop for the smallest number of axes in the group.  
• In the tool operation, the positioning operation for the interpolation group is performed by clicking 

[Operate] for any axes. However, due to the above specifications, a warning message is shown when 
any [Operate] button other than the one for the smallest axis number is clicked.   

 
3. Click [Close] to close the dialog. 
 

 Note: 
This dialog cannot be closed during the positioning operation. 
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7.17.3 Tool Operation – JOG Operation 

Each axis can be operated manually using the tool operation. 
 
1. Click [JOG operation] in the tool operation dialog. The following dialog is shown. 
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Axis [Group] The axis numbers and group names to be monitored. 

Synchronous group The group name and the master/slave axis type for the synchronous 
operation. 

Synchronous mode The operation mode for the synchronous operation. 

Synchronous 
condition 

Monitor the synchronous/asynchronous condition in the synchronous 
operation. 
For the synchronous operation in the operation mode A, clicking 
[Synchronous change] changes the condition. 

Current value 
Monitor the feedback value for every axis after unit conversion. 
Clicking [Current value update] displays the dialog for inputting the value, 
and it enables to change the current value. 

Unit Monitor the unit of positions for the axes specified in the parameter settings 
each from the positioning unit. 

Deviation (Pulse) Monitor the deviation when activating the moving amount automatic check 
function. 

JOG target speed Monitor and display the target speed in the JOG operation. 
Click [Change] to change the target speed for the JOG operation. 

JOG [+] Click [+] to perform the forward rotation. 
JOG [-] Click [-] to perform the reverse rotation. 
State of axis] The operating states of axes or error and warning occurrences. 
Error code The latest error code when an error occurred. 
Error clear Clear the error by clicking this button, when an error occurred. 
Warning code Indicate the latest warning code when a warning occurs. 
Warning clear Clear the warning by clicking this button, when a warning occurred. 

Speed rate 

The target speed of the home return specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the 
specified speed rate. 
Clicking [Speed rate] shows the dialog for inputting the value. 

 

 Note: 
If a recoverable error occurred in the positioning unit, click [Error Clear] to clear the error.  
If a warning occurred in the positioning unit, click [Warning Clear] to clear the warning.  
 
 
2. Click the JOG[+] for the JOG operation in the forward rotation. Click the JOG[-] for the JOG 

operation in the reverse rotation. 
 
3. Click [Close] to close the dialog. 
 

 Note: 
This dialog cannot be closed during the JOG operation. 
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7.17.4 Tool Operation - Teaching 

Activate each axis manually by the tool operation, and register the positioning addresses where the axes 
stopped as the point data. 
 

 Note: 
To perform the teaching operation, the equivalent axes should be in the state that the servo is locked 
(servo ON).  
 
1 . Click [Teaching] in the tool operation dialog. The following dialog is shown. 
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Axis [Group] The axis numbers and group names to be monitored. 
Synchronous 
group The group name and the master/slave axis type for the synchronous operation. 

Synchronous 
mode The operation mode for the synchronous operation. 

Synchronous 
condition 

Monitor the synchronous/asynchronous condition in the synchronous operation. 
For the synchronous operation in the operation mode A, clicking [Synchronous 
change] changes the condition. 

Current value 
Monitor the feedback value for every axis after unit conversion. 
Clicking [Current value update] displays the dialog for inputting the value, and it 
enables to change the current value. 

Unit Monitor the unit of positions for the axes specified in the parameter settings 
each from the positioning unit. 

Deviation (Pulse) Monitor the deviation when activating the moving amount automatic check 
function. 

JOG target speed Monitor and display the target speed in the JOG operation. 
Click [Change] to change the target speed for the JOG operation. 

JOG [+] Click [+] to perform the forward rotation. 
JOG [-] Click [-] to perform the reverse rotation. 

Table number 
Indicate the table number to perform the teaching. 
Click [Teaching] to change the table number for the teaching and register the 
current value. 

State of axis The operating states of axes or error and warning occurrences. 
Error code The latest error code when an error occurred. 
Error clear Clear the error by clicking this button, when an error occurred. 
Warning code Indicate the latest warning code when a warning occurs. 
Warning clear Clear the warning by clicking this button, when a warning occurred. 

Speed rate 

The target speed of the home return specified in the parameter settings for 
each axis is regarded as 100%, and the operation is executed in the specified 
speed rate. 
Clicking [Speed rate] shows the dialog for inputting the value. 

 

 Note: 
If a recoverable error occurred in the positioning unit, click [Error Clear] to clear the error.  
If a warning occurred in the positioning unit, click [Warning Clear] to clear the warning.  
 
2. Click [Teaching] after stopping the axis at the desired position by the JOG operation, and input 

the table number to execute the teaching operation. 
3. Click [OK] after inputting the table number. The current value is registered for the movement 

amount of the specified table number. Also, if the axis that the teaching operation is performed 
is the interpolation axis, the current value is registered for the movement amount of the 
equivalent coordinate in the interpolation group. 

 

 Note: 
• The control method for the table number that the teaching operation was performed is automatically 

changed to “Absolute”. 
• The result of the teaching becomes effective once the tool operation quits and the setting data is 

downloaded to the positioning unit.  
 
4. Click [Close] to close the dialog. 
 

 Note: 
This dialog cannot be closed during the JOG operation. 
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Chapter 8 
 Automatic Operation (Position Control) 
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8.1 Basic Operation 
Type of perations 
The automatic operation is an operation mode to be perform a position control. For the position control, 
there are a single axis control and an interpolation control that starts and stops multiple axes 
simultaneously. 
For the operations of the position control, there are the E point control that uses the positioning data of 1 
table, the P point control and C point control that use multiple tables for the single axis control or 
interpolation control. Each operaton is as mentioned below, and the acceleration time and deceleration 
time can be set individually. For the P point control and C point control, the E point should be set as the 
last table. Also, in the P point control and C point control, the operation done flag turns on after the last 
table was executed. 
The J point control to perform a speed control is also available, besides the P point, C point and E point 
controls. The J point control is performed at the target speed from the beginning of the operation until the 
J point positioning start contact turns on, and once the contact turns on, the next position control will be 
started. In the J point control, the operation done flag turns on after the last table was executed, note that 
the J point control can be used only for a single axis.  

  
Operation flow of single axis control Operation flow of interpolation control  

  
The procedures to set the positioning data and to start the position control are the same for the E point 
control, P point control and C point control. The operation of each cotntrol is determined according to the 
contents of the positioning data to be set. 
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8.1.1 Setting and Operation of E Point Control 

The example below is the case of a single axis control for the 1st axis with the positioning unit installed in 
the slot 0. The movement amount setting is the increment method, and the unit is set to pulse.  
 

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range 

Operation pattern E: End point 
C: Continuance point   E: End point   P: Pass point   J: Speed 
point 

Control method I: Increment I: Increment   A: Absolute 

X-axis movement 
amount 

10000 pulse 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/decelerati
on pattern 

L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Target speed 10000 pps 

Pulse: 1 to 32,767,000 pps  
m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts. The flag turns on after the positioning unit has sent 
the command to move to the target position. 

 
Sample program 
 

  
 
Precautions on programming 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 
Limit input(+):ON Not executable, Error occurs. 

Forward 
Limit input (-):ON Not executable, Error occurs. 
Limit input(+):ON Not executable, Error occurs. 

When E point control is 
executed 

Reverse 
Limit input (-):ON Not executable, Error occurs. 

Forward Limit input(+):ON Deceleration stop, Error occurs. 
During E point control 

Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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8.1.2 Setting and Operation of P Point Control 

The example below is the case of a single axis control for the 1st axis with the positioning unit installed in 
the slot 0. The movement amount setting is the increment method, and the unit is set to pulse.  

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range Table 1 Table 2 Table 3 
Operation 
pattern 

P: Pass 
point 

P: Pass 
point 

E: End 
point 

C: Continuance point   E: End point   P: Pass point    
J: Speed point 

Control 
method 

I: 
Increment

I: 
Increment

I: 
Increment I: Increment   A: Absolute 

X-axis 
movement 
amount 

5000 
pulses 

10000 
pulses 

3000 
pulses 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/
deceleration 
pattern 

L: Linear L: Linear L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration 
time (ms) 100 ms 200 ms 30 ms 0 to 10000 ms 

Deceleration 
time (ms) 10 ms 20 ms 150 ms 0 to 10000 ms 

Target speed 10000 pps 20000 pps 5000 pps 

Pulse: 1 to 32,767,000 pps  
m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts. The flag turns on after the positioning unit has sent 
the command to move to the target position. 

 
Sample program 
 

 
 
Precautions on programming 
- Once starting the table 1, the operation continues up to the table 3 automatically. The last table should 

be set to E: End point. 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 
Limit input(+):ON Not executable, Error occurs. 

Forward 
Limit input (-):ON Not executable, Error occurs. 
Limit input(+):ON Not executable, Error occurs. 

When P point control is 
executed 

Reverse 
Limit input (-):ON Not executable, Error occurs. 

Forward Limit input(+):ON Deceleration stop, Error occurs. 
During P point control 

Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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8.1.3 Setting and Operation of C Point Control 

The example below is the case of a single axis control for the 1st axis with the positioning unit installed in 
the slot 0. The movement amount setting is the increment method, and the unit is set to pulse.  

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range Table 1 Table 2 Table 3 
Operation 
pattern 

C: 
Continu-
ance point

C: 
Continuan
ce point 

E: End 
point 

C: Continuance point   E: End point   P: Pass point 
J: Speed point 

Control 
method 

I: 
Increment

I: 
Increment

I: 
Increment I: Increment   A: Absolute 

X-axis 
movement 
amount 

5000 
pulses 

10000 
pulses 

3000 
pulses 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/
deceleration 
pattern 

L: Linear L: Linear L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration 
time (ms) 100 ms 200 ms 30 ms 0 to 10000 ms 

Deceleration 
time (ms) 10 ms 20 ms 150 ms 0 to 10000 ms 

Target speed 10000 pps 20000 pps 5000 pps 
Pulse: 1 to 32,767,000 pps   m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 
rev/s 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts. The flag turns on after the positioning unit has sent 
the command to move to the target position. 

 
Sample program 
 

 
 
Precautions on programming 
- Once starting the table 1, the operation continues up to the table 3 automatically. The last table should 

be set to E: End point. 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 
Limit input(+):ON Not executable, Error occurs. 

Forward 
Limit input (-):ON Not executable, Error occurs. 
Limit input(+):ON Not executable, Error occurs. 

When C point control is 
executed 

Reverse 
Limit input (-):ON Not executable, Error occurs. 

Forward Limit input(+):ON Deceleration stop, Error occurs. 
During C point control 

Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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8.1.4 Setting and Operation of J Point Control 

The J point control is performed at the target speed from the beginning of the operation until the J point 
positioning start contact turns on, and once the contact turns on, the next position control will be started.  
The J point control can be used only for a single axis control. Note that it cannot be used for the 
interpolation control. 
 

 
 
In the J point control, the speed can be changed during the operation. To change the speed, turn on the 
J point speed change contact after changing the following parameters in the parameter setting area. 
 
- J point control code 
- J point acceleration time 
- J point deceleration time 
- J point target speed 

 

 Reference: <17.6.2 Parameter Setting Area> 
 

 Note: 
The control code, acceleration (deceleration) time and target speed when starting the J point control are 
activated by each setting of the table that the J pont control has been specified.  
The J point control code, J point acceleration (deceleration) time and J point target speed will become 
effective when the speed for the J point control is changed. 
 
Precautions when performing the J point control 
In the J point control, although the speed can be changed during the operation, it cannot be changed 
when accelerating (decelerating). The contact for changing the speed when accelerating (decelerating) 
is ignored, and the speed changes when operating at the constant speed. 
 

 
 
Use the increment mode for the position setting method for the P point, C point and E point controls to 
be executed after the J point control. 
The speed control is performed in the J point contor, however, the positioning moving amount should be 
always a value that enables to have a constant speed area at the target speed. 
 
The example below is the case of a single axis control with the positioning unit installed in the slot 0. The 
movement amount setting is the increment method, and the unit is set to pulse.  
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Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range Table 1 Table 2 Table 3
Operation 
pattern 

J: Speed 
point 

P: Pass 
point 

E: End 
point 

C: Continuance point   E: End point   P: Pass point 
J: Speed point 

Control 
method 

I: 
Increment

I: 
Increment

I: 
Increment I: Increment   A: Absolute 

X-axis 
movement 
amount 

5000 
pulses 

10000 
pulses 

3000 
pulses 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/
deceleration 
pattern 

L: Linear L: Linear L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration 
time (ms) 100 ms 200 ms 30 ms 0 to 10000 ms 

Deceleration 
time (ms) 10 ms 20 ms 150 ms 0 to 10000 ms 

Target speed 10000 pps 20000 pps 5000 pps 
Pulse: 1 to 32,767,000 pps   m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 
rev/s 

J pont 
control code 

Linear 
accelera-
tion/dece-
leration 

  0: Linear acceleration/deceleration    
1: S-shaped acceleration/deceleration 

J point 
acceleration 
time 

10 ms   0 to 10000 ms 

J point 
deceleration 
time 

10 ms   0 to 10000 ms 

J point target 
speed 30000 pps   

Pulse: 1 to 32,767,000 pps   m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 
rev/s 

 
Operation diagram 

 



 8-11 

Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts. 

- Turning on the J point speed change contact changes the target speed during the J pont control to the 
target speed specified as the J point target speed. 

- Once the J point positioning start contact turns on, the operation for the next positioning table (table) 
will be started. 

 
Sample program 
 

 
 
Precautions on programming 
- Once starting the table 1, the operation continues up to the table 3 automatically. The last table should 

be set to E: End point. 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 

When J point control is 
executed 

Forward 
Limit input(+):ON Not executable, Error occurs. 
Limit input (-):ON Not executable, Error occurs. 

Reverse 
Limit input(+):ON Not executable, Error occurs. 
Limit input (-):ON Not executable, Error occurs. 

During J point control 
Forward Limit input(+):ON Deceleration stop, Error occurs. 
Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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8.2 Interpolation Control 
Type of perations 
For the interpolation control, there are 2-axis linear interpolation control, 2-axis circular interpolation 
control, 3-axis linear interpolation control, and 3-axis spiral interpolation control. The following methods 
are available to specify the operation of each interpolation control. Select any of them as usage. The 
axes in the relation of an interpolation are called X axis and Y axis for the 2-axis interpolation, and are 
called X axis, Y axis and Z axis for the 3-axis interpolation. Also, X, Y, Z axes are automatically allocated 
from the smallest axis number. 
In each interpolation control, the E point control tha tuses one table, P point control and C point control 
that uses multiple tables can be combined arbitrarily as positioning data. 
For example, using the P point control enables the continuous interpolation control from the 2-axis linear 
control to the 2-axis circular interpolation control. The acceleration time and deceleration time can be 
specified individually. For the P point control and C point control, the E point should be set as the last 
table. 
 

Type Operation specification method Necessary data 

Composite speed Composite speed of X axis and Y axis 2-axis 
linear 
interpolati
on control Long axis speed 

Speed of long axis (Axis of which moving 
distance is long) 

Center point/CW direction X-axis and Y-axis coordinate of center point 

Center point/CCW direcvtion X-axis and Y-axis coordinate of center point 

2-axis 
circular 
interpolati
on control Pass point  X-axis and Y-axis coordinate of pass point on arc 

Composite speed Composite speed of X axis, Y axis and Z axis. 3-axis 
linear 
interpolati
on control Long axis speed 

Speed of long axis (Axis of which moving 
distance is long) 

Center point/CW direction/ 
X-axis movement 

Y-axis and Z-axis coordinate of center point 

Center point/CCW direction/ 
X-axis movement 

Y-axis and Z-axis coordinate of center point 

Center point/CW direction/ 
Y-axis movement 

X-axis and Z-axis coordinate of center point 

Center point/CCW direction/ 
Y-axis movement 

X-axis and Z-axis coordinate of center point 

Center point/CW direction/ 
Z-axis movement 

X-axis and Y-axis coordinate of center point 

Center point/CCW direction/ 
Z-axis movement 

X-axis and Y-axis coordinate of center point 

Pass point/X-axis movement Y-axis and Z-axis coordinate of pass point on arc 
Pass point/Y-axis movement X-axis and Z-axis coordinate of pass point on arc 

3-axis 
spiral 
interpolati
on control 

Pass point/Z-axis movement Y-axis and Z-axis coordinate of pass point on arc  
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When the X axis and Y axis is the moving axes, each axis in the above diagram is replaced. 
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8.2.1 Setting and Operation of Two-Axis Linear Interpolation 

The example below is the case of the E point control with the positioning unit installed in the slot 0. The 
X axis is set to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the 
increment method, and the unit is set to pulse.   

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range 
Operation pattern E: End point C: Continuance point   E: End point   P: Pass point 

Interpolation operation 0: Linear  
(Composite speed) 

0: Linear (Composite speed)   1: Linear (Long axis speed) 
S: Circular (Pass point/CW direction)   
T: Circular (Pass point/CCW direction  U: Circular (Pass point) 

Control method I: Increment I: Increment   A: Absolute 
X-axis movement 
amount 10000 pulses Pulse: -1,073,741,823 to 1,073,741,823 pulse 

m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

X-axis auxiliary point 0 
Y-axis movement 
amount 5000 pulses 

Y-axis auxiliary point 0 

Acceleration/ 
deceleration pattern L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Interpolation speed 10000 pps Pulse: 1 to 32,767,000 pps   m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag for the axis 1 and 2 (X18, X19) indicating the state that a motor is running turns on 

when the position control started, and it turns off when the operation completed. 
- The operation done flag for the axis 1 and 2 (X20, X21) indicating the state that an operation completed 

turns on when the position control completed, and it will be held until any operation among the position 
control, JOG operation, home return and pulser operation starts.  

 
Sample program 
 

 
 
Precautions on programming 
- To start the interpolation control, turn on the positioning start contact of the axis with the smallest 

number in the same group. 
- The values of the X-axis auxiliary point and Y-axis auxiliary point are invalide for the linear interpolation. 
- When setting the long axis speed, the composite speed is faster than the long axis speed.  
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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8.2.2 Setting and Operation of Two-Axis Circular Interpolation 

The example below is the case of the E point control with the positioning unit installed in the slot 0. The 
X axis is set to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the 
increment method, and the unit is set to pulse.  

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range 
Operation pattern E: End point C: Continuance point   E: End point   P: Pass point 

Interpolation operation 
S: Circular (Pass 
point/CW direction) 

0: Linear (Composite speed)   1: Linear (Long axis speed) 
S: Circular (Pass point/CW direction)   
T: Circular (Pass point/CCW direction  U: Circular (Pass point) 

Control method I: Increment I: Increment   A: Absolute 
X-axis movement 
amount 

0 pulse 
Pulse: -1,073,741,823 to 1,073,741,823 pulse 
m (0.1 m): -107,374,182.3 to 107,374,182.3 m 
m (1 m): -1,073,741,823 to 1,073,741,823 m 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

X-axis auxiliary point 0 pulse 
Y-axis movement 
amount 

20000 pulses 

Y-axis auxiliary point 10000 pulses 

Acceleration/ 
deceleration pattern 

L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Interpolation speed 10000 pps 
Pulse: 1 to 32,767,000 pps   m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag for the axis 1 and 2 (X18, X19) indicating the state that a motor is running turns on 

when the position control started, and it turns off when the operation completed. 
- The operation done flag for the axis 1 and 2 (X20, X21) indicating the state that an operation completed 

turns on when the position control completed, and it will be held until any operation among the position 
control, JOG operation, home return and pulser operation starts. 

 
Sample program 
 

  
Precautions on programming 
- To start the interpolation control, turn on the positioning start contact of the axis with the smallest 

number in the same group. 
- In case of the center point specification, the X-axis auxiliary point is the center point of X axis, and the 

Y-axis auxiliary point is the center point of Y axis. In case of the pass point, each pass point is set as 
the pass point of X axis and Y axis. 

- When the control method is increment, both the center point and pass point are the increment 
coordinatefrom the start point. 

- When the start point and the operaton done point is the same, it performs one circular operation when 
using the center point method. However, when using the pass point method, an error occurs. 

- In case of the pass point method, when the start point, pass point and operation done pont exsit in the 
same straight line, an arc is not comprised, and an error occurs. 

- When setting the long axis speed, the composite speed is faster than the long axis speed.  
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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8.2.3 Setting and Operation of Three-Axis Linear Interpolation 
The example below is the case of the E point control with the positioning unit installed in the slot 0. The 
X axis is set to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the 
increment method, and the unit is set to pulse.   

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting 
example Allowable range 

Operation pattern E: End point C: Continuance point   E: End point   P: Pass point 

Interpolation operation 
0: Linear  
(Composite 
speed) 

0: Linear (Composite speed)   1: Linear (Long axis speed) 
A: Spiral (Center point/CW direction/X-axis movemet) 
B: Spiral (Center point/CCW direction/X-axis movemet) 
C: Spiral (Center point/CW direction/Y-axis movemet) 
D: Spiral (Center point/CCW direction/Y-axis movemet) 
E: Spiral (Center point/CW direction/Z-axis movemet) 
F: Spiral (Center point/CCW direction/Z-axis movemet) 
L: Spiral (Pass point/X-axis movement)   
M: Spiral (Pass point/Y-axis movement) 
N: Spiral (Pass point/Z-axis movement) 

Control method I: Increment I: Increment   A: Absolute 
X-axis movement amount 10000 pulses 
X-axis auxiliary point 0 
Y-axis movement amount 5000 pulses 
Y-axis auxiliary point 0 
Z-axis movement amount 20000 pulses 

Z-axis auxiliary point 0 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): -1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/ 
deceleration pattern L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Interpolation speed 10000 pps Pulse: 1 to 32,767,000 pps   μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 rev/s 

 



8-20 

Operation diagram 

 
 
Operations of each contact 
- The BUSY flag for the axes 1, 2 and 3 (X18, X19, X1A) indicating the state that a motor is running turns 

on when the position control started, and it turns off when the operation completed. 
- The operation done flag for the axes 1, 2 and 3 (X20, X21, X22) indicating the state that an operation 

completed turns on when the position control completed, and it will be held until any operation among 
the position control, JOG operation, home return and pulser operation starts.  
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Sample program 
 

 
 
Precautions on programming 
- To start the interpolation control, turn on the positioning start contact of the axis with the smallest 

number in the same group. 
- The values of the X-axis auxiliary point and Y-axis auxiliary point are invalide for the linear interpolation. 
- When setting the long axis speed, the composite speed is faster than the long axis speed.  
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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8.2.4 Setting and Operation of Three-Axis Linear Interpolation 

The example below is the case of the E point control with the positioning unit installed in the slot 0. The 
X axis is set to the 1st axis, the Y axis is set to the 2nd axis and the Z axis is set to the 3rd axis. The 
movement amount setting is the increment method, and the unit is set to pulse.   

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting 
example Allowable range 

Operation pattern E: End point C: Continuance point   E: End point   P: Pass point 

Interpolation operation 

E: Spiral 
(Center point/CW 
direction/Z-axis 
movement) 

0: Linear (Composite speed)   1: Linear (Long axis speed) 
A: Spiral (Center point/CW direction/X-axis movemet) 
B: Spiral (Center point/CCW direction/X-axis movemet) 
C: Spiral (Center point/CW direction/Y-axis movemet) 
D: Spiral (Center point/CCW direction/Y-axis movemet) 
E: Spiral (Center point/CW direction/Z-axis movemet) 
F: Spiral (Center point/CCW direction/Z-axis movemet) 
L: Spiral (Pass point/X-axis movement)   
M: Spiral (Pass point/Y-axis movement) 
N: Spiral (Pass point/Z-axis movement) 

Control method I: Increment I: Increment   A: Absolute 
X-axis movement amount 0 pulse 
X-axis auxiliary point 0 pulse 
Y-axis movement amount 20000 pulses 
Y-axis auxiliary point 10000 pulses 
Z-axis movement amount 5000 pulses 

Z-axis auxiliary point 0 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): -1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/ 
deceleration pattern L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Interpolation speed 10000 pps Pulse: 1 to 32,767,000 pps   μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 rev/s 
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Operation diagram 

 
 
Operations of each contact 
- The BUSY flag for the axes 1, 2 and 3 (X18, X19, X1A) indicating the state that a motor is running turns 

on when the position control started, and it turns off when the operation completed. 
- The operation done flag for the axes 1, 2 and 3 (X20, X21, X22) indicating the state that an operation 

completed turns on when the position control completed, and it will be held until any operation among 
the position control, JOG operation, home return and pulser operation starts.  
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Sample program 
 

 
 
Precautions on programming 
- For X-Y plane, in case of the center point specification, the X-axis auxiliary point is the center point of X 

axis, and the Y-axis auxiliary point is the center point of Y axis. In case of the pass point, each pass 
point is set as the pass point of X axis and Y axis. These settings are the same for Y-Z plane and X-Z 
plane. 

- When the control method is increment, both the center point and pass point are the increment 
coordinatefrom the start point. 

- When the start point and the operaton done point is the same, it performs one circular operation when 
using the center point method. However, when using the pass point method, an error occurs. 

- In case of the pass point method, when the start point, pass point and operation done pont exsit in the 
same straight line, an arc is not comprised, and an error occurs. 

- When setting the long axis speed, the composite speed is faster than the long axis speed.  
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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8.3 Synchronous Operation 

8.3.1 Overview of Synchronous Operation 

The synchronous operation is a function to set an axis to be the standard (master axis) and an axis to be 
synchronized (slave axis), and make the operations the master and slave axes identical 
(synchrononous).  
 
The features of the synchronous operation are as below. 
 
- A maximum of 2 groups can be set for the synchronous operation.  
- The master and slave axis can be set for one axis each.) 
 
Two types of synchronous operation can be selected. 
 
1. Synchronous mode A 
Using this mode enables to switch the setting of the synchronous operation between “enabled” and 
“disabled”, and perform the synchronous operation as necessary. 

  
2. Synchronous mode B 
This mode is used to drive a large-sized table such as a carrier machine with two motors. The 
synchronous operation cannot be disabled in the mode B.. 

 
 
Differences in the operations of synchronous modes 

 Synchronous mode A Synchronous mode B 
Synchronous 
setting 

A maximum of 2 groups can be set for the synchronous group. 
An individual operation mode can be set for each synchrounous group. 

Enabled/disabled 
of synchronous 
operation 

It can be selected either Enabled or Disabled. Only Enabled  

【Synchronous: When enabled】 
Operates with the setting of the master axis. 
The positioning starts for the master axis. 

Positioning 
operation 
JOG operation 
Operation stop 
Pulser operation 

【Synchronous: When disabled】 
The master and slave axes are operated 
according to the respective settings for each axis.
The positioning starts for each axis. 

Operates with the setting of the master axis. 
The positioning starts for the master axis. 

Home return 

It is performed for each axis. 
It is necessary to set the synchronous operation 
to be “Disabled” when performing the home 
return.  

Some home return methods cannot be used. 
The connection of the switch of the 
positioning unit may be changed according 
to the home return methods.   
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8.3.2 Home Return in Synchronous Operation 

The usable home return methods vary according to the synchronous mode to be used in the 
synchronous operation. 

A: Available    N/A: Not available 
 Home return 

method 
 Synchronous mode A  Synchronous mode B 

 DOG method 1  A  N/A 
 DOG method 2  A  A 
 DOG method 3  A  N/A 
 Limit method 1  A  N/A 
 Limit method 2  A  A 
 Home method  A  N/A 
 Data set method  A  A 

 Remarks 

 Set the synchronous 
operation to be “Disabled” 
when performing the home 

return. 

 The connections for each 
switch are different when 

using the home return. 

 
Home return when using synchronous mode A 
In the synchronous mode A, the home return is performed for each axis individually. 
 
[Procedure] 
1. Disable the synchronous operation. 
2. Execute the home return for the master axis and slave axis individually. 
3. Enable the synchronous operation after confirming the completion of the home return for the master 

and slave axes. 
 
Home return when using synchronous mode B 
In the synchronous mode B, the home return is performed simultaneously for the master and slave axes 
by executing the home return for the master axis. 
 
Connect the near home switch and limit switch as below to perform the home return using the “DOG 
method 2” and “Limit method 2”. 
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 Reference: <Chapter 10   Manual Operation (Home Return)> 



8-28 

8.3.3 Synchronous Operation Difference Behavior Check Function 

The difference behavior check function is used to check if the master and slave axes perform the 
synchronous operation properly, and detect the feedback pulse value between the master and slave 
axes exceeds the threshold by comparing the feedback pulse value. 
 
The operations when the difference between the moving amounts of master and slave axes exceeds the 
specified difference value can be selected from the followings. 
 

 Difference 
check 

 Operation 

 Error  An error occurs, and the operations of master and slave axes stop. 
 The operations cannot start until the error is cleared. 

 Warning  A warning occurs. 
 The operations continue. 

 None  The difference behavior check is not performed. 
 

 Note: 
The difference behavior check function in the synchronous operation is available only when setting the 
pulse input method for the master and slave axes to the feedback pulse. 
 

 Reference: <5.3 Setting the Pulse Ouput Mode> 
 

8.3.4 Controlling and Monitoring Synchronous Operation 

The following area is used to set the synchronous operation to be enabled/disabled, and check the 
synchronous status. 
 
[Synchronous operation control/monitor area] 

Bank Offset 
address Name Description 

2B0H 
Synchronous 
group 1 operation
Enabled/disabled 

2B1H 
Synchronous 
group 2 operation
Enabled/disabled 

The setting for the synchronous operation can be switched between “Enabled” 
and “Disabled”. 
When using the synchronous mode B, this setting is ignored, and the operation 
is always performed in the synchronized state.  

 
00H 

2B4H Synchronous 
operation monitor

 
 

 Note:  
Setting to enable/diable the synchronous mode is available in the synchronous mode A only. 
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8.3.5 Operation of Master and Slave Axes 
Operation of master and slave axes 
Various positioning parameters should be set to perform operations on the positioning unit. The 
parameters to be applied vary in the synchronous operation as follows. 
 

Parameter name Operation during synchronous operation 
Unit setting 
Pulse number per rotation 
Moving amount per rotation 
Pulse I/O setting 

Operates by the setting of each axis. 
Specify the same settings for the axes to be 
synchronized when performing the synchronous 
operation. 

Limit switch 
Limit switch connection 
Software limit (Positioning control) 
Software limit (Home return) 
Software limit (JOG operation) 
Upper limit of software limit 
Lower limit of software limit 
Auxiliary output mode 
Auxiliary output ON time (ms) 
Auxiliary output Delay rate 

Follows the operation of the master axis during the 
synchronous operation. 

Home return – Setting code 
Home return – Direction 
Home return – Acceleration time 
Home return – Deceleration time 
Home return – Traget speed 
Home return – Creep speed 

Varies depending on the operation mode of the 
synchronous operation. 
Synchronous mode A: Operates by the setting of 
each axis. 
Synchronous mode B: Follows the operation of a 
master axis. 

JOG operation – Acceleration/Deceleration type 
JOG operation – Acceleration time 
JOG operation – Deceleration time 
JOG operation – Target speed 
JOG positioning operation setting code 
JOG positioning operation acceleration time 
JOG positioning operation deceleration time 
JOG positioning operation target speed 

Follows the operation of the master axis during the 
synchronous operation. 

Emergency stop deceleration time (ms) 
Limit stop deceleration time (ms) 

Error stop deceleration time (ms) 

The operation varies according to the type of stop 
operations.  
For the details, see the following “Stop function in 
synchronous operation”. 

Pulser operation setting code 
Pulser operation ratio numerator 

Pulser operation ratio denominator 

Operates by the setting of each axis. 
Specify the same settings for the axes to be 
synchronized when performing the synchronous 
operation. 

 
Stop function in synchronous operation 
If the stop operaiton is executed for the master and slave axes during the synchronous operation, the 
operation is as follows. 

 Axis requested to stop 
Stop operation Operational overview Master axis Slave axis 

System stop All axes stop without 
deceleration time. All axes stop. 

Emergency stop 
Deceleration stop 

A specified axis stops with 
a deceleration time. Stops with the deceleraiton time for the master axis. 

Limit stop Stops with a deceleration 
time when a limit occurred.

Error stop 
Stop the operation with a 
deceleration time when an 
error occurs. 

Stops with the deceleraiton time for the master axis. 
After stop, the error code occurred on the master 
axis is set for the master/slave axes. 
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8.3.6 Setting and Operation of Synchronous Operation 

The example below is the case of the synchronous operation for 2 axes with the positioning unit installed 
in the slot 0. The movement amount setting is the increment method, and the unit is set to pulse.   

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Item Setting example Allowable range 
Operation pattern E: End point C: Continuance point   E: End point   P: Pass point 
Control method I: Increment I: Increment   A: Absolute 

X-axis movement 
amount 10000 pulses 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): -1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/ 
deceleration pattern L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Target speed 10000 pps Pulse: 1 to 32,767,000 pps   μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 rev/s 

Synchronous group Group 1  
Master axis Axis 1  
Slave axis Axis 2  
Synchronous mode Synchronous mode A  
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Operation diagram 

 
 
Operations of each contact 
- The BUSY flag (X18, X19) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20, X21) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts. 

- In the synchronous operation, the request for the operation of the slave axis is ignored. 
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Sample program 
 

 
 
Precautions on programming 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 
Limit input(+):ON Not executable, Error occurs. 

Forward 
Limit input (-):ON Not executable, Error occurs. 
Limit input(+):ON Not executable, Error occurs. 

When E point control is 
executed 

Reverse 
Limit input (-):ON Not executable, Error occurs. 

Forward Limit input(+):ON Deceleration stop, Error occurs. 
During E point control 

Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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8.4 Setting and Operation of Positioning Repeat Function 
The positioning repeat function is a function to execute the positioning control repeatedly for the 
specified times. 
The repeat count is specified in the positioning repeat count area for each axis. It can be specified in the 
range of 2 to 254 times. Setting the positioning repeat count area to 255 specifies the unlimited repeat 
count. 
 

 Reference: <17.4.8 Positioning Control Area> 
 
Overview of positioning repeat function 
The operation when the following positionining control is repeated for 3 times is as below.  

 
 
When setting the dwell time to 0 for the E point control that is the last of the positioning control, the 
positioning unit processes the E pont control as the P point control, and completes the operation after 
repeating the positioning control for 3 times without stopping the operation.  

 
 
When setting the dwell time to a number other than 0 for the E point control that is te last of the 
positioning control, the positioning unit processes the E point control as the C point control, and execute 
the positioning control again after stopping the operation for the dwell time (ms). The positioning unit 
completes after repeating the positioning control for 3 times.  

 
 
Stop processing in positioning repeat operation 
The following operation is carried out only if performing the deceleration stop while repeating the 
positioning. 
 
- When repeating the E point control (dwell time: 0 ms) 
Once the positioning unit detects the deceleration stop, it will stop the positioning control after repeating 
for N+2 times.  
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- When executing multiple positioning table consecutively 
Once the positioning unit detects the deceleration stop, it will stop the positioning control after repeating 
for N+1 times.  

 
 
The example below is the case of a single axis control with the positioning unit installed in the slot 0. The 
movement amount setting is the increment method, and the unit is set to pulse.  
 

  
Setting 
The parameters necessary for the setting of the positioining data and parameters are specified by the 
Configurator PM. The unit is set to pulse. 

Setting example Item Table 1 Table 2 Table 3 Allowable range 

Operation 
pattern 

J: Speed 
point 

P: Pass 
point 

E: End 
point 

C: Continuance point   E: End point   P: Pass point 
J: Speed point 

Control 
method 

I: 
Increment

I: 
Increment

I: 
Increment I: Increment   A: Absolute 

X-axis 
movement 
amount 

5000 
pulses 

10000 
pulses 

3000 
pulses 

Pulse: -1,073,741,823 to 1,073,741,823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): -1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 1-7,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Acceleration/
deceleration 
pattern 

L: Linear L: Linear L: Linear L: Linear   S: S-shaped acceleration/deceleration 

Acceleration 
time (ms) 100 ms 200 ms 30 ms 0 to 10000 ms 

Deceleration 
time (ms) 10 ms 20 ms 150 ms 0 to 10000 ms 

Target speed 10000 pps 20000 pps 5000 pps 
Pulse: 1 to 32,767,000 pps   μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   degree:0.001 to 32,767.000 
rev/s 

Positioning 
repeat count 3   2 to 254: Repeat count 

255: Unlimited repeat 
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Operation diagram 

 
 
Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the position control 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the 

position control completed, and it will be held until any operation among the position control, JOG 
operation, home return and pulser operation starts.  

 
Sample program 
 

 
 
Precautions on programming 
- Once starting the table 1, the operation continues up to the table 3 automatically. The last table should 

be set to E: End point. 
- If any value such as a movement amount, acceleration time, deceleration time or target speed is out of 

the specified range, a setting value error will occur when the position control starts. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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Operation at limit input 
Condition Direction Limit status Operation 

Limit input(+):ON Not executable, Error occurs. 
Forward 

Limit input (-):ON Not executable, Error occurs. 
Limit input(+):ON Not executable, Error occurs. 

When J point control is 
executed 

Reverse 
Limit input (-):ON Not executable, Error occurs. 

Forward Limit input(+):ON Deceleration stop, Error occurs. 
During J point control 

Reverse Limit input (-):ON Deceleration stop, Error occurs. 
 



Chapter 9 
 Manual Operation (JOG Operation) 
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9.1 Setting and Operation of Home Return 
The example below is the case of the positioning unit installed in the slot 0. The unit is set to pulse. 
 
 

  
Setting 
The parameters necessary for the setting of the JOG operation are specified by the Configurator PM. 
The unit is set to pulse. 

Item Setting example Allowable range 

Acceleration/deceleration pattern 0: Linear acceleration/deceleration
0: Linear acceleration/deceleration 
1: S-shaped acceleration/deceleration 

Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Target speed 10000 pps 

Pulse: 1 to 32,767,000 pps  
μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 

  
Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the JOG operation 

started, and it turns off when the operation completed. 
- The operation done flag (X20) indicating the state that an operation completed turns on when the JOG 

operation completed, and it will be held until any operation among the position control, JOG operation, 
home return and pulser operation starts.  
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Sample program 
 

 
 
Precautions on programming 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 

When JOG operation is 
executed 

Forward 
Limit input(+):ON Not executable, Error occurs. 
Limit input (-):ON Executable 

Reverse 
Limit input(+):ON Executable 
Limit input (-):ON Not executable, Error occurs. 

During JOG operation 
Forward Limit input(+):ON Deceleration stop, Error occurs. 
Reverse Limit input (-):ON Deceleration stop, Error occurs. 
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9.2 Changing the Speed During JOG Operation 
The target speed can be changed during the JOG operation. 
 
Setting 
The parameters necessary for the setting of the JOG operation are specified by the Configurator PM. 
The unit is set to pulse. 

Item Setting example Allowable range 

Acceleration/deceleration pattern 0: Linear acceleration/deceleration
0: Linear acceleration/deceleration 
1: S-shaped acceleration/deceleration 

Acceleration time 1 (ms) 100 ms 0 to 10000 ms 

Deceleration time 1 (ms) 50 ms 0 to 10000 ms 

Target speed 1 10000 pps 

Pulse: 1 to 32,767,000 pps  
m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

Acceleration time 2 (ms) 200 ms 0 to 10000 ms 

Deceleration time 2 (ms) 150 ms 0 to 10000 ms 

Target speed 2 20000 pps 

Pulse: 1 to 32,767,000 pps  
m: 1 to 32,767, 000 m/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

 
Operation diagram 

  
Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the JOG operation 

started, and it turns off when the operation completed. 
- The target speed can be changed freely in the JOG operation. Use a program to change the target 

speed.   
- The operation done flag (X20) indicating the state that an operation completed turns on when the JOG 

operation completed, and it will be held until any operation among the position control, JOG operation, 
home return and pulser operation starts. 
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Sample program 
 

 
 
Precautions on programming 
- As the acceleration time and deceleration time will be retrieved when the speed is changed during the 

JOG operation, the acceleration/deceleration speed can be changed. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
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Chapter 10 
 Manual Operation (Home Return) 
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10.1 Types of Home Return 
The home return is a function to move to the preset reference position and to set its coordinate to 0.  
The following home return methods are available for the positioning unit. 
 
DOG method 1 (Edge detection of near home switch + Home switch based on front-end) 
Detects the rising edge of the near home switch, and the rising edge of the first home switch becomes 
the starting point. 

 
 
DOG method 2 (Edge detection of near home switch) 
Detects the rising edge of the near home switch, and it becomes the starting point. 
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DOG method 3 (Edge detection of near home switch + Home switch based on back-end) 
Detects the trailing edge of the near home switch, and the first rising edge f the home switch in the home 
return direction becomes the starting point. 

 
 
 
Limit method 1 (Edge detection of limit switch + Home switch based on front-end) 
Reverses after detecting the rising edge of the limit switch in the opposite direction of the home return. 
After that, stops at the rising edge of the first home switch and that point becomes the straight point. 
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Limit method 2 (Edge detection of limit switch) 
Detects the rising edge of the limit switch in the home return direction and stops. That point becomes the 
starting point. 

 
 
 
Home method (Edge detection of home switch) 
Moves toward the home return direction from the current value, stops after detecting the rising edge of 
the first home switch. Thtat point becomes the starting point. 
 

 
 
 
Data set method 
The current value becomes the starting point. 
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10.2 Setting and Operation of Home Return 
The example below is the case of the positioning unit installed in the slot 0. The unit is set to pulse.  

  
Setting 
The parameters necessary for the setting of the home return are specified by the Configurator PM. The 
unit is set to pulse. 

Item Setting example Allowable range 
Return setting code 0: DOG method 1 0: DOG method 1 
Return direction 0: Limit (-) direction 0: Limit (-) direction   1: Limit (+) direction 
Acceleration time (ms) 100 ms 0 to 10000 ms 
Deceleration time (ms) 100 ms 0 to 10000 ms 

Target speed 10000 pps 

Return creep speed 1000 pps 

Pulse: 1 to 32,767,000 pps  
μm: 1 to 32,767, 000 μm/s 
Inch: 0.001 to 32,767.000 inch/s   
degree:0.001 to 32,767.000 rev/s 

Deviation counter 
clear signal ON time 

1 ms 1 to 100 ms 

 
Operation diagram 
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Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when the home return started, 

and it turns off when the operation completed. 
- The deviation counter clear signal turns on during the deviation counter clear signal ON time on 

completion of the home return operation. 
- The home return done flag (X28) indicating the state that an operation completed turns on when the 

home return operation completed, and it will be held until any operation among the position control, 
JOG operation, home return and pulser operation starts. The timing of that the flag turns on is at the 
time that the home return operation completed. 

-  
Sample program 
 

 
 
Precautions on programming 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 

When Home return operation 
is executed 

Forward 
Limit input(+):ON Executable 
Limit input (-):ON Executable 

Reverse 
Limit input(+):ON Executable 
Limit input (-):ON Executable 

During Home return operation
Forward Limit input(+):ON Automatic reverse operaiton 
Reverse Limit input (-):ON Automatic reverse operaiton 

 
 



Chapter 11 
 Manual Operation (Pulser Operation) 
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11.1 Setting and Operation of Pulser Operation 
Types of pulse operation 
The pulser operation is a function to output pulses in the manual operation using the pulser connected to 
the positioning unit. 
The following operation methods can be used. 

Operation method Operation 
Standard operation Obtains the number of pulses of the pulser in increment of 1 ms, and operates. 

The content of the input from the pulser are reflected in the actual operation as 
it is. 

Speed limit 
(keep pulse) 

Operates keeping the maximum speed, once the speed of the pulser input 
exceeds the specified maximum speed. 
The number of pulses that has been input with the pulser is kept. As the pulse 
that could not be output is kept, the pulse may be ouput even without input 
from the pulser. 
Speed unit is "Set unit X1000/s". 

Speed limit (cutoff) Operates keeping the maximum speed, once the speed of the pulser input 
exceeds the specified maximum speed The pulse that could not be output is 
cut off, and the pulse output is processed simultaneously with the operation of 
the pulser. 
Speed unit is "Set unit X1000/s". 

 

 
 
The example below is the case of the positioning unit installed in the slot 0. The unit is set to pulse.  

 
 



Setting 
The parameters necessary for the setting of the pulser operation are specified by the Configurator PM. 
The unit is set to pulse. 

Item Setting example Allowable range 
Operation setting code 0: Pulser 1 0: Pulser 1, 1: Pulser 2, 2: Pulser 3 
Pulser operation ratio numerator 2 1 to 32,767 
Pulser operation ratio denominator 1 1 to 32,767 
Pulser operation method 2: Speed limit 

(cutoff) 
0: Standard  1: Speed limit (keep pulse) 
2: Speed limit (cutoff) 

Pulser operation max. speed 500 Pulse: 1 to 32,767,000 kpps 
 
Operation diagram 

 
 
Operations of each contact 
- The BUSY flag (X18) indicating the state that a motor is running turns on when a pulser operation 

enabled contact turned on, and it turns off when the pulser operation enabled contact turned off. 
- The operation done flag (X20) indicating the state that an operation completed turns on when an pulser 

operation enabled contact turned off, and it will be held until any operation among the position control, 
JOG operation, Home return and pulser operation starts. 

 
Sample program 
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Precautions on programming 
- The movement amount per an 1-pulse signal from the pulser can be changed by setting the ratio 

numerator and ratio denominator for the input signal of the pulser. 
- The number of the startup contact and flag varies depending on the number of axes and the installation 

position. 
- The specified slot number varies depending on the installation position of the unit. 
 
Operation at limit input 

Condition Direction Limit status Operation 
Limit input(+):ON Not executable. Error occurs. 

Forward 
Limit input (-):ON Executable 
Limit input(+):ON Executable 

When Pulser operation 
is executed 

Reverse 
Limit input (-):ON Not executable. Error occurs. 

Forward Limit input(+):ON Deceleration stop. Error occurs. 
During Pulser operation

Reverse Limit input (-):ON Deceleration stop. Error occurs. 
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Chapter 12 
 Stop Functions 
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12.1 Settings and Operations of Stop Functions 
Following stop functions are available during operations. Each deceleration time can be set individually. 
Set the deceleration time according to each occurrence condition of the stop operation. 
 

Name Occurrence condition Axis stopped Operation 
Deceleration 
stop 

when the deceleration 
stop contact turns on 

Each axis 
Stops in deceleration time of the control 
being operated. 

Pause 
when the deceleration 
stop contact turns on 

Each axis 

Stops in deceleration time of the control 
being operated, and restarts the stopped 
control once the deceleration stop is 
reset. 

Emergency 
stop 

when the emergency stop 
contact turns on 

Each axis 
Stops in the emergency stop 
deceleration time. 

Limit stop 
when the input of limit 
switch turns on 

Each axis 

Software limit 
stop 

when exceeding the range 
of the software limit 

Each axis 
Stops in the limit stop deceleration time. 

Error stop when an error occurred Each axis Stops in the error stop deceleration time. 

System stop 
when the system stop 
contact turns on 

All axes Stops without deceleraiton time  

 
The deceleration stop (pause), emergency stop and system stop is performed by turning on each 
request contact in the I/O area. The stopped state is held while each contact is on until each request 
signal turns off. Any operation cannot be performed in the stopped state. 
 
Refer to the following table for the stop by turning contacts on. It indicates the allocated I/O when the 
positioning unit is installed in the slot 0.  

Contact 
allocation 

Target 
axis Name Descriptions 

 Y80 All axes System stop Contact for requesting the system stop. When it turns on, all axes will stop 
with 0-deceleration time. 

Y110 1 axis 
Y111 2 axis 
Y112 3 axis 

Y113 4 axis 

Emergency stop

Requests the emergency stop for the corresponding axes 
The deceleration time for the emegency stop is specified in the emergency 
stop deceleration time area of the shared memory. 
(The operation is the level type.) 
 
Note) The deviation counter cannot be cleared. 

Y114 - - - 
Y115 - - - 
Y116 - - - 
Y117 - - - 
Y118 1 axis 
Y119 2 axis 
Y11A 3 axis 

Y11B 4 axis 

Deceleration 
stop 

Requests the deceleration stop for the corresponding axes. 
The deceleration time for the deceleration stop is the deceleration time in 
operation. 
(The operation is the level type.) 
 
Note) The deviation counter cannot be cleared. 

Y11C - - - 
Y11D - - - 
Y11E - - - 

W
Y

11
 

Y11F - - - 
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12.2 Setting and Operation of Pause Function 
The pause function is a function to temporarily stop the control in operation. The pause function is used 
switching between the deceleration stop function.  
Using the pause function enables to perform the deceleration stop in the deceleration time of the control 
being operated by turning on the deceleration stop request contact. 
After that, the stopped state is kept while the deceleration stop request contact is on, and the control 
stopped is restarted by turning off the deceleration stop request contact. 
 
Switching between the pause function and deceleration stop function is carried out in the system 
operation setting area of the shared memory. 
 
System operation setting area 

Bank Offset 
address Name Description 

00H 389H Deceleration stop 
operation 

Specify the operation when turning on the deceleration stop request 
contact. 
 
0: Deceleration stop 
1: Pause 
- Performs the deceleration stop, and restarts the positioning operation 

when resetting “Deceleration stop request signal” (from ON to OFF). 
- Performs the same operation as the deceleration stop except during 

the positioning operation. 
- In the repeat operation, operates until getting to the E point targeted 

for repeating and stops. Restarts the repeat operation when resetting 
“Deceleration stop request signal” (from ON to OFF). 

-  When executing the system stop or emergency stop in paused state, 
the pause will be reset and the operation will not be restarted even if 
the “Deceleration stop request signal” is reset (fron ON to OFF). 

 
[Default]  0: Deceleration stop 

 

 Reference: <17.4.13 System Operation Setting Area> 
 

 Note:  
The deceleration stop cannot be executed when using the pause function. Use the emergency stop 
function to execute the stop operation when using the pause function. 
The pause function is available only when performing the automatic operation (positioning control). In the 
manual operation, it is the same operaton as the deceleration stop. 
The pause function keeps the stopped state as well as other stop functions when the deceleration stop 
(pause) request signal is on. If executing the emergency stop or system stop in paused state, the pause 
will be cancelled and the state will change to the one of the emergency stop or system stop. 
The pause function cannot be specified by the Configurator PM. Change the operation with the program 
to use the pause function. 
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Chapter 13 
 Supplementary Functions 



13.1 Dwell Time 
The time taken until the next operation after the completion of an executed positioning table in the 
automatic operation is called dwell time. 
The operations of the dwell time vary according to control methods slightly. Followings are the 
operations in each control method. 
 
For E point control 
The dwell time is the time taken from the completion of the position command until the operation done 
ag turns on. fl 

  
For P point control 
In the P point control, the positioning table operates consecutively, therefore, the dwell time is ignored.  
For the last table (E point), as well as the E point control, the dwell time is the time taken from the 
ompletion of the position command until the operation done flag turns on. c 

  
For C point control 
The dwell time is the waiting time for executing the next table from the completion of the positioning 
talble (deceleraiton stop). 
For the last table (E point), as well as the E point control, the dwell time is the time taken from the 
completion of the position command until the operation done flag turns on. 
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13.2 Software Limit 
The system is designed to mechanically set the limit (+) and limit (-) to restrict the moving range of a 
motor. 
Separately from the mechanical limits (+) and (-), the software limit is a function to add the limits for the 
absolute coordinate managed within the positioning unit. As the software limit is a function for the 
protection of the motor and AMP, it is recommended to set them to the values within the range of the 
mechanical limits (+) and (-) as below. 
 

 
 
When exceeding the setting range of the software limit (upper and lower limit values), an error occurs, 
and the deceleration stop is executed. It is necessary to clear the erro and move the motor into the range 
of the softwarelimit using an operation such as JOG operation after the stop. 
 

 
 
Whether the software limit is set to be available or not can be specified individually for the positioning 
control, JOG operation and home return each. For example, it is possible to set the limit software to be 
invalid only in the home return operation. 
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13.3 Auxiliary Output Code and Auxiliary Output Contact 
The auxiliary output contact is a function to inform about which table’s operation is performing when the 
automatic operation (E point control, C point control, P point control, J point control) is executed. 
The auxiliary output contact and the auxiliary output code can be used by setting the parameter “auxiliary 
output mode” of each axis to the With or Delay mode.  
 
Auxiliary output contact 
The With mode and Delay mode are available for the operation of the auxiliary output contact.  

Auxiliary 
output mode Operation 

With mode At the same time the automatic operation starts, the auxiliary contact flag of the 
corresponding axis allocated in the I/O area turns on. 

Delay mode The auxiliary contact flag of the corresponding axis allocated in the I/O area turns on 
according to the rate (%) of positioning moving amount in the automatic operation.  
The rate to turn on the flag in the Delay mode is specified in the auxiliary output 
delay rate area of the shared memory. 
However, if the J point control has been specified for the automatic operation, the 
operation is the same as the one in the With mode. 

Also, the ON time of the auxiliary contact flag can be specified in the ms unit  

 Reference: <17.6.2 Parameter Setting Area>  

 Note: When performing the J point control, the operation in the Delay mode is the same as the 
one in the With mode. 
 
Auxiliary output data 
The auxiliary output data (1 word) can be set for each table of the positioning data. The content of the 
process currently carried out can be confirmed by setting the auxiliary output.  The values in the auxiliary 
output data are held until the next positioning table is executed. Also, the auxiliary output data that was 
output just before the completion of the automatic operation is held.  

 

 Note: The auxiliary output data is stored when the positioning starts regardless of the type of 
auxiliary output modes (With mode or Delay mode). 



13.4 Home Change   
The current value update is a function to change the current value managed in the positioning unit to an 
arbitrary value. 
Data must be written into the shared memory from the PLC in order to carry out the current value update. 
Followings are the details of the shared memory to carry out the current value update. 
 
Home change area (Shared memory, Bank 0) 

address Name Descriptions 

0C0H Current value 
update request flag

Only when the corresponding bits for each axis changed to 1 from 0, the current 
valuecooridnate managed in the positioning unit is changed to the following 
current value update coordiate. 
Afther the change, the positioning unit clears the corresponding bits to 0 
automatically. 
  

  
0C8H 

0C9H 

Current value 
update coordinate 
of axis 1 

Stores the coordinate to change the current value of axis 1. 

0CAH 

0CBH 

Current value 
update coordinate 
of axis 2 

Stores the coordinate to change the current value of axis 2. 

0CCH 

0CDH 

Current value 
update coordinate 
of axis 3 

Stores the coordinate to change the current value of axis 3. 

0CEH 

0CFH 

Current value 
update coordinate 
of axis 4 

Stores the coordinate to change the current value of axis 4. 

0D0H 

0D1H 

Current value 
update coordinate 
of axis 5 

Stores the coordinate to change the current value of axis 5. 

0D2H 

0D3H 

Current value 
update coordinate 
of axis 6 

Stores the coordinate to change the current value of axis 6. 

0D4H 

0D5H 

Current value 
update coordinate 
of axis 7 

Stores the coordinate to change the current value of axis 7. 

0D6H 

0D7H 

Current value 
update coordinate 
of axis 8 

Stores the coordinate to change the o current value of axis 8. 

 
Procedures of current value update 
1. Write an coordinate to be the current value in the current value update coordinate area of the target 

axis. 
2. Write the value at the time that the bit of the target axis set to 1 in the current value request flag area. 

As the current value update process is performed for the axis that is 1 in the current value request flag 
area, do not set any bit to 1 other than the target axis. 

3. The current value after unit conversion in each axis information and monitor area is changed to the 
specified current value. 

 Note: The value to be changed by updating the current value is the current value after unit 
conversion. 
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13.5 Coordinate Origin 
The positioning unit sets the coordinate managed to 0 by the home return process. 
Coordinate origin is a function to set the coordinate after the home return process to an arbitrary value. 
 
Procedure of coordinate origin process 
1. Write the coordinate to be the origin in the coordinate origin value area for the axis of which coordinate 

will be changed after the home return. 
2. Execute the home return for the target axis. After the home return, the coordinated specified in the 

above 1 becomes the origin. 
 

 Reference: <17.6.2 Parameter Setting Area> 
 

 Note: The coordinate origin value should be specified in the specified unit. 
 

13.6 Pulse Input 
The positioning unit is equipped with the pulse input for each axis, and various input devices can be 
connected. Input devices are as follows. 
 

Input device Description 
Pulser - Set for using the manual pulser. 

- Using the pulser operation setting code enables to specify which axis (ch) is 
used. 

Feeback pulse - Set for connecting an encoder to monitor the rotation of a motor. 
- When selecting the feedback pulse, the positioning unit counts the feedback 
pulse of one’s axis using the pulse input value, and detects the difference 
between the command value and pulse input value. (Moving amount 
automatic check function) 

High-speed counter - Set for using as a general-purpose counter input. 
Various input modes (2-phase input, direction discrimination input, individual 
input) are available. 

- The positioning unit stores the number of input pulses in the monitor area. 
 

 

 Reference: <5.3 Setting the Pulse Input Mode> 
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13.6.1 Monitoring Pulse Input Values 

The pulse input values can be monitored from programs on the positioning unit. 
The following areas are used for monitoring the pulse input values. 
 
[Axis information & monitor area] 
1st axis 

Bank Offset 
address Name Descriptions 

036H 
01H 

037H 

Pulse input value of 
axis 1 

Stores the pulse input value according to the pulse input purpose 
(pulser, feedback pulse, high-speed counter). (Unit: pulse) 
The pulse input value is stored, and cleared by changing the pulse 
input purpose or clearing the pulse input value. 

 
2nd axis 

Bank Offset 
address Name Descriptions 

076H 01H 
077H 

Pulse input value of 
axis 2 Refer to the description of 1st axis. 

 
3rd axis 

Bank Offset 
address Name Descriptions 

0B6H 01H 
0B7H 

Pulse input value of 
axis 3 Refer to the description of 1st axis. 

 
4th axis 

Bank Offset 
address Name Descriptions 

0F6H 01H 
0F7H 

Pulse input value of 
axis 4 Refer to the description of 1st axis. 

 

 Reference: <17.5.2 Each Axis Information & Monitor Area> 
 

13.6.2 Pulse Input Function 

A manual pulser can be used by setting the pulse input purpose of the positioning unit to “Pulser”. 
With the manual pulser, pulsers connected to different axes can be used according to the setting. 
Therefore, more than one axis can be operated simultaneously with one pulser. However, a care should 
be taken to set the axis which the pulser is connected and the axis which the pulser operates. 
R efer to the table below to set the pulse input purpose. 

Setting of pulse input purpose Pulser operation 
Axis that pulser 

is connected 
Axis that pulser 

operates Operation Description 

Feedback pulse 
High-speed 
counter 

Feedback pulse 
High-speed counter 
Pulser 

Not 
available 

As the positioning unit does not recognize 
the input pulse as the manual pulser, it does 
not perform the pulser operation.  

Feedback pulse Available
Performs the pulser operation. 
The function of the feedback pulse is 
available during the pulser operation. 

High-speed counter Available
Performs the pulser operation. 
The function of the high-speed counter is 
available during the pulser operation.  

Pulser 

Pulser Available Performs the pulser operation.  

 Reference: <5.3 Setting the Pulse Input Mode > 

 13-7 



13.6.3 Function of Feedback Pulse 

The function using the feedback pulse from an encoder can be used by setting the pulse input purpose 
to “Feedback pulse” on the positioning unit. 
 
Moving amount automatic check function 
It is a function to check whether an operating axis is activating in accordance with the command value. 
The difference (deviation) between the current value (absolute) managed within the unit and the 
feedback pulse value to be input is compared to the preset threshold. The moving amount automatic 
check function activates in all operations. This function activates only when setting the pulse input 
purpose to “Feedback pulse”, and this is ignored when setting to “Pulse” or “High-speed counter”. 
 

  
The setting for the moving amount automatic check function is specified in the following area. 
 
1st axis 

Bank Offset 
address Name Descriptions 

008H 
Moving amount 
automatic check 
correction numerator 

009H 
Moving amount 
automatic check 
correction denominator

Set the correction value for the pulse input to be performed when 
xecuting the moving amount automatic check. e

 
The deviation feedback value (pulse input value after correction) is 
calculated with the pulse input value by the following calculating 
ormula, and the moving amount automatic check is executed. f

 
Deviation feedback value = (Correction numerator / Correction 
denominator) x Pulse input 

00AH 
Moving amount 
automatic check 
operation 

Set the operation to be performed when the difference between the 
command value and feedback value exceeds the moving amount 
check value. 
 
0: Error occurs. 

If the difference between the feedback value and the command 
moving amount exceeded the moving amount check value 
(threshold), an error occurs and the operation stops. 
The pulse input value will be cleared after clearing the error. 

1: Warning occurs. 
If the difference between the feedback value and the command 
moving amount exceeded the moving amount check value 
(threshold), a warning occurs and the operation continues. 
The pulse input value will be cleared after clearing the warning. 

2: Off 
The moving amount check is not performed. 

018H Moving amount 
automatic check value

Set the shreshold to perform the moving amount automatic check 
function. 

02H 

01AH 
Moving amount 
automatic check 
interval 

Set the intervale to perform the moving amount automatic check 
function. (unit: ms) 
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2nd axis 

Bank Offset 
address Name Descriptions 

008H Moving amount automatic check 
correction numerator 

009H Moving amount automatic check 
correction denominator 

Refer to the description of 1st axis. 

00AH Moving amount automatic check 
operation Refer to the description of 1st axis. 

018H Moving amount automatic check value Refer to the description of 1st axis. 

0CH 

01AH Moving amount automatic check interval Refer to the description of 1st axis. 
 
3rd axis 

Bank Offset 
address Name Descriptions 

008H Moving amount automatic check 
correction numerator 

009H Moving amount automatic check 
correction denominator 

Refer to the description of 1st axis. 

00AH Moving amount automatic check 
operation Refer to the description of 1st axis. 

018H Moving amount automatic check value Refer to the description of 1st axis. 

16 

01AH Moving amount automatic check interval Refer to the description of 1st axis. 
 
4th axis 

Bank Offset 
address Name Descriptions 

008H Moving amount automatic check 
correction numerator 

009H Moving amount automatic check 
correction denominator 

Refer to the description of 1st axis. 

00AH Moving amount automatic check 
operation Refer to the description of 1st axis. 

018H Moving amount automatic check value Refer to the description of 1st axis. 

20H 

01AH Moving amount automatic check interval Refer to the description of 1st axis. 
 

 Reference: <17.6.2 Parameter Setting Area> 
 
Operation of moving amount automatic check function 
The moving amount automatic check function activates in the following procedure in all operations. 
 
1. The current value that has been held by the positioning unit is stored in the positioning unit at the 

same time that the operation starts. 
2. After the start of operation, the moving amount automatic check function stops until “Moving amount 

automatic check interval” elapses. 
3. After the moving amount automatic check interval, the deviation feedback value calculated form the 

current pulse input value is compared to the stored pulse input value, and it is checked if the difference 
(deviation) between those values exceeds the specified value for the moving amount automatic check 
value. 

4. The current value that has been held by the positioning unit is stored in the positioning unit. 
5. The above 2 to 4 operations are continued. 
 

 Note: The moving amount automatic check interval should be specified in consideration of the 
response time of the encoder used.  
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Monitoring the moving amount automatic check function 
The value (deviation) that is calculated by the moving amount automatic check function can be checked 
with a program.  
The following areas are used for monitoring the deviation. 
 
[Axis information & monitor area] 
1st axis 

Bank Offset 
address Name Descriptions 

034H 
01H 

035H 
Deviation of axis 1 Stores the maximum value of deviation (difference between the pulse 

input value and command value) of 1st axis. 

 
2nd axis 

Bank Offset 
address Name Descriptions 

074H 01H 
075H 

Deviation of axis 2 Refer to the description of 1st axis. 
 
3rd axis 

Bank Offset 
address Name Descriptions 

0B4H 01H 
0B5H 

Deviation of axis 3 Refer to the description of 1st axis. 
 
4th axis 

Bank Offset 
address Name Descriptions 

0F4H 01H 
0F5H 

Deviation of axis 4 Refer to the description of 1st axis. 
  

 Reference: <17.5.2 Each Axis Information & Monitor Area> 
 
Clearing pulse input values 
Pulses that have been input as feedback pulses are calculated and stored as pulse input values. 
When using “Feedback pulse” for the pulse input purpose, the pulse input value is cleared when 
performing the home return. 
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Changing pulse input values 
The pulse input value that has been input can be changed to an arbitrary value when setting the pulse 
input purpose to the feedback pulse. 
The following area is used for changing the pulse input value. 
 
[Pulse count control area] 

Bank Offset 
address Name Descriptions 

241H Pulse count value 
change request flag

When turns the corresponding bits for each axis from 0 to 1, the pulse 
input value will be changed to the specified pulse count changed 
value. 
This flag is an edge trigger. It should be always turned to 1 from 0 
when changing the value. 

  
248H 
249H 

Pulse input changed 
value of axis 1  Set the pulse input value of axis 1 to be changed. 

24AH 
24BH 

Pulse input changed 
value of axis 2  Set the pulse input value of axis 2 to be changed. 

24CH 
24DH 

Pulse input changed 
value of axis 3  Set the pulse input value of axis 3 to be changed. 

24EH 

00H 

24FH 
Pulse input changed 
value of axis 4  Set the pulse input value of axis 4 to be changed. 

 

 Reference: <17.4.11 Pulse Count Control Area> 
 

13.6.4 Function of High-speed Counter 

Setting the pulse input purpose to “High-speed counter” enables the pulse input to be used as an 
external counter. 
 
Control of pulse input 
On the positioning unit, when setting the pulse input purpose to “High-speed counter”, the count of pulse 
input value can be arbitrarily stopped. When the count of pulse input value stops, the current pulse input 
value is held.  
The following area is used to specify to disable/enable the count of pulse input. 
 
  [Pulse count control area] 

Bank Offset 
address Name Descriptions 

00H 240H Pulse count enable 
flag 

When the corresponding bits for each axis is 0, the count of pulse input 
value is performed. 

   

 Reference: <17.4.11 Pulse Count Control Area>  

 13-11 



13-12 

Changing pulse input values 
The pulse input value that has been input can be changed to an arbitrary value when setting the pulse 
input purpose to the high-speed counter. 
The following area is used for changing the pulse input value. 
 
[Pulse count control area] 

Bank Offset 
address Name Descriptions 

00H 

241H 
Pulse count value 
change request flag 

When turns the corresponding bits for each axis from 0 to 1, the pulse 
input value will be changed to the specified pulse count changed 
value. 
This flag is an edge trigger. It should be always turned to 1 from 0 
when changing the value. 

 
248H Pulse input changed 

value of axis 1  
Set the pulse input value of axis 1 to be changed. 

249H 
24AH Pulse input changed 

value of axis 2  
Set the pulse input value of axis 2 to be changed. 

24BH 
24CH Pulse input changed 

value of axis 3  
Set the pulse input value of axis 3 to be changed. 

24DH 
24EH Pulse input changed 

value of axis 4  
Set the pulse input value of axis 4 to be changed. 

24FH 
 

 Reference: <17.4.11 Pulse Count Control Area> 
 
 

13.7 Startup Speed 
The startup speed when starting various operations can be specified. The startup speed can be used for 
the positioning control, JOG operation and home return. 
 
Precautions when setting startup speed 
Note the followings when setting the startup speed. 
 
1. The startup speed is the end speed at the completion of operation. The end speed cannot be changed. 
2. In the home return operation, the home return creep speed is not influenced by the startup speed. 
3. The target speed for various operations is not influenced by the startup speed. The positioning unit 
operates at a specified target speed regardless of the setting for the startup speed. 
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14.1 Precautions During Programming 

14.1.1 Turning Off Power Supply Clears Contents in Shared Memory  

The data in the shared memory of the positioning unit is cleared when the power supply of the PLC turns 
off. So, if you want to perform the positioning control with the current settings of the shared memory the 
next time the power supply turns on, the positioning data should be written in the FROM (flash memory) 
within the positioning unit. 
When parameters and positioning data has been set using the Configurator PM, it is selectable whether 
to store them in the FROM (flash memory) or not at the time of downloading to the positioning unit. 
 

14.1.2 An Operation Started does Not Change to Another Operation  

Once any start-up contact of the automatic operation (position control), manual operations (JOG 
operation, home return, pulser operation) turns on and the operation starts, it will not change to another 
operation even if the contact of the other contact turns on. 
However, the stop operation (deceleration stop, emergency stop, system stop) can be executed during 
other operations. 
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14.1.3 How to Use Standard Area and Extended Area of Positioning Data  

When executing the automatic operation (position control) with the positioning unit RTEX, specify the 
number of the positioning table that has been specified in advance, and start the position control. After 
the start-up, the motor is automatically controlled according to the settings of the table. There are the 
method that creates the positioning table using Configurator PM that is an exclusive setting tool, and the 
other method that writes the positioning table in a prescribed address by ladder programs. 
There are the standard area of 600 points that is specified by No. 1 to 600, and the extended area of 25 
points that is specified by No. 10001 to 10025. 
 
The standard area is used when the setting values of the positioning table are predetermined. It can be 
set using Configurator PM, and can be rewritten from the ladder programs, too. However, if the 
positioning table is changed by the ladder program, the caulculation is necessary to restructure the 
positioning data before executing the automatic operation. This function enables to read the positioning 
data of 600 points in advance and to prepare for the start-up within the positioning unit, and enables to 
shorten the start-up time for the positioning. When using Configurator PM to download the positioning 
data, the data is restructured automatically, so the calculation is not necessary. However, the calculation 
is necessary after rewriting the poisitoning data from the ladder program.  The procedures for the 
calculation are as follows. 
1. Change the positioning table in the shared memory. 
2. Turn on the recalculation request contact (Y87) in the I/O area. 
3. Confirm the recalculation done contact (X7) in the I/O area is on. (Confim the completion of the 

recalculation.) 
 
If the data is not recalculated after rewriting the positioning table by the ladder program, note that the 
operation will be executed with the positioning table before the rewriting. 
 
The extended area is used when the setting values of the positioning table cannot be determined until 
just before executing the positioning operation. For example, in the application of alignment using an 
image processing, the moving distance is determined by the image processing. Therefore, the 
positioning table cannot be determined until just before sarting the positioning operation. In that case, the 
positioning table is set just before the start-up of the positioning. In the extended area, the positioning 
table can be rewritten as needed, and the recalculation is not necessary. However, it is up to 25 tables, 
and Configurator PM cannot be used. The ladder programs should be used to write the positioning table 
in the prescribed address in the shared memory. The start-up time is longer than the standard area, and 
when performing the P point control or C point control in the extended area, note that the start-up time 
varies depending on the number of tables to be executed consecutively.  
How to use each area and the precautions are as below. 
 

 How to use Number 
of points

Table 
number

Setting using 
Configurator PM 

Setting using 
ladder program 

Standard 
area 

Area to be used when 
the setting value of the 
positioning table is 
predetermined.  

600 
points 1 to 600 Available 

Available 
(Calculation for 
restructuring is 
necessary.) 

Extended 
area 

Area to be used when 
the setting value of the 
positioning table cannot 
be determined until just 
before executing the 
positioning operation. 

25 points 
10001 
to 
10025 

Not available 

Available 
(Calculation for 
restructuring is 
not necessary.) 
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14.1.4 Operation When the Mode of PLC Changed to PROG. from RUN  

Any start-up contact of the automatic operation (position control), manual operations (JOG operation, 
home return, pulser operation) turns on, and the operation will continue even if the PLC changes to the 
PROG. mode from the RUN mode after starting the operation. 
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15.1 Errors and Warnings 

15.1.1 About Errors and Warnings 

When any operational unconformity occurs in the positioningn unit, errors or warnings will occur. When 
errors or warnings occur, the following operations will be performed. 
 

Errors 
Occurs in any abnormal conditions. When a motor is operating, the operation stops. 
The motor stopped due to the occurrence of error will not activate until the error clear is 
executed. 

Warnings 
Occurs when any operational unconformity not abnormal conditions exist.  
The operation can continue even after the occurrence of warnings, and the motor 
continues running if the motor is operating.  

 
The errors and warnings can be confirmed on the data monitor and status monitor screens of the 
Configurator PM. 
 

15.1.2 Error and Warning Logs 

There are log areas to store the error/warning logs within the positioning unit. 
 
Error log Max. 7 error codes can be stored for each axis (axis 1 to 4). 
Warnings log Max. 7 warning codes can be stored for each axis (axis 1 to 4). 

 
Once an error/warning occurs, the error/warning code will be stored in the log area of the axis that the 
error occurred. 
When an error/warning that is not related to the axes occurs, such as an failure in the unit, the 
error/warning code will be stored in the log areas of all axes. 
The latest error/warning codes for each axis can be checked with the Configurator PM. 
When referring the error and warning logs for each axis, read the following shared memory from the PLC. 
 
Error log area (Shared memory  Bank 0) Warning log area (Shared memory  Bank 0) 
 

  
Number of occcurrences of 
errors/warnings Stores the number of occurrences of errors and warnings. 

Error/warning annunciation 
buffers (1 to 4) 

Stores error and warning codes. 
The buffer 1 is always the latest code.  
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15.1.3 Errro and Warning Clear 

When an error/warning occurred, it can be cleared at the each axis that the error occurred. 
Note that all the contents of the error log will be initialized, once the error/warning clear is executed. 
 
The error/warning clear can be executed on the data monotor screen of the Configurator PM, but 
errors/warnings can be cleared by the error clear request flag or warning clear request flag allocated in 
the I/O area. 
 
Note) When an error occurred, the axis that the error occurred will not be operated until the execution of 

the error clear. 
 

15.1.4 Errro and Warning Code Format 

The error and warning codes are 32-bit data and in the format as follows. 
32 bits (double word) 

16 bits (word) 16 bits (word) 
Not used Error/warning code 

 

15.1.5 Sample Program 

The program below is a sample program to detect the occurrence of error, and to clear the error after 
reading the error log. 
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15.2 Change in Error Recovery Process (Ver.1.13 or later) 

15.2.1 Overview of Operational Change 

The method to recover from error occurrence varies according to the states when errors occur. 
 

Status when an 
error occurred Description Error type 

Recoverable state 
（○） 

-After an error occurred, the operating axes stop. 
-After an error occurred, the Positioning Unit can recover 
the error at any timing. 

All error types 

Unrecoverable 
state 
（×） 

-Error when a critical trouble occurred on the Positioning 
Unit  system 
-When an unrecoverable error occurred, the power 
supply of the Positioning Unit should be restored. 

System error 
Axis operation error 

* Refer to “List of Error Code” for the details of error types. 
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15.3 List of System Codes 

15.3.1 System Errors (From 1000H) 

These are the errors that occur due to any failure within the positioning unit. The system errors are 
defined as the fatal errors for the system. Except for some items, the power supply must be turned off 
and on again to recover from the errors. 
 

A: Available   N/A: Not available 
Error 
code 

Error name Description Object Clear Countermeasures 

1000H System 
runaway 

System runaway (If the error occurred, 
the ALARM LED on the positioning 
unit is lighted. 

All axes N/A

1001H Hardware 
error 

An error occurred in the hardware test 
when the power supply turned on. All axes N/A

1002H Unit error Any error occurred in the internal 
processing. All axes N/A

Turn off the power supply and 
turn it on again. 
If the error occurred repeatedly, 
please contact us. 

1003H 
System 
processing 
error 

An error occurred in the system 
processing due to any reason. All axes A 

Check the settings.  
If the setting values are correct 
and the error occurred repeatedly, 
please contact us. 

1010H FROM writing 
error 

An error occurred when the positioning 
settings were written in the positioning 
unit. 
Item: Writing error 

Verify error 
Erase error 

All axes A 
Rewrite into the FROM again. 
If the error occurred repeatedly, 
please contact us. 

1020H 
Tool 
operation 
abnormal end

An error occurred in the 
communication with a PC in the tool 
operation by the Configurator PM. 

All axes A 

Check the connection of the 
RS232C cable connecting the PC 
and PLC. 
Reboot the PC. 

1030H High-order 
CPU error 

An alarm occurred on a higher-order 
CPU (control unit or CPU). All axes N/A

Check the status of higher-order 
CPU.  
Turn on the power supply again. 
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15.3.2  Axis Operation Errors (From 3000H)  

These are the errors occurred while various operations are being executed. 
 

A: Available   N/A: Not available 
Error 
code 

Error name Description Object Clear Countermeasures 

3010H Limit + signal 
detection 

The input on the plus side of the 
limit turned on. Each axis A 

3011H Limit – signal 
detection 

The input on the minus side of the 
limit turned on. Each axis A 

Move the motor into the range of 
the limit by an operation such as 
the JOG operation. 
Check the limit singal is correct.  

3012H Limit signal error Both inputs on the plus and minus 
sides of the limit turned on. Each axis A 

Check the status of the limit 
signal. 
Turn off the power supply and 
turn it on again. 

3020H 
Software limit 
(plus side) 
detection 

The movement amount of the 
motor exceeded the upper limit of 
the software limit. 

Each axis A 

3021H 
Software limit 
(minus side) 
detection 

The movement amount of the 
motor exceeded the lower limit of 
the software limit. 

Each axis A 

Move the motor into the range of 
the limit by an operation such as 
the JOG operation. 
Check the setting values of the 
software limit. 

3030H Axis operation 
error 

An error occurred in the operation 
processing of each axis. Each axis A 

Check the setting values and 
parameters of the positioning unit. 
If the error occurred repeatedly 
with the correct setting values, 
please contact us. 

3031H Operation 
abnormal end 

An error occurred in the operation 
processing of each axis. 

Each axis
All axes A 

Turn off the power supply and 
turn it on again. 
If the error occurred repeatedly, 
please contact us. 

3032H Axis group 
operation error 

- The setting of axis group was 
changed during the operation or 
when requesting the stop. 
- The setting of axis group is out of 
the range 

Each axis A 

Changing the axis group should 
be performed when the axis 
stops.  
Also, do not make the stop 
request.  
Check the setting of the axis 
group. 

3033H Interpolation 
operation error 

The operation stopped as an error 
occurred on other interpolation axis 
during the interpolation operation. 

Each axis A 

Check the setting values of the 
positioning data for the 
interpolation operation. 
If the error occurred repeatedly 
with the correct setting values, 
please contact us. 

3034H 

Axis group not 
settable 
（In pulser 
operation） 

The setting of the axis group was 
changed during the pulser 
operaiton. 

Each axis A 
Changing the axis group should 
be performed when the pulser 
operation enalbed signal is off. 

3035H 
Positioning 
moving amount 
error 

The positioning moving amount 
exceeded the upper/lower limit 
value. 

Each axis A Check the setting vaules. 

3040H 
Synchronous 
operation group 
error 

The synchronous group was 
changed during the synchronous 
operation or when requesting the 
stop in the synchronous operation.
 
- The setting of synchronous group 
is out of the range. 
- An error occurred in the home 
return of the synchronous 
operation. 

Each axis A 

Changing the synchronous group 
should be performed when the 
busy signal for the axes to be 
synchronized is off. 
Also, it should be performed when 
various stop request signals 
(system stop, emergency stop, 
deceleration stop) are off. 
 
Specify an axis number existing 
on the network. 
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Error 
code 

Error name Description Object Clear Countermeasures 

3042H 
Synchronous 
operation home 
return error 

- The home return process was 
executed with setting the 
synchronous operation to “Enabled”
when using the synchronous mode 
A. 
 
- A method other than the usable 
home return mothods was 
executed when using the 
synchronous mode B. 

Each axis A 

Simultaneous mode A: 
Set the simultaneous operation to 
“Disabled” when performing the 
home return. 
 
Simultaneous mode B: 
Select a usable home return 
method. 

3043H Synchronous 
operation error 

The operation was stopped as an 
error has occurred on another axis 
in the synchronous operaiton. 

Each axis A 

Check the unit setting of the 
stopped axis. 
If the error occurred repeatedly 
with the correct setting values, 
please contact us. 

3044H 

Synchronous 
operation not 
settable 
（In pulser 
operation） 

The setting of the synchronous 
opration was changed during the 
pulser operation. 

Each axis A 

Changing the setting of the 
synchronous operation should be 
performed when the pulser 
operation enabled signal is off. 

3045H 
Synchronous axis 
difference check 
error 

The difference between the 
movement amounts of the target 
axes for the synchronous operation 
exceeded the specified difference 
threshold. 

Each axis A 
Check the operation of the target 
axes for the synchronous 
operation. 

3046H 
Moving amount 
automatic check 
value error 

The difference between the 
command value and feedback 
value exceeded the moving amount 
automatic check value with the 
moving amount automatic check 
function. 

Each axis A 

Check the operation of the target 
axis. 
Check the parameter for the 
moving amount automatic check 
function. 
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15.3.3 Setting Value Errors (From 0x4000) 

These are the errors in the various setting values specified using the Configurator PM or ladder 
programs. 
 

A: Available   N/A: Not available 
Error 
code 

Error name Description Object Clear Countermeasures 

4000H Axis group setting error The settings of axis groups are 
not correct. Each axis A 

Check the following items 
in the settings of the axis 
group and independent 
axis. 
- The same axis number 

has been registered in 
more than one group. 

- Four or more axes have 
been set in one group. 

- The group is composed 
of one axis only. 

4002H Unit setting error The unit system for the axis 
setting is out of the range. Each axis A 

Check if the unit is one of 
the followings. 
  Pulse, μm, inch, degree 

4004H Pulse number error per 
rotation 

The pulse number is out of the 
range. Each axis A 

4005H Movement amount 
error per rotation 

The movement amount is out of 
the range. Each axis A 

Check the setting value. 
If the setting value is out of 
the range, reduce it by the 
following formula. 
(Pulse number per rotation) 
/ (Movement amount per 
rotation) 

4010H Software limit setting 
error 

The upper or lower limit value of 
software limit is out of the range. Each axis A 

4020H Limit stop deceleration 
time error 

The limit stop deceleration time is 
out of the range. Each axis A 

4021H Error stop deceleration 
time error 

The rror stop deceleration time is 
out of the range. Each axis A 

4022H Emergency stop 
deceleration time error

The emergency stop deceleration 
time is out of the range. Each axis A 

4028H Auxiliary output setting 
error 

The settings of auxiliary output 
are not correct. 
- A mode other than With mode or 
Delay mode for the auxiliary 
output mode has been set. 
- A value other than 0 to 100 (%) 
was specified for the auxiliary 
output delay ratio in the delay 
mode. 

Each axis A 

4030H Synchronous group 
setting error 

- The same axis has been set for 
the synchronous groups 1 and 2.
- Either master axis or slave axis 
has not been set. 
- Multiple axes have been set for 
the master or slave axis. 
- The same axis has been set for 
the master and slave axes. 
- The slave axis has been set to 
the interpolation group. 

Each axis A 

Check the setting value. 
If the error occurred 
repeatedly with the correct 
setting value, please 
contact us. 
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A: Available   N/A: Not available 
Error 
code 

Error name Description Object Clear Countermeasures 

4031H Synchronous operation 
method setting error 

The operation setting for the 
synchronous operation difference 
check function is incorrect. 

Each axis A 

4042H Pulser setting error 

The pulser input mode is 
incorrect. 
The pulser operation method is 
incorrect. 
The pulser operation maximum 
speed is incorrect. 

Each axis A 

Check the setting value. 
If the error occurred 
repeatedly with the correct 
setting value, please 
contact us. 

4043H Pulser disable error 

The pulse input purpose for the 
axis that has been set to enable 
the pulser input  is not set to 
“Pulser”. 

Each axis A 

Check the the setting of 
pulser input purpose. 
Set the input purpose to 
“Pulser” when using the 
pulser. 

4044H Speed rate error The setting of the speed rate is 
out of the range. Each axis A 

4050H Startup speed error The setting of the startup speed is 
out of the range. Each axis A 

4080H 
JOG positioning 
acceleration/decelerati
on method error 

The acceleration/deceleration 
method of the JOG positioning is 
out of the range. 

Each axis A 

4081H JOG positioning 
acceleration time error

The acceleration time of the JOG 
positioning is out of the range. Each axis A 

4082H JOG positioning 
deceleration time error

The deceleration time of the JOG 
positioning is out of the range. Each axis A 

4083H JOG positioning target 
speed error 

The target speed of the JOG 
positioning is out of the range. Each axis A 

4102H Home return target 
speed error 

The target speed of the home 
return is out of the range. Each axis A 

4105H Home return 
acceleration time error

The acceleration time of the home 
return is out of the range. Each axis A 

4106H Home return 
deceleration time error

The deceleration time of the home 
return is out of the range. Each axis A 

4107H Home return setting 
code error 

The home return setting code is 
incorrect. Each axis A 

4110H Home return creep 
speed error 

The creep speed of the home 
return is out of the range. Each axis A 

4111H Home return returning 
direction error 

The moving direction of the home 
return is out of the range. Each axis A 

4112H Home return limit error

The limit switch is disabled. 
(It occurs when the home return 
method is set to the stop-on-
contact method 1 or 2.) 

Each axis A 

4120H Coordinate origin error The coordinate origin is out of the 
range. Each axis A 

Check the setting value. 
If the error occurred 
repeatedly with the correct 
setting value, please 
contact us. 

4201H JOG operation target 
speed error 

The target speed of the JOG 
operation is out of the range. Each axis A 

4203H 
JOG operation 
acceleration/decelera-
tion type error 

The acceleration/deceleration 
type of the JOG operaiton is 
incorrect. 

Each axis A 

4204H JOG operation 
acceleration time error

The acceleraiton time of the JOG 
operation is out of the range. Each axis A 

4205H JOG operation 
deceleration time error

The deceleraiton time of the JOG 
operation is out of the range. Each axis A 

4250H Current value update 
error 

The setting value of the current 
value update is out of the range. Each axis A 

Check the setting value. 
If the error occurred 
repeatedly with the correct 
setting value, please 
contact us. 

A: Available   N/A: Not available 
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Error 
code 

Error name Description Object Clear Countermeasures 

4301H Absolute/Incremental 
setting error 

A value other than the 
absolute/increment is set for the 
move method. 

Each axis A 

4302H Dwell time error The setting value of the dwell time 
is out of the range. Each axis A 

4303H Positioning starting 
table No. error 

The specified table number is 0, 
or it exceeds the maximum table 
number. 

Each axis A 

4304H Table setting error 
The last table of the positioning 
setting tables is not point E. Each axis A 

4400H Positioning movement 
amount setting error 

The movement amount of the 
positioning operation is out of the 
range. 

Each axis A 

4401H 
Positioning rotating 
acceleration/decelera-
tion type error 

The acceleration/deceleration 
type of the positioning operation is 
incorrect. 

Each axis A 

4402H Positioning 
acceleration time error

The acceleration time of the 
positioning operation is out of the 
range. 

Each axis A 

4403H Positioning 
deceleration time error

The deceleration time of the 
positioning operation is out of the 
range. 

Each axis A 

4404H Positioning target 
speed error 

The target speed of the 
positioning operation is out of the 
range. 

Each axis A 

4500H Interpolation type error The setting of the interpolation 
type is incorrect. Each axis A 

4504H Circular interpolation 
not executable 

The parameter of the circular 
interpolation (such as center point 
or pass point) is incorrect. 

Each axis A 

4505H Spiral interpolation not 
executable 

The error occurred during the 
spiral interpolation as the setting 
value is incorrect. 

Each axis A 

 

4600H Pulse input setting 
error 

The setting of the pulse input 
mode is incorrect. Each axis A 

Cehck the setting value. 
Check the combination of 
the input mode, input 
multiplying, input purpose. 

4605H Pulse count changed 
value setting error 

The specified pulse count 
changed value is out of the range. Each axis A 

4609H 

Moving amount 
automatic check 
operation method 
setting error 

The setting for the operation of 
moving amount automatic check 
function is incorrect. 

Each axis A 

4610H 

Moving amount 
automatic check 
correction numerator 
setting error 

The moving amount automatic 
check correction numerator is out 
of the range. 

Each axis A 

4611H 

Moving amount 
automatic check 
correction denominator 
setting error 

The moving amount automatic 
check correction denominator is 
out of the range. 

Each axis A 

4613H 
Moving amount 
automatic check 
interval setting error 

The moving amount automatic 
check interval is out of the range. Each axis A 

Check the setting value. 
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15.4 List of Warning Codes) 
Warning codes are from 0xA000 to differentiate from the error codes. 
 

15.4.1 Unit Warnings (From B000H)  

These are the warning codes to be given when the warnings occurred in the positioning unit.  
 

A: Available   N/A: Not available 
Error 
code 

Error name Description Object Clear Countermeasures 

B000H Tool operation 

The following request signals were 
turned on by the host PLC during the 
Tool operation. 
- Positioning startup request flag 

(each axis) 
- Home return request flag (each 

axis) 
- JOG forward/reverse rotation 

request flag (each axis) 

Each 
axis A 

Various requests from the PLC 
cannot be executed during the 
Tool operation, except the 
following requests. 
- Deceleration stop request flag 

(each axis) 
- Emergency stop request flag 

(each axis) 
- System stop request flag (all 

axes) 
- Pulser operation enabled flag 

(each axis) 

B010H Duplicate startup
The same axis was requested to 
start even though the axis operation 
has not completed. 

Each 
axis A 

The requests for the axes being 
operated cannot be executed, 
except the following requests. 
- Deceleration stop request flag 

(each axis) 
- Emergency stop request flag 

(each axis) 
- System stop request flag (all 

axes) 

B030H 
J point 
simultaneous 
startup warning 

“J point sepped change contact” and 
J point positioning start contact” was 
turned on simultaneously during the 
JOG positioning (J point) operation.

Each 
axis A 

When the both contacts have 
been turned on simultaneously, “J 
point positioning start contact” 
has a priority, and “J point speed 
change contact” is ignored.  

B045H 
Synchronous axis 
difference check 
warning 

The difference of the moving amount 
of the target axis for the synchronous 
operation exceeded the specified 
threshold. 
 
This warning occurs when setting the 
synchronous operation method and 
the synchronous difference check 
function to “Warning”. 

Each 
axis A Check the operation of the targe 

axis. 

B046H 
Moving amount 
automatic check 
warning 

The difference between the 
command value and feedback value 
exceeded the specified moving 
amount automatic check value with 
the moving amount automatic check 
function. 
 
This warning occurs when setting the 
moving amount automatic check 
operation to “Warning”. 

Each 
axis A Check the operation of the target 

axis. 

B304H Recalculation 
error warning 

An error occurred during 
recalculation processing. 

Each 
axis A 

Check the setting of parameters 
or interpolation group for each 
axis. 
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16.1 Troubleshooting 

16.1.1 If the Motor Does Not Turn or Operate (if the LED for pulse output A or B 
is flashing or lighted) 

Solution 1: For the servomotor 
Check to make sure the servo on input is set to ”ON”. 
 

 
 
Solution 2 
Check to make sure the power supply for the driver is ON. 
 
Solution 3 
Check to make sure the wiring between the positioning unit and the driver has been correctly connected. 
 
Solution 4 
Check to make sure the settings for the pulse output method (CW/CCW method or Pulse/Sign method) 
are appropriate for the driver. 
 
 

16.1.2 If the Motor Does Not Turn or Operate (if the LED for pulse output A or B 
is not lighted) 

Solution 
Review the program and correct it if necessary. 
 
Points to check: 
1. Check to make sure the I/O numbers are appropriate. 
2. Check non-rewriting of the start flag in the program.  
3. Check the input valid logic of the Over limit switch. (In this case, Error LED is blinking.) 
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16.1.3  Rotation/Movement Direction is Reversed 

 Example of reversed rotation/movement direction: 
 

 
 
 
Solution 1 
Make sure the wiring between the positioning unit and the driver has been correctly connected. 
 
Point to check: 
Make sure the CW/CCW output or the Pulse/Sign output has been connected to the pertinent input on 
the driver side. 
 
Solution 2 
Change the pulse output rotation direction in the parameters for each axis, and set the rotation to the 
reverse direction. 
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17.1 Table of Specificationa 

17.1.1 General Specifications 

Item Description 
Ambient operating temperature 0 to +55 °C 
Ambient storage temperature -20 to +70 °C 
Ambient operating humidity 30 to 85 % RH (at25 °C  non-condensing) 
Ambient storage humidity 30 to 85 % RH (at25 °C  non-condensing) 

Breakdown voltage 
1500 V AC, 1 minute 
Between the various pins of the external connector and the ground 
(However, excluding F.E. terminal) 

Insulation resistance 
100MΩ or more (measured with 500 V DC testing)  
Between the various pins of the external connector and the ground  
(However, excluding F.E. terminal) 

Vibration resistance 
10 to 55 Hz, 1 cycle/min.  
Double amplitude of 0.75 mm, 10 min. each in the X, Y, Z directions 

Shock resistance Shock of 98 m/s 2, 4 times in the X, Y, Z directions 

Noise immunity 
1500 V[P-P] with pulse widths 50ns and 1µs  
(based on in-house measurements) 

Operating environment Free of corrosive gases and excessive dust 
Internal current consumption 300 mA or less 
Weight Approx. 150 g 
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17.1.2 Performance Specifications 

Description Item 
2-axis type 4-axis type 

Product number AFP243710 AFP243711 AFP243720 AFP243721 
Part number FP2-PP2T FP2-PP2L FP2-PP4T FP2-PP4L 
Output type Transistor Line driver Transistor Line driver 
Number of axes controlled 2 axes 4 axes 

Interpolation control 
2-axis linear interpolation 
2-axis circular interpolation 

2-axis linear interpolation 
2-axis circular interpolation 
3-axis linear interpolation 
3-axis spiral interpolation 

Occupied I/O points Input: 128 points, Output: 128 points (SX128, SY128) 
Position setting modes Absolute (absolute position setting), Increment (relative position setting) 

Position setting units 

pulse 
μm (Minimum command unit is selected from 0.1 μm or 1 μm.) 
inch ((Minimum command unit is selected from 0.00001 inch or 0.0001 inch.) 
degree ((Minimum command unit is selected from 0.1 degree or 1 degree.) 

Position command range

Pulse: -1,073,741,823 to 1,073,741, 823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): 1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 107,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741,823 degree 

Speed command range 

Pulse:1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Operation maximum 
speed 

500 kpps 4 Mpps 500 kpps 4 Mpps 

Acceleration/ 
deceleration 

Linear acceleration/deceleration, S-shaped acceleration/deceleration 

Acceleration time 0 to 10,000 ms (can set in 1 ms) 
Deceleration time 0 to 10,000 ms (can set in 1 ms) 
Number of positioning 
tables 

Each axis   Standard area: 600 points, extended area: 25 points 

Independent 
PTP control (E point control, C point control), CP control (P point control), 
Speed control (J point control) 

Linear 
E point, P point, C point control   Composite speed or long axis speed 
specification 2-axis inter-

polation Circu- 
lar 

E point, P point, C point control   Center point or pass point specification 

Linear 
E point, P point, C point control   Composite speed or long axis speed 
specification 

C
on

tro
l m

et
ho

d 

3-axis inter-
polation 

Spiral E point, P point, C point control   Center point or pass point specification 
Start-up speed Standard area: 3 ms or less, extended area: 5 ms or less 

A
ut

om
at

ic
 o

pe
ra

tio
n 

P
os

iti
on

 c
on

tro
l 

Other 
functions 

Dwell time 0 to 32,767 ms (can set in 1ms) 
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Description Item 

2-axis type 4-axis type 
Product number AFP243710 AFP243711 AFP243720 AFP243721 
Part number FP2-PP2T FP2-PP2L FP2-PP4T FP2-PP4L 
Output type Transistor Line driver Transistor Line driver 

Speed command range 

Pulse:1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Acceleration/deceleration Linear acceleration/deceleration, S-shaped acceleration/deceleration 
Acceleration time 0 to 10,000 ms (can set in 1 ms) 

JO
G

 

Deceleration time 0 to 10,000 ms (can set in 1 ms) 

Speed command range 

Pulse:1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767.000 inch/s 
degree: 0.001 to 32,767.000 rev/s 

Acceleration/deceleration Linear acceleration/deceleration 
Acceleration time 0 to 10,000 ms (can set in 1 ms) 
Deceleration time 0 to 10,000 ms (can set in 1 ms) 

H
om

e 
re

tu
rn

 

Return method DOG method (3 types), limit method (2 types), data set method, home method 

M
an

ua
l o

pe
ra

tio
n 

P
ul

se
r 

Speed command range Activates in synchronization with pulser input 

Deceleration 
stop 

Deceleration 
time 

Deceleration time of active operation 

Emergency 
stop 

Deceleration 
time 

0 to 10,000 ms (can set in 1 ms) 

Limit stop 
Deceleration 
time 

0 to 10,000 ms (can set in 1 ms) 

Error stop 
Deceleration 
time 

0 to 10,000 ms (can set in 1 ms) S
to

p 
fu

nc
tio

n 

System stop 
Deceleration 
time 

Immediate stop (0 ms), all axes stop 

Software 
limit function 

Setting range

Pulse: -1,073,741,823 to 1,073,741, 823 pulse 
μm (0.1 μm): -107,374,182.3 to 107,374,182.3 μm 
μm (1 μm): 1,073,741,823 to 1,073,741,823 μm 
inch (0.00001 inch): -10,737.41823 to 10,737.41823 inch 
inch (0.0001 inch): -107,374.1823 to 107,374.1823 inch 
degree (0.1 degree): -107,374,182.3 to 107,374,182.3 degree 
degree (1 degree): -1,073,741,823 to 1,073,741, 823 degree 

Backup 
Parameters and positioning data are stored in flash memory. (Battery is not 
requred.) 

Counting 
range 

-2,147,483,648 to 2,147,483,647pulse High-speed 
counter 
function *1 Input mode 

Phase difference input, direction discrimination input, individual input (Multiple 
function is available for each mode.) 

O
th

er
 s

pe
ci

fic
at

io
ns

 

Limit input CWL, CCWL monitor, Near home (DOG) monitor 
Auxiliary output contact, auxiliary output code  

Inernal consumption current  
(5 V DC) 

300 mA or less 300 mA or less 300 mA or less 300 mA or less 

Voltage 21.6 V DC to 26.4 V DC 
External power 
supply Consumption 

current 
50 mA 90 mA 50 mA 90 mA 

Weight Approx. 130 g Approx. 150 g Approx. 130 g Approx. 150 g 
Note1) As the same pulse input terminal is used for the pulser input function and the high-speed counter function, 
these two functions cannot be used at the same time. 
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17.2 Allocation of Each Contact 
Followings are occupied I/O when FP2 Positioning unit (Interpolation type) is installed in the slot 0. 

Contact 
allocation 

Target 
axis Name Descriptions 

X0 All axes Positioning 
preparation ready 

Indicates that the initial preparation within the positioning unit was 
completed, and announce the system started running. 

X1 - - - 
X2 - - - 

X3 All axes Write FROM Announces that data such as positioning parameters in the shared memroy 
is being written in FROM. 

X4 All axes Tool operation 
Contact to indicate the Tool operation from Configurator PM. 
The start-up from I/O is not available during the Tool operaiton. If it 
performs, a warning will occur.  

X5 - - - 
X6 - - - 

X7 All axes Recalculation 
done 

If the recalculation request contact (Y_7) turns on, the positioning data of 
the shared memory (standard area) will be restructured. This contact will 
turn on after restructuring completes. 
If the recalculation request contact (Y_7) turns on again, this contact will be 
off once. 
Note) It is used only when the positioning data has been rewritten by laddar 
programs. 

X8 - - - 
X9 - - - 
XA - - - 
XB - - - 
XC - - - 
XD - - - 
XE - - - 

W
X

0 

XF - - - 
X10 - - - 
X11 - - - 
X12 - - - 
X13 - - - 
X14 - - - 
X15 - - - 
X16 - - - 
X17 - - - 
X18 1 axis 
X19 2 axis 
X1A 3 axis 
X1B 4 axis 

BUSY Turns on when the corresponding axis is operating. 

X1C - - - 
X1D - - - 
X1E - - - 

W
X

1 

X1F - - - 
 



17-6 

 
Contact 

allocation 
Target 

axis Name Descriptions 

X20 1 axis 

X21 2 axis 

X22 3 axis 

X23 4 axis 

Operation done 

Turns on when the operation command for the corresponding axis 
completed and the position error became in the specified completion width.  
For P point control and C point control of the automatic operation, turns on 
when the operation for all the tables completed. 
After this contact turned on, the on-state continues until the next control 
activates. 

X24 - - - 
X25 - - - 
X26 - - - 
X27 - - - 
X28 1 axis 
X29 2 axis 
X2A 3 axis 
X2B 4 axis 

Home return done 
Turns on when the home return operation for the corresponding axis 
completed. After this contact turned on, the on-state continues until the next 
control activates. 

X2C - - - 
X2D - - - 
X2E - - - 

W
X

2 

X2F - - - 
X30 1 axis 
X31 2 axis 
X32 3 axis 
X33 4 axis 

Home The contact to monitor the external home input signal for the corresponding 
axis. 

X34 - - - 
X35 - - - 
X36 - - - 
X37 - - - 
X38 1 axis 
X39 2 axis 
X3A 3 axis 
X3B 4 axis 

Near home The contact to monitor the external near home input signal for the 
corresponding axis. 

X3C - - - 
X3D - - - 
X3E - - - 

W
X

3 

X3F - - - 
X40 - - - 
X41 - - - 
X42 - - - 
X43 - - - 
X44 - - - 
X45 - - - 
X46 - - - 
X47 - - - 
X48 1 axis 
X49 2 axis 
X4A 3 axis 
X4B 4 axis 

Auxiliary contact

Turns on when the corresponding positioning table of the corresponding 
axis was executed. 
Use Configurator PM or directly write in the shared memory for setting to 
able/disable the auxiliary contact. 

X4C - - - 
X4D - - - 
X4E - - - 

W
X

4 

X4F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

X50 Limit + 
X51 

1 axis 
Limit - 

X52 Limit + 
X53 

2 axis 
Limit - 

X54 Limit + 
X55 

3 axis 
Limit - 

X56 Limit + 
X57 

4 axis 
Limit - 

Monitor contact of the limit + and – for the corresponding axis. 
During the positioning operation, JOG operation or pulser operation, 
performs the deceleration stop when the limit input that is an extension of 
the operating direction turned on. 
The deceleration stop time during the limit input can be changed in the 
shared memory. 
It will be the contact for the automatic inversion when performing the home 
return. 

X58 - - - 
X59 - - - 
X5A - - - 
X5B - - - 
X5C - - - 
X5D - - - 
X5E - - - 

W
X

5 

X5F - - - 
X60 1 axis 
X61 2 axis 
X62 3 axis 
X63 4 axis 

Error annunciation

Turns on when an error occurs on the corresponding axis. 
The contacts of all axes turn on if an error occurs on all axes. 
The details of the error can be confirmed in the error annunciation area of 
the shared memory. 

X64 - - - 
X65 - - - 
X66 - - - 
X67 - - - 
X68 1 axis 
X69 2 axis 
X6A 3 axis 
X6B 4 axis 

Warning 
annunciation 

Turns on when a warning occurs on the corresponding axis. 
The contacts of all axes turn on if a warning occurs on all axes. 
The details of the warning can be confirmed in the warning annunciation 
area of the shared memory. 

X6C - - - 
X6D - - - 
X6E - - - 

W
X

6 

X6F - - - 
X70 - - - 
X71 - - - 
X72 - - - 
X73 - - - 
X74 - - - 
X75 - - - 
X76 - - - 
X77 - - - 
X78 - - - 
X79 - - - 
X7A - - - 
X7B - - - 
X7C - - - 
X7D - - - 
X7E - - - 

W
X

7 

X7F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y80 All axes System stop Contact for requesting the system stop. When it turns on, all axes will stop 
at the deceleration time 0. 

Y81 - - - 
Y82 - - - 
Y83 - - - 
Y84 - - - 
Y85 - - - 
Y86 - - - 

Y87 All axes Recalculation 
request 

Turn on this signal when each positioning data (standard area) in the shared 
memory was changed. 
The positioning data after the table number starting the recalculation 
specified in the shared memory can be restructured and will be executable 
by turning on this signal. 
When restructuring of the positioning data completes, the recalculation done 
contact (X_7) will turn on. 
 
Note) It is used only when the positioning data has been rewritten by ladder 
programs. 

Y88 - - - 
Y89 - - - 
Y8A - - - 
Y8B - - - 
Y8C - - - 
Y8D - - - 
Y8E - - - 

W
Y

8 

Y8F - - - 

Y90 1 axis 

Y91 2 axis 

Y92 3 axis 

Y93 4 axis 

Positioning start-
up 

Requests the positioning control for the corresponding axis. 
The starting table is specified in the area for specifying the position control 
starting table number in the shared memory. 
(The operation is the edge type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y94 - - - 
Y95 - - - 
Y96 - - - 
Y97 - - - 

Y98 1 axis 

Y99 2 axis 

Y9A 3 axis 

Y9B 4 axis 

Home return start-
up 

Requests the home return for the corresponding axis. 
The settings for the direction or pattern of the home return are specified by 
Configurator PM or the home return operation setting area in the shared 
memory. 
(The operation is the edge type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y9C - - - 
Y9D - - - 
Y9E - - - 

W
Y

9 

Y9F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y100 JOG forward 
Y101 

1 axis 
JOG reverse 

Y102 JOG forward 
Y103 

2 axis 
JOG reverse 

Y104 JOG forward 
Y105 

3 axis 
JOG reverse 

Y106 JOG forward 
Y107 

4 axis 
JOG reverse 

Requests the JOG operation for the corresponding axis. 
The settings for acceleration time, etc are specified by Configurator PM or 
the JOG operation settings in the shared memory. 
(The operation is the level type.) 
 
If this contact turns on during the Tool operation by Configurator PM, a 
warning will be output. 

Y108 - - - 
Y109 - - - 
Y10A - - - 
Y10B - - - 
Y10C - - - 
Y10D - - - 
Y10E - - - 

W
Y

10
 

Y10F - - - 
Y110 1 axis 
Y111 2 axis 
Y112 3 axis 
Y113 4 axis 

Emergency stop 

Requests the emergency stop for the corresponding axis. 
The deceleration time for the emergency stop is specified in the emergency 
stop deceleration time area in the shared memory. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y114 - - - 
Y115 - - - 
Y116 - - - 
Y117 - - - 
Y118 1 axis 
Y119 2 axis 
Y11A 3 axis 
Y11B 4 axis 

Deceleration stop

Requests the deceleration stop for the corresponding axis. 
The deceleration time for the deceleration stop is the deceleration time in 
the operation. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y11C - - - 
Y11D - - - 
Y11E - - - 

W
Y

11
 

Y11F - - - 
Y120 1 axis 

Y121 2 axis 
Y122 3 axis 
Y123 4 axis 

Pulser operation 
enabled 

Requests the permission for the pulser operation of the corresponding axis. 
The multiple setting and other settings for the pulser operation are specified 
by Configurator PM or the pulser operation setting area in the shared 
memory. 
(The operation is the level type.) 

Y124 - - - 
Y125 - - - 
Y126 - - - 
Y127 - - - 
Y128 1 axis 
Y129 2 axis 
Y12A 3 axis 
Y12B 4 axis 

J point speed 
change 

Request the change in the speed during the JOG positioning operation. 
The JOG positioning operation is specified in the JOG positioning operation 
target speed area. 
(The operation is the edge type.) 

Y12C - - - 
Y12D - - - 
Y12E - - - 

W
Y

12
 

Y12F - - - 
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Contact 

allocation 
Target 

axis Name Descriptions 

Y130 - - - 
Y131 - - - 
Y132 - - - 
Y133 - - - 
Y134 - - - 
Y135 - - - 
Y136 - - - 
Y137 - - - 
Y138 1 axis 
Y139 2 axis 
Y13A 3 axis 
Y13B 4 axis 

J point positioning 
start 

Requests to start the next positioning operation during the JOG positioning 
operation. 
(The operation is the edge type.) 

Y13C - - - 
Y13D - - - 
Y13E - - - 

W
Y

13
 

Y13F - - - 
Y140 1 axis 

Y141 2 axis 

Y142 3 axis 

Y143 4 axis 

Request error 
clear 

Requests the error clear for the corresponding axis. 
The processing to recover from errors is performed and the error logs are 
cleared by turning on this signal. 
 
Note) Unrecoverable errors cannot be recovered even if this signal turned 
on. 

Y144 - - - 
Y145 - - - 
Y146 - - - 
Y147 - - - 
Y148 1 axis 
Y149 2 axis 
Y14A 3 axis 
Y14B 4 axis 

Request warning 
clear 

Requests the warning clear for the corresponding axis. 
The warning logs are cleared by turning on this signal. 

Y14C - - - 
Y14D - - - 
Y14E - - - 

W
Y

14
 

Y14F - - - 
Y150 - - - 
Y151 - - - 
Y152 - - - 
Y153 - - - 
Y154 - - - 
Y155 - - - 
Y156 - - - 
Y157 - - - 
Y158 - - - 
Y159 - - - 
Y15A - - - 
Y15B - - - 
Y15C - - - 
Y15D - - - 
Y15E - - - 

W
Y

15
 

Y15F - - - 
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17.3 Configuration of Shared Memory Areas 
The positioning unit manages all the setting values of parameters and positioning data in the shared 
memory. Therefore, all the setting values can be specified by ladder programs as well as Configurator 
PM.  
Followings are the details of the shared memory. 
Area name Shared memory bank Individual name of each area 

Setting parameter control area 
Operation speed rate area 
Axis group setting area 
Synchronous group setting area 
Current value update data area 
Torque limit area 
Positioning control starting table number setting area 
Positioning control area 
Error annunciation & clear area 
Warning annunciation & clear area 
Pulse count control area 
Synchronous operation control/monitor area 

Common area 00H 

System operation setting area 
1 axis Each axis information & monitor area 
2 axis Each axis information & monitor area 
3 axis Each axis information & monitor area 

Each axis 
information area 
Note) 

01H 

4 axis Each axis information & monitor area 
Parameter setting area 

02H to 0BH 1 axis Positioning data setting area (Standard: for 
600 points, Extended: for 25 points) 
Parameter setting area 

0CH to 15H 2 axis Positioning data setting area (Standard: for 
600 points, Extended: for 25 points) 
Parameter setting area 

16H to 1FH 3 axis Positioning data setting area (Standard: for 
600 points, Extended: for 25 points) 
Parameter setting area 

Each axis setting 
area 

20H to 29H 4 axis Positioning data setting area (Standard: for 
600 points, Extended: for 25 points) 

Note) Firstly confirm that the link establishment annunciation flag (X0) is on when reading the axis 
information area using the program. 
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17.4 Details of Common Area in Shared Memory 

17.4.1 Configuration of Common Area  

The shared memory is composed of banks. The common area is allocated in the bank 00H in the shared 
memory, and is used for the common settings of each axis. 
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17.4.2 Setting Parameter Control Area  

This is the area to write the setting values of the positioning parameters and positioning data in the 
shared memory into FROM(Flash memory), or to execute the recalculation of the positioning data.  
The number of writing to FROM in the positioning unit is announced to the CPU through this area, and 
writing the positioning parameters and positioning data in the shared memory to FROM is requested. 
Also, the recalculation starting table number is set to recalculate the positioning data in the standard 
area. 
 

Bank 
Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

080H 
Annunciation of 
number of 
writing to FROM 

Announces the number of writing the 
positioning parameters and data in the 
shared memory into FROM. 

0 -  times 

081H Request for 
writing to FROM 

When writing into FROM by Configurator 
PM, the following procedures will be 
automatically performed. 
When writing into FROM by ladder 
programs, it is necessary to achieve the 
following Configurator PM operation by 
the ladder programs. 
 
1. Write 5555H in this area by the ladder 

program. 
2. The positioning unit checks 5555H, 

and write 6666H over in the same 
area. 

3. Check 6666H by the ladder program, 
and write AAAAH over. 
(Time out of 6666H is 30 seconds.) 

4. The positioning unit copies the content 
of the shared memory into FROM. 

5. The positioning unit checkes writing. 
When OK: The unit sets 0000H. 
When NG: The unit sets FFFFH. 

6. When confirming 0000H by the ladder 
program, the operation will be 
completed successfully. When 
confirming FFFFH, an error will occur. 
In that case, write 0000H over in this 
area. 

0000H - - 
00H 

085H 
Recalculation 
starting table 
number 

When the recalculation request signal 
(Y87 contact) turns on, the positioning 
unit will recalculate the positioning data 
of all the axes from this table number to 
No. 600. 

1 1 to 600 - 

 

17.4.3 Operation Speed Rate Area  

Bank 
Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

00H 088H Operation speed 
rate 

All operations relating to axes 
(positioning, JOG, home return) can be 
perfomred at the specified rate. 
The unit is %, and can be input in the 
range of 1 to 100 (%). 

100 1 to 100 % 
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17.4.4 Setting Parameter Control Area  

The interpolation groups for each axis are set in this area. For the axis connected to network, set the bit 
of the corresponding axis to 1 in any setting as below. 
 

Bank 
Offset 
address 

Name Descriptions 

0B0H Group A axis 
settings 

0B1H Group B axis 
settings 

0B2H Group C axis 
settings 

0B3H Group D axis 
settings 

Set either independent or interpolation for each axis in this area. In case 
of interpolation, each axis belongs to any group among A to D. For 
example, the axes 1, 2, and 3 belong to group A and are 3-axis 
interpolation, set the corresponding 3 bits to 1 in the interpolation axis 
setting of group A. In case of single axis independent setting, it does not 
belong to any group. Turn on the corresponding bits of the rest of the 
independent axis settings. 
Maximum number of interpolation axis per group is 3. The same axis 
cannot be set in more than one group. 
 

 
 

00H 

0B4H Independent 
axis settings 

For the axes that do not belong to the interpolation relation, set the 
corresponding bits to 1. 
 

 
 

 



 17-15 

17.4.5 Synchronous Group Setting Area  

For the synchronous operation, one slave axis is set for a master axis, and a maximum of 2 groups can 
be specified for the gourp of synchronous operation. 
 

Bank 
Offset 
address 

Name Descriptions 

0B7H 

Synchronous 
group 1 
Synchronous 
mode 

Set the operation mode of synchronous operation. 
00H: Synchronous mode A   01H: Synchronous mode B 

0B8H 
Synchronous 
group 1 
Master axis 

0B9H 
Synchronous 
group 1 
Slave axis 

Turn on the corresponding bits to be the master and slave axes for the 
synchronous operation. 
Each synchronous axis can be set for one axis only. 
 

  

0BAH 

Synchronous 
group 2 
Synchronous 
mode 

Set the operation mode of synchronous operation. 
00H: Synchronous mode A   01H: Synchronous mode B 

0BBH 
Synchronous 
group 2 
Master axis 

00H 

0BCH 
Synchronous 
group 2 
Slave axis 

Turn on the corresponding bits to be the master and slave axes for the 
synchronous operation. 
Each synchronous axis can be set for one axis only. 
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17.4.6 Current Value Update Data Area  

For changing the current values for each axis that are managed by the positioning unit, store the 
changed coordinate in this area and turn on the current value update request flag. 
 

Bank 
Offset 
address 

Name Descriptions 

0C0H 
Current value 
update request 
flag 

Only when the corresponding bits to each axis changes to 1 from 0, the 
current value managed in the positioning unit will be changed to the 
following current value. 
Afther the change, the positioning unit clears the corresponding bits to 0 
automatically. 
 

 
 

0C8H 

0C9H 

Current value 
update 
coordinate of 
axis 1 

Store the coordinate to perform the current value update for axis 1. 

0CAH 

0CBH 

Current value 
update 
coordinate of 
axis 2 

Store the coordinate to perform the current value update for axis 2. 

0CCH 

0CDH 

Current value 
update 
coordinate of 
axis 3 

Store the coordinate to perform the current value update for axis 3. 

0CEH 

00H 

0CFH 

Current value 
update 
coordinate of 
axis 4 

Store the coordinate to perform the current value update for axis 4. 
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17.4.7 Positioning Control Starting Table Number Setting Area 

It is used to specify the table number of each axis to start the positioning control. 
The setting ranges are 1 to 600 in the standard area, and 10001 to 10025 in the extended area. 
 

Bank 
Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

100H 
Position control 
starting table 
number of 1st axis

Store the table number of 1st axis 
starting the position control. 1 

1 to 600 
10001 to 
10025 

- 

101H 
Position control 
starting table 
number of 2nd axis

Store the table number of 2nd axis 
starting the position control. 1 

1 to 600 
10001 to 
10025 

- 

102H 
Position control 
starting table 
number of 3rd axis

Store the table number of 3rd axis 
starting the position control. 1 

1 to 600 
10001 to 
10025 

- 

00H 

103H 
Position control 
starting table 
number of 4th axis

Store the table number of 4th axis 
starting the position control. 1 

1 to 600 
10001 to 
10025 

- 

 
 

17.4.8 Positioning Control Area 

It is used to specify the repeat count for each axis respectively for the positioning control that starts when 
starting the positioning control. The positioning unit repeats the positioning control started for the 
specified repeat count, and then completes the operation.  
The specified repeat count changes to the default on completion of the operation. 
 

Bank 
Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

108H 
Repeat count 
for positioning 
of 1st axis 

Store the repeat count for the operation 
starting from the positioning starting table 
number of 1st axis to E point. 
When storing 255, the operation is 
unlimitedly repeated until stopping the 
operation. 

0 0 to 255 Times 

109H 
Repeat count 
for positioning 
of 2nd axis 

Store the repeat count for the operation 
starting from the positioning starting table 
number of 2nd axis to E point. 
When storing 255, the operation is 
unlimitedly repeated until stopping the 
operation. 

0 0 to 255 Times 

10AH 
Repeat count 
for positioning 
of 3rd axis 

Store the repeat count for the operation 
starting from the positioning starting table 
number of 3rd axis to E point. 
When storing 255, the operation is 
unlimitedly repeated until stopping the 
operation. 

0 0 to 255 Times 

00H 

10BH 
Repeat count 
for positioning 
of 4th axis 

Store the repeat count for the operation 
starting from the positioning starting table 
number of 4th axis to E point. 
When storing 255, the operation is 
unlimitedly repeated until stopping the 
operation. 

0 0 to 255 Times 
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17.4.9 Error Annunciation & Clear Area 

When an error occurs (that leads to the stop), the error and the number of occurrences for each axis will 
be stored in this area. Once the error clear is executed, the error and number of occurrences will be 
cleared, and then the error will be judged again. If the error condition still continues, the error will occur 
again even after the execution of error clear. When an error targeted to all axes such as a network failure 
occurs, it will be stored in the error annunciation buffers of all axes. Up to 7 errors are stored in the error 
history.  
The error clear can be executed by the error clear contact as well. 
 

Bank 
Offset 
address 

Name Descriptions 

111H 
Error clear 
individual axis 
setting 

Executes the error clear for each axis.  

  

129H 
Number of error 
occurrences of 
axis 1 

Announces the number of occurrences of errors at axis 1.  

  
12AH 

12BH 

Error code 
annunciation 
buffer 1 of axis 1

12CH 

12DH 

Error code 
annunciation 
buffer 2 of axis 1

12EH 

12FH 

Error code 
annunciation 
buffer 3 of axis 1

130H 

131H 

Error code 
annunciation 
buffer 4 of axis 1

132H 

133H 

Error code 
annunciation 
buffer 5 of axis 1

134H 

135H 

Error code 
annunciation 
buffer 6 of axis 1

136H 

137H 

Error code 
annunciation 
buffer 7 of axis 1

Stores the latest error code from the buffer number 1 in order. 
 

 
 

139H 
Number of error 
occurrences of 
axis 2 

Announces the number of occurrences of errors at axis 2. 

13AH 

13BH 

Error code 
annunciation 
buffer 1 of axis 2

Announces the code when an error occurred. 

13CH 

13DH 

Error code 
annunciation 
buffer 2 of axis 2

Announces the code when an error occurred. 

13EH 

00H 

13FH 

Error code 
annunciation 
buffer 3 of axis 2

Announces the code when an error occurred. 
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Bank 
Offset 
address 

Name Descriptions 

140H 

141H 

Error code 
annunciation buffer 4 
of axis 2 

Announces the code when an error occurred. 

142H 

143H 

Error code 
annunciation buffer 5 
of axis 2 

Announces the code when an error occurred. 

144H 

145H 

Error code 
annunciation buffer 6 
of axis 2 

Announces the code when an error occurred. 

146H 

147H 

Error code 
annunciation buffer 7 
of axis 2 

Announces the code when an error occurred. 

149H Number of error 
occurrences of axis 3 Announces the number of occurrences of errors at axis 3. 

14AH 

14BH 

Error code 
annunciation buffer 1 
of axis 3 

Announces the code when an error occurred. 

14CH 

14DH 

Error code 
annunciation buffer 2 
of axis 3 

Announces the code when an error occurred. 

14EH 

14FH 

Error code 
annunciation buffer 3 
of axis 3 

Announces the code when an error occurred. 

150H 

151H 

Error code 
annunciation buffer 4 
of axis 3 

Announces the code when an error occurred. 

152H 

153H 

Error code 
annunciation buffer 5 
of axis 3 

Announces the code when an error occurred. 

154H 

155H 

Error code 
annunciation buffer 6 
of axis 3 

Announces the code when an error occurred. 

156H 

157H 

Error code 
annunciation buffer 7 
of axis 3 

Announces the code when an error occurred. 

159H Number of error 
occurrences of axis 4 Announces the number of occurrences of errors at axis 4. 

15AH 

15BH 

Error code 
annunciation buffer 1 
of axis 4 

Announces the code when an error occurred. 

15CH 

15DH 

Error code 
annunciation buffer 2 
of axis 4 

Announces the code when an error occurred. 

15EH 

15FH 

Error code 
annunciation buffer 3 
of axis 4 

Announces the code when an error occurred. 

160H 

161H 

Error code 
annunciation buffer 4 
of axis 4 

Announces the code when an error occurred. 

162H 

163H 

Error code 
annunciation buffer 5 
of axis 4 

Announces the code when an error occurred. 

164H 

165H 

Error code 
annunciation buffer 6 
of axis 4 

Announces the code when an error occurred. 

166H 

00H 

167H 

Error code 
annunciation buffer 7 
of axis 4 

Announces the code when an error occurred. 
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17.4.10 Warning Annunciation & Clear Area 

When a warning occurs (that does not lead to the stop), the warning and the number of occurrences for 
each axis will be stored in this area. Once the warning clear is executed, the warning and number of 
occurrences will be cleared, and then the warning will be judged again. If the warning condition still 
continues, the warning will occur again even after the execution of warning clear. When a warning 
targeted to all axes occurs, it will be stored in the warning annunciation buffers of all axes. Up to 7 
warnings are stored in the warning history.  
The warning clear can be executed by the warning clear contact as well. 
 

Bank 
Offset 
address 

Name Descriptions 

1A9H 
Warning clear 
individual axis 
setting 

Executes the warning clear for each axis.  

  

1C1H 

Number of 
warning 
occurrences of 
axis 1 

Announces the number of occurrences of warnings at axis 1.  

  
1C2H 

1C3H 

Warning code 
annunciation 
buffer 1 of axis 1

1C4H 

1C5H 

Warning code 
annunciation 
buffer 2 of axis 1

1C6H 

1C7H 

Warning code 
annunciation 
buffer 3 of axis 1

1C8H 

1C9H 

Warning code 
annunciation 
buffer 4 of axis 1

1CAH 

1CBH 

Warning code 
annunciation 
buffer 5 of axis 1

1CCH 

1CDH 

Warning code 
annunciation 
buffer 6 of axis 1

1CEH 

1CFH 

Warning code 
annunciation 
buffer 7 of axis 1

Stores the latest warning code from the buffer number 1 in order. 
 

 
 

1D1H 
No. of warning 
occurrences of 
axis 2 

Announces the number of occurrences of warnings at axis 2. 

1D2H 

1D3H 

Warning code 
annunciation 
buffer 1 of axis 2

Announces the code when a warning occurred. 

1D4H 

1D5H 

Warning code 
annunciation 
buffer 2 of axis 2

Announces the code when a warning occurred. 

1D6H 

00H 

1D7H 

Warning code 
annunciation 
buffer 3 of axis 2

Announces the code when an error occurred. 
 



 17-21 

Bank 
Offset 
address 

Name Descriptions 

1D8H 

1D9H 

Warning code 
annunciation buffer 4 
of axis 2 

Announces the code when a warning occurred. 

1DAH 

1DBH 

Warning code 
annunciation buffer 5 
of axis 2 

Announces the code when a warning occurred. 

1DCH 

1DDH 

Warning code 
annunciation buffer 6 
of axis 2 

Announces the code when a warning occurred. 

1DEH 

1DFH 

Warning code 
annunciation buffer 7 
of axis 2 

Announces the code when a warning occurred. 

1E1H No. of warning 
occurrences of axis 3 Announces the number of occurrences of warnings at axis 3. 

1E2H 

1E3H 

Warning code 
annunciation buffer 1 
of axis 3 

Announces the code when a warning occurred. 

1E4H 

1E5H 

Warning code 
annunciation buffer 2 
of axis 3 

Announces the code when a warning occurred. 

1E6H 

1E7H 

Warning code 
annunciation buffer 3 
of axis 3 

Announces the code when a warning occurred. 

1E8H 

1E9H 

Warning code 
annunciation buffer 4 
of axis 3 

Announces the code when a warning occurred. 

1EAH 

1EBH 

Warning code 
annunciation buffer 5 
of axis 3 

Announces the code when a warning occurred. 

1ECH 

1EDH 

Warning code 
annunciation buffer 6 
of axis 3 

Announces the code when a warning occurred. 

1EEH 

1EFH 

Warning code 
annunciation buffer 7 
of axis 3 

Announces the code when a warning occurred. 

1F1H No. of warning 
occurrences of axis 4 Announces the number of occurrences of warnings at axis 4. 

1F2H 

1F3H 

Warning code 
annunciation buffer 1 
of axis 4 

Announces the code when a warning occurred. 

1F4H 

1F5H 

Warning code 
annunciation buffer 2 
of axis 4 

Announces the code when a warning occurred. 

1F6H 

1F7H 

Warning code 
annunciation buffer 3 
of axis 4 

Announces the code when a warning occurred. 

1F8H 

1F9H 

Warning code 
annunciation buffer 4 
of axis 4 

Announces the code when a warning occurred. 

1FAH 

1FBH 

Warning code 
annunciation buffer 5 
of axis 4 

Announces the code when a warning occurred. 

1FCH 

1FDH 

Warning code 
annunciation buffer 6 
of axis 4 

Announces the code when a warning occurred. 

1FEH 

00H 

1FFH 

Warning code 
annunciation buffer 7 
of axis 4 

Announces the code when a warning occurred. 
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17.4.11 Pulse Count Control Area 

It is used to change the input pulse when setting the pulse input to the high-speed pulse. 
 

Bank 
Offset 
address 

Name Descriptions 

240H Pulse count 
enable flag 

When the corresponding bit to each axis turns to 0, the count of pulse 
input will start. 
This flag is available only when setting the pulse input purpose to “High-
speed counter”.  

  

241H 
Pulse count 
value change 
request flag 

When the corresponding bit to each axis changes to 1 from 0, the pulse 
input will be changed to the pulse count change value that the pulse input 
count value has been set. 
This flag is an edge trigger. Always chang e this flag to 1 from 0 before 
change.  

  
248H 

249H 

Pulse count 
change value of 
axis 1 

24AH 

24BH 

Pulse count 
change value of 
axis 2 

24CH 

24DH 

Pulse count 
change value of 
axis 3 

24EH 

00H 

24FH 

Pulse count 
change value of 
axis 4 

Set the pulse count value to be changed. 
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17.4.12 Synchronous Operation Control/Monitor Area 

It is used to set to enable/disable the synchronous operaion, and to check the current synchronous 
settings. 
 

Bank 
Offset 
address 

Name Descriptions 

2B0H 

Synchronous 
group 1  
Operation 
enable/disable 

2B1H 

Synchronous 
group 2  
Operation 
enable/disable 

Set to enable/disable the synchronous operation. 
When using the synchronous mode B, this setting is ignored, and always 
performs the synchronous operation.  

  

2B4H Synchronous 
operation monitor

The bits for the axes targeted for the synchronous operation turn on in 
this area regardless of synchronous grpus and master/slave axes.  

  

2B8H 

Synchronous 
group 1 
Synchronous 
operation 
difference value 

The difference threshold for the moving amounts of master and slave 
axes that the synchronous operation is performed in the synchronous 
group 1. 
Checks whether the difference between the moving amounts of master 
and slave axes exeeds the threshold or not. 
This difference value is specified by the unit used for the master axis. 
Default: 10000 

2B9H - - 

2BAH 

Synchronous 
group 2 
Synchronous 
operation 
difference value 

The difference threshold for the moving amounts of master and slave 
axes that the synchronous operation is performed in the synchronous 
group 2. 
Checks whether the difference between the moving amounts of master 
and slave axes exeeds the threshold or not. 
This difference value is specified by the unit used for the master axis. 
Default: 10000 

2BBH - - 

2BCH 

Synchronous 
group 1 
Operation 
method 

00H 

2BDH 

Synchronous 
group 2 
Operation 
method 

Specify the operation of the difference check (i.e. function to check if the 
difference between the moving amounts of master and slave axes 
exceeds “Synchronous operation difference value”) during the 
synchronous operation. 
 
0: Error occurs. 

When the difference between the moving amounts of master and slave 
axes exceeded the threshold using the difference check, an error 
occurs and the operation stops. 

1: Warning occurs. 
When the difference between the moving amounts of master and slave 
axes exceeded the threshold using the difference check, a warning 
occurs and the operation continues. 

2: Not perform difference check. 
The difference check is not performed. 

Default: 0 
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17.4.13 System Operation Setting Area 

It is used to change the operation of positioning unit. 
 

Bank 
Offset 
address 

Name Descriptions 

00H 389H Deceleration stop 
operation 

Specify the operation when setting the deceleration stop request signal to 
“Active” (from OFF to ON). 
 
0: Deceleration stop 

When performing the repeat operation, stops after reaching E point 
that is targeted for the repeat operation. 

1: Pause 
- Performs the deceleration stop, and restarts the positioning opration 
when turning “Deceleration stop request signal” to OFF from ON.  
- Also, performs the same operation as the deceleration stop in all 
states except during the positioning operation. 
- When performing the repeat operation, stops after reaching E point 
that is targeted for the repeat operation, and restarts the positioning 
opration when turning “Deceleration stop request signal” to OFF from 
ON. 
- If the system stop or emergency stop is executed during the pause, 
the pause will be cancelled. The operation will not restart even if 
turning “Deceleraiton stop request signal” to OFF from ON. 

 
Default: 0 
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17.5 Details of Each Axis Information Area in Shared 
Memory 

17.5.1 Configuration of Each Axis Information Area  

The shared memory is composed of banks. The each axis information area is allocated in the bank 01H 
in the shared memory. Also the information on the axes 1 to 4 is allowcated for each address in this area.  
 

 
 

 Note: Firstly confirm that the link establishment annunciation flag (X0) is on when reading the axis 
information area using the ladder program. 
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17.5.2 Each Axis Information & Monitor Area  

These are the areas for the information of each axis and monitoring operation states. 
 
Axis information of axis 1 
 

Bank 
Offset 
address 

Name Descriptions 
Defaul
t value

Setting 
range 

Unit 

031H 
External terminal 
input monitor of 
axis 1 

Stores the information of I/O connected to each axis.  

  
034H 

035H 

Moving amount 
automatic check 
value of axis 1 

Stores the maximum value of difference 
between the command value and 
feedback value of the unit. 

- - - 

036H 

037H 
Pulse input 
value of axis 1 

Stores the pulse input values (pulser, 
feedback pulse, couner) according to the 
pulse input purposes. 
 
The pulse input value is stored by 
integrating the pulse input values until 
changing the pulse input purpose or 
clearing the pulse input. 

- - pulse 

038H 
Acitve table or 
execution done 
table of axis 1 

Stores the number of active positioning 
table or when the operation completed. 1 1 to 

600 - 

039H Auxiliary output 
code of axis 1 Stores the auxiliary output code. 0  - 

03AH 
Repeat count 
setting value of 
axis 1 

Stores the setting value of repeat count 
for positioning. 
1 is stored not to repeat the operation. 
When specifying the repeat count to be 
unlimited, 255 is stored. 

0 0 to 
255 times 

03BH 
Repeat count 
current value of 
axis 1 

Stores the repeat count in operation. 
1 is stored not to repeat the operation. 
When the repeat count exceeds the 
upper limit, it returns to 0. 

0 0 to 
65,535 times 

03CH 
03DH 

Current value of 
axis 1 Stores the current value. 0 -  pulse 

03EH 

01H 

03FH 

Unit system 
conversion 
current value of 
axis 1 

Stores the current value after the unit 
was converted. 0 - - 
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Axis information of axis 2 

Bank 
Offset 
address 

Name Descriptions 

071H External terminal input monitor of axis 2 Refer to the descriptions of axis 1. 
074H Position deviation of axis 2 Refer to the descriptions of axis 1. 
076H Pulse input value of axis 2 Refer to the descriptions of axis 1. 

078H Acitve table or execution done table of 
axis 2 Refer to the descriptions of axis 1. 

079H Auxiliary output code of axis 2 Refer to the descriptions of axis 1. 
07AH Repeat count setting value of axis 2 Refer to the descriptions of axis 1. 
07BH Repeat count current value of axis 2 Refer to the descriptions of axis 1. 
07CH 
07DH 

Current value of axis 2 Refer to the descriptions of axis 1. 

07EH 

01H 

07FH 
Unit system conversion current value of 
axis 2 Refer to the descriptions of axis 1. 

 
Axis information of axis 3 

Bank 
Offset 
address 

Name Descriptions 

0B1H External terminal input monitor of axis 3 Refer to the descriptions of axis 1. 
0B4H Position deviation of axis 3 Refer to the descriptions of axis 1. 
0B6H Pulse input value of axis 3 Refer to the descriptions of axis 1. 

0B8H Acitve table or execution done table of 
axis 3 Refer to the descriptions of axis 1. 

0B9H Auxiliary output code of axis 3 Refer to the descriptions of axis 1. 
0BAH Repeat count setting value of axis 3 Refer to the descriptions of axis 1. 
0BBH Repeat count current value of axis 3 Refer to the descriptions of axis 1. 
0BCH 
0BDH 

Current value of axis 3 Refer to the descriptions of axis 1. 

0BEH 

01H 

0BFH 
Unit system conversion current value of 
axis 3 Refer to the descriptions of axis 1. 

 
Axis information of axis 4 

Bank 
Offset 
address 

Name Descriptions 

0F1H External terminal input monitor of axis 4 Refer to the descriptions of axis 1. 
0F4H Position deviation of axis 4 Refer to the descriptions of axis 1. 
0F6H Pulse input value of axis 4 Refer to the descriptions of axis 1. 

0F8H Acitve table or execution done table of 
axis 4 Refer to the descriptions of axis 1. 

0F9H Auxiliary output code of axis 4 Refer to the descriptions of axis 1. 
0FAH Repeat count setting value of axis 4 Refer to the descriptions of axis 1. 
0FBH Repeat count current value of axis 4 Refer to the descriptions of axis 1. 
0FCH 
0FDH 

Current value of axis 4 Refer to the descriptions of axis 1. 

0FEH 

01H 

0FFH 
Unit system conversion current value of 
axis 4 Refer to the descriptions of axis 1. 
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17.6 Details of Each Axis Setting Area in Shared Memory 

17.6.1 Configuration of Each Axis Setting Area 

The shared memory is composed of banks. The each axis setting area is allocated in the banks 02H to 
29H in the shared memory. The each axis setting area is used to store positioning parameters and 
positioning data, and the setting values are allocated to every address from the axes 1 to 4. The 
positioning setting area of each axis is composed of 600 tables of the standard area and 25 tables of the 
extended area. 
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17.6.2 Parameter Setting Area  

Positioning parameters of each axis 
Data in the following foramts are stored from the starting address of positioning parameters of each axis. 

Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

000H Unit setting 

Sets the unit system of movement amounts of the positioning control for each axis. 
The same unit system should be set for all interpolation axes.  

  
001H - - 

002H 

003H 

Pulse number 
per rotation 

Sets the pulse number per rotation. It is necessary for the conversion of the pulse 
number in the settings of mm, inch and degree.  

  

004H 

005H 

Movement 
amount per 
rotation 

Sets the movement amount per rotation. It is necessary for the conversion of the 
pulse number in the settings of mm, inch and degree.  

  
006H - - 
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

007H Pulse input 
mode 

Set the pulse input signal. 
Set according to the application to be used as the pulse input. 
 

 
 
Default: 20H 

008H 

Moving amount 
automatic check 
correction 
numerator 

009H 

Moving amount 
automatic check 
correction 
denominator 

Set the correction value for the pulse input to be performed when executing the 
moving amount automatic check. 
 
The deviation feedback value (pulse input value after correction) is calculated with 
the pulse input value to be input from the pulse input terminal by the following 
calculating formula, and the moving amount automatic check is executed. 
 
Deviation feedback value = (Correction numerator / Correction denominator) x 
Pulse input 
 
Setting range: 1 to 32767 
Default: 1 

00AH 
Moving amount 
automatic check 
operaiton 

Set the operation to be performed when the difference between the command 
value and feedback value exceeds the moving amount check value. 
 
0: Error occurs. 

If the difference between the feedback value and the command moving amount 
exceeded the moving amount check value (threshold), an error occurs and the 
operation stops. 

1: Warning occurs. 
If the difference between the feedback value and the command moving amount 
exceeded the moving amount check value (threshold), a warning occurs and the 
operation continues. 

2: Off 
The moving amount check is not performed. 
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

00BH 
Software limit 
enabled/ 
disabled setting 

Sets the software limit to be enabled or disabled for each control.  

  

00CH 

00DH 

Upper limit of 
software limit 

Sets the upper limit value of the software limit for absolute coordinates.  

  
 



17-32 

 
Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

00EH 

00FH 

Lower limit of 
software limit 

Sets the lower limit value of the software limit for absolute coordinates. 

 
010H - - 
011H - - 

012H Auxiliary output 
mode 

Sets the auxiliary output function of the auxiliary output contact and code to be 
enalbed or disabled. The time that the auxiliary output contact is on is determined 
by the following auxiliary output ON time. 

  

013H Auxiliary output 
delay ratio 

Specify the ratio (%) of output when using the Delay mode for the auxiliary output. 
The allowable range is 0 to 100 (%). When specifying 50%, the auxiliary output is 
performed if the positioning moving amount exceeds 50%. 
Default: 0 (%) 

014H - - 

015H Pulse output 
control code 

Set the pulse output, home, near home and limit signal.  

  

016H 

017H 

Startup speed 

Set the startup speed when starting each operation. 
The change in startup speed should be done before starting each operation. 
 
Setting range: 0 to 32,767,000 
 
Any other settings will be errors. 
Interpretation is changed by the unit setting. 
pulse: 1 to 32,767,000 pps 
μm: 1 to 32,767,000 μm/s 
inch: 0.001 to 32,767,000 inch/s 
degree: 0.001 to 32,767,000 rev/s 
 
Default: 0 
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

018H 
Moving amount 
automatic check 
value 

Set the threshold for executing the moving amount automatic check function. 
 
Setting range: 0 to 65536 
Default: 10000 (pulse) 

019H - - 

01AH 
Moving amount 
automatic check 
interval 

Set the interval for executing the moving amount automatic check function. 
 
Setting range: 0 to 32767 (ms) 
Default: 0 (ms) 

01BH - - 
01CH - - 
01DH - - 
01EH - - 
01FH - - 
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

020H Home return 
setting code 

Set the pattern of the home return.  

  

021H Home return 
direction 

Set the operating direction of the home return.  

  

022H 
Home return 
acceleration 
time 

023H 
Home return 
deceleration 
time 

Set the acceleration/deceleration time when performing the home return. 
At the beginning of the home return, accelerates for the specified acceleration 
time, decelerates for the specified deceleration time after the proximity input and 
changes to the creep speed.  

  

024H 

025H 

Home return 
target speed 

Set the target speed when performing the home return. 
When there is no proximity input after starting the home return, accelerates to the 
target speed.  

  

026H 

027H 

Home return 
creep speed 

Set the speed to search the home position after the proximity input. 
Set the value lower than the home return target speed.  

  

028H 
Deviation 
counter clear 
signal ON time 

Set the ON time of deviation counter clear signal after the completion of home 
return. 
 
Default: 1 (ms) 
Setting range: 1 to 100 (ms) 
When setting a value larger than 100 ms, the time iis 100 ms. 

029H JOG operation 
setting code 

Set the mode of the JOG operation.  
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

02AH 
JOG operation 
acceleraiton 
time 

02BH 
JOG operation 
deceleration 
time 

Sets the acceleration/deceleraion time when performing the JOG operaiton. 
At the beginning of the JOG operation, accelerates for the specified acceleration 
time, decelerates for specified deceleraiton time when the starting contact of the 
JOG operation turns off, and stops.  

  

02CH 

02DH 

JOG operation 
target speed 

Sets the target speed when performing the JOG operation. 
After starting the JOG operation, accelerates with the specified operation to the 
target speed while the starting contact of the JOG operation is on. After reaching 
the target speed, operates with the target speed.   

  
02EH - - 
02FH - - 
030H - - 
031H - - 
032H - - 

033H 
Emergency stop 
deceleration 
time 

When the emergency stop is requested by I/O, it will be valid, and the deceleration 
operation will complete in this deceleration time.  

  
034H - - 

035H 
Limit stop 
deceleraiton 
time 

When the limit is input, the deceleration operation will complete in this deceleration 
time.  

  
036H - - 

037H 
Error stop 
deceleration 
time 

When an error occurred, it will be valid, and the deceleration operation will 
complete in this deceleration time.  

  

038H Pulser operation 
setting code 

Specify one pulser among 1 to 3 for the input, for the case that pulser operation is 
requested by I/O.  
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

039H Pulser operation 
ratio numerator 

Sets the multiplier for the input pulse string in the pulser operation.  
(Number of command pulses) = (Pulse strings of input from pulser) x (Numerator of 
ratio of pulser operation) / (Denominator of ratio of pulser operation).   

  

03AH 
Pulser operation 
ratio 
denominator 

Sets the divisor for the input pulse string in the pulser operation.  
(Number of command pulses) = (Pulse strings of input from pulser) x (Denominator 
of ratio of pulser operation) / (Numerator of ratio of pulser operation).  

  

03BH Pulse operation 
method 

Set the single or interpolation operation pattern for the positioning operation.  

  
03CH - - 
03DH - - 
03EH - - 
03FH - - 
040H - - 

041H J point control 
code 

Set the control code of the J point control.  

  

042H 
J point 
acceleration 
time 

043H 
J point 
deceleration 
time 

Set the acceleration/deceleration time of the J point control.  

  
044H 

045H 
J point target 
speed 

Set the target speed of the J point control.  

  
046H - - 
047H - - 
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Offset 
address 

Name Descriptions 
Default 
value 

Setting 
range 

Unit 

048H 

049H 

Pulser operation 
maximum speed

The maximum speed when selecting the speed limit for the pulser operation 
method. 
When the speed calculated by multiplying (pulser operation numerator / pulser 
operation denominator) by the pulser input is ver the specified maximum speed, 
the operation is performed at the maximum speed. 
 
Unit: Set unit X1000/s 
Input range: 0 to 32767000 (pulse/s) 
Default: 0 
 
* If this area has been set to 0, it is the minimum speed in the set unit. 

04AH 
04BH 

Coordinate 
origin value Stores the coordinate origin value after the home return. 

04CH - - 
04DH - - 
04EH - - 
04FH - - 

 
 
Starting address of each positioning parameter 

Axis 1 Axis 2 Axis 3 Axis 4 
Bank No. Address Descriptions 

02H 0CH 16H 20H 050H Starting address of parameters 
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17.6.3 Positioning Data Setting Areas 
They are the areas for setting positioning data. The positioning data for 4 axes can be set individually. 
The positioning data is stored in the table format of 625 points per axis. 
 
When executing the automatic operation (position control) with the positioning unit, specify the number of 
the positioning table that has been specified in advance, and start the position control. After the start-up, 
the motor is automatically controlled according to the settings of the table. There are the method that 
creates the positioning table using Configurator PM that is an exclusive setting tool, and the other 
method that writes the positioning table in a prescribed address by programs. 
There are the standard area of 600 points that is specified by No. 1 to 600, and the extended area of 25 
points that is specified by No. 10001 to 10025. 
 
The standard area is used when the setting values of the positioning table are predetermined. It can be 
set using Configurator PM, and can be rewritten from the programs, too. However, if the positioning table 
is changed by the program, the caulculation is necessary to restructure the positioning data before 
executing the automatic operation. This function enables to read the positioning data of 600 points in 
advance and to prepare for the start-up within the positioning unit, and enables to shorten the start-up 
time for the positioning. When using Configurator PM to download the positioning data, the data is 
restructured automatically, so the calculation is not necessary. However, the calculation is necessary 
after rewriting the poisitoning data from the program.  The procedures for the calculation are as follows. 
1. Change the positioning table in the shared memory. 
2. Turn on the recalculation request contact (Y87) in the I/O area. 
3. Confirm the recalculation done contact (X7) is on (Confim the completion of the recalculation.) 
 
If the data is not recalculated after rewriting the positioning table by the ladder program, note that the 
operation will be executed with the positioning table before the rewriting. 
 
The extended area is used when the setting values of the positioning table cannot be determined until 
just before executing the positioning operation. For example, in the application of alignment using an 
image processing, the moving distance is determined by the image processing. Therefore, the 
positioning table cannot be determined until just before sarting the positioning operation. In that case, the 
positioning table is set just before the start-up of the positioning. In the extended area, the positioning 
table can be rewritten as needed, and the recalculation is not necessary. However, it is up to 25 tables, 
and Configurator PM cannot be used. The programs should be used to write the positioning table in the 
prescribed address in the shared memory. The start-up time is longer than the standard area, and when 
performing the P point control or C point control in the extended area, note that the start-up time varies 
depending on the number of tables to be executed consecutively.  
 
How to use each area and the precautions are as below. 

 How to use Number 
of points 

Table 
number

Setting using 
Configurator PM

Setting using 
ladder program 

Standard 
area 

Area to be used when 
the setting value of the 
positioning table is 
predetermined.  

600 
points 1 to 600 Available 

Available 
(Calculation for 
restructuring is 
necessary.) 

Extended 
area 

Area to be used when 
the setting value of the 
positioning table cannot 
be determined until just 
before executing the 
positioning operation. 

25 points 
10001 
to 
10025 

Not available 

Available 
(Calculation for 
restructuring is 
not necessary.) 
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Positioning tables 
Data in the following formats is stored from the starting address of positioning tables of each axis. 

Offset 
address 

Name Descriptions 

000H Control code 

Sets the position setting mode and acceleration/deceleration pattern for the 
positioning operation.  

  

001H Operation 
pattern 

Sets the independent and interpolation patterns for the positioning operation. 
The relation of the inerpolation depends on the settings in the axis group setting 
area in the common area of the shared memroy. 
In the interpolation operation, the setting for the axis with the smallest number in 
an axis group is effective.  

  
002H - - 
003H - - 

004H 
Positioning 
acceleration 
time 

005H 
Positioning 
deceleration 
time 

Sets the acceleration and deceleration time for the positioning operation. 
The acceleration time and deceleration time can be set individually. 
In the interpolation operation, the setting for the axis with the smallest number in 
an axis group is effective.  

  

006H 

007H 

Positioning 
target speed 
(interpolation 
speed) 

In case of the individual operation (no interpolation), it is the target speed of the 
corresponding axis. In case of the interpolation operaiton, it is the target speed of 
the interpolation. 
In the interpolation operation, the target speed for the axis of the smallest number 
in a group is valid.  
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Offset 
address 

Name Descriptions 

008H 

009H 

Positioning 
movement 
amount 

The area to set the movement amount for the positioning operation. 
The interpretation is chagned for the increment movement amount or absolute 
coordiate by the control code setting.  

  

00AH 

00BH 

Auxiliary point 

The area to set the auxiliary points (center poijnt, pass point coordinates) in case 
of the circular interpolation or spiral interpolation control.  

  

00CH Dwell time 

After the completion of the positioning control of this table, 
when the mode is C: Continuation point, stops the motor operation for the dwell 
time and starts the operation of the next table. 
when the mode is P: Pass point, this setting is ignored. 
when the mode is E: End point, the positioning done contact will turn on after 
waiting for the dwell time.  

  

00DH Auxiliary output 
code 

Sets the data to be output to the auxiliary output code in each axis information & 
monitor area by the setting of the auxiliary output mode in the parameter setting 
area.  

  
00EH - - 
00DH - - 
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Starting address of each positioning table 
Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

050H Starting address of table 1 
060H Starting address of table 2 
070H Starting address of table 3 
080H Starting address of table 4 
090H Starting address of table 5 
0A0H Starting address of table 6 
0B0H Starting address of table 7 
0C0H Starting address of table 8 
0D0H Starting address of table 9 
0E0H Starting address of table 10 
0F0H Starting address of table 11 
100H Starting address of table 12 
110H Starting address of table 13 
120H Starting address of table 14 
130H Starting address of table 15 
140H Starting address of table 16 
150H Starting address of table 17 
160H Starting address of table 18 
170H Starting address of table 19 
180H Starting address of table 20 
190H Starting address of table 21 
1A0H Starting address of table 22 
1B0H Starting address of table 23 
1C0H Starting address of table 24 
1D0H Starting address of table 25 
1E0H Starting address of table 26 
1F0H Starting address of table 27 
200H Starting address of table 28 
210H Starting address of table 29 
220H Starting address of table 30 
230H Starting address of table 31 
240H Starting address of table 32 
250H Starting address of table 33 
260H Starting address of table 34 
270H Starting address of table 35 
280H Starting address of table 36 
290H Starting address of table 37 
2A0H Starting address of table 38 
2B0H Starting address of table 39 
2C0H Starting address of table 40 
2D0H Starting address of table 41 
2E0H Starting address of table 42 
2F0H Starting address of table 43 
300H Starting address of table 44 
310H Starting address of table 45 
320H Starting address of table 46 
330H Starting address of table 47 
340H Starting address of table 48 
350H Starting address of table 49 
360H Starting address of table 50 
370H Starting address of table 51 
380H Starting address of table 52 
390H Starting address of table 53 
3A0H Starting address of table 54 
3B0H Starting address of table 55 
3C0H Starting address of table 56 
3D0H Starting address of table 57 
3E0H Starting address of table 58 

02H 0CH 16H 20H 

3F0H Starting address of table 59 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 60 
010H Starting address of table 61 
020H Starting address of table 62 
030H Starting address of table 63 
040H Starting address of table 64 
050H Starting address of table 65 
060H Starting address of table 66 
070H Starting address of table 67 
080H Starting address of table 68 
090H Starting address of table 69 
0A0H Starting address of table 70 
0B0H Starting address of table 71 
0C0H Starting address of table 72 
0D0H Starting address of table 73 
0E0H Starting address of table 74 
0F0H Starting address of table 75 
100H Starting address of table 76 
110H Starting address of table 77 
120H Starting address of table 78 
130H Starting address of table 79 
140H Starting address of table 80 
150H Starting address of table 81 
160H Starting address of table 82 
170H Starting address of table 83 
180H Starting address of table 84 
190H Starting address of table 85 
1A0H Starting address of table 86 
1B0H Starting address of table 87 
1C0H Starting address of table 88 
1D0H Starting address of table 89 
1E0H Starting address of table 90 
1F0H Starting address of table 91 
200H Starting address of table 92 
210H Starting address of table 93 
220H Starting address of table 94 
230H Starting address of table 95 
240H Starting address of table 96 
250H Starting address of table 97 
260H Starting address of table 98 
270H Starting address of table 99 
280H Starting address of table 100 
290H Starting address of table 101 
2A0H Starting address of table 102 
2B0H Starting address of table 103 
2C0H Starting address of table 104 
2D0H Starting address of table 105 
2E0H Starting address of table 106 
2F0H Starting address of table 107 
300H Starting address of table 108 
310H Starting address of table 109 
320H Starting address of table 110 
330H Starting address of table 111 
340H Starting address of table 112 
350H Starting address of table 113 
360H Starting address of table 114 
370H Starting address of table 115 
380H Starting address of table 116 
390H Starting address of table 117 
3A0H Starting address of table 118 
3B0H Starting address of table 119 
3C0H Starting address of table 120 
3D0H Starting address of table 121 
3E0H Starting address of table 122 

03H 0DH 17H 21H 

3F0H Starting address of table 123 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 124 
010H Starting address of table 125 
020H Starting address of table 126 
030H Starting address of table 127 
040H Starting address of table 128 
050H Starting address of table 129 
060H Starting address of table 130 
070H Starting address of table 131 
080H Starting address of table 132 
090H Starting address of table 133 
0A0H Starting address of table 134 
0B0H Starting address of table 135 
0C0H Starting address of table 136 
0D0H Starting address of table 137 
0E0H Starting address of table 138 
0F0H Starting address of table 139 
100H Starting address of table 140 
110H Starting address of table 141 
120H Starting address of table 142 
130H Starting address of table 143 
140H Starting address of table 144 
150H Starting address of table 145 
160H Starting address of table 146 
170H Starting address of table 147 
180H Starting address of table 148 
190H Starting address of table 149 
1A0H Starting address of table 150 
1B0H Starting address of table 151 
1C0H Starting address of table 152 
1D0H Starting address of table 153 
1E0H Starting address of table 154 
1F0H Starting address of table 155 
200H Starting address of table 156 
210H Starting address of table 157 
220H Starting address of table 158 
230H Starting address of table 159 
240H Starting address of table 160 
250H Starting address of table 161 
260H Starting address of table 162 
270H Starting address of table 163 
280H Starting address of table 164 
290H Starting address of table 165 
2A0H Starting address of table 166 
2B0H Starting address of table 167 
2C0H Starting address of table 168 
2D0H Starting address of table 169 
2E0H Starting address of table 170 
2F0H Starting address of table 171 
300H Starting address of table 172 
310H Starting address of table 173 
320H Starting address of table 174 
330H Starting address of table 175 
340H Starting address of table 176 
350H Starting address of table 177 
360H Starting address of table 178 
370H Starting address of table 179 
380H Starting address of table 180 
390H Starting address of table 181 
3A0H Starting address of table 182 
3B0H Starting address of table 183 
3C0H Starting address of table 184 
3D0H Starting address of table 185 
3E0H Starting address of table 186 

04H 0EH 18H 22H 

3F0H Starting address of table 187 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 188 
010H Starting address of table 189 
020H Starting address of table 190 
030H Starting address of table 191 
040H Starting address of table 192 
050H Starting address of table 193 
060H Starting address of table 194 
070H Starting address of table 195 
080H Starting address of table 196 
090H Starting address of table 197 
0A0H Starting address of table 198 
0B0H Starting address of table 199 
0C0H Starting address of table 200 
0D0H Starting address of table 201 
0E0H Starting address of table 202 
0F0H Starting address of table 203 
100H Starting address of table 204 
110H Starting address of table 205 
120H Starting address of table 206 
130H Starting address of table 207 
140H Starting address of table 208 
150H Starting address of table 209 
160H Starting address of table 210 
170H Starting address of table 211 
180H Starting address of table 212 
190H Starting address of table 213 
1A0H Starting address of table 214 
1B0H Starting address of table 215 
1C0H Starting address of table 216 
1D0H Starting address of table 217 
1E0H Starting address of table 218 
1F0H Starting address of table 219 
200H Starting address of table 220 
210H Starting address of table 221 
220H Starting address of table 222 
230H Starting address of table 223 
240H Starting address of table 224 
250H Starting address of table 225 
260H Starting address of table 226 
270H Starting address of table 227 
280H Starting address of table 228 
290H Starting address of table 229 
2A0H Starting address of table 230 
2B0H Starting address of table 231 
2C0H Starting address of table 232 
2D0H Starting address of table 233 
2E0H Starting address of table 234 
2F0H Starting address of table 235 
300H Starting address of table 236 
310H Starting address of table 237 
320H Starting address of table 238 
330H Starting address of table 239 
340H Starting address of table 240 
350H Starting address of table 241 
360H Starting address of table 242 
370H Starting address of table 243 
380H Starting address of table 244 
390H Starting address of table 245 
3A0H Starting address of table 246 
3B0H Starting address of table 247 
3C0H Starting address of table 248 
3D0H Starting address of table 249 
3E0H Starting address of table 250 

05H 0FH 19H 23H 

3F0H Starting address of table 251 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 252 
010H Starting address of table 253 
020H Starting address of table 254 
030H Starting address of table 255 
040H Starting address of table 256 
050H Starting address of table 257 
060H Starting address of table 258 
070H Starting address of table 259 
080H Starting address of table 260 
090H Starting address of table 261 
0A0H Starting address of table 262 
0B0H Starting address of table 263 
0C0H Starting address of table 264 
0D0H Starting address of table 265 
0E0H Starting address of table 266 
0F0H Starting address of table 267 
100H Starting address of table 268 
110H Starting address of table 269 
120H Starting address of table 270 
130H Starting address of table 271 
140H Starting address of table 272 
150H Starting address of table 273 
160H Starting address of table 274 
170H Starting address of table 275 
180H Starting address of table 276 
190H Starting address of table 277 
1A0H Starting address of table 278 
1B0H Starting address of table 279 
1C0H Starting address of table 280 
1D0H Starting address of table 281 
1E0H Starting address of table 282 
1F0H Starting address of table 283 
200H Starting address of table 284 
210H Starting address of table 285 
220H Starting address of table 286 
230H Starting address of table 287 
240H Starting address of table 288 
250H Starting address of table 289 
260H Starting address of table 290 
270H Starting address of table 291 
280H Starting address of table 292 
290H Starting address of table 293 
2A0H Starting address of table 294 
2B0H Starting address of table 295 
2C0H Starting address of table 296 
2D0H Starting address of table 297 
2E0H Starting address of table 298 
2F0H Starting address of table 299 
300H Starting address of table 300 
310H Starting address of table 301 
320H Starting address of table 302 
330H Starting address of table 303 
340H Starting address of table 304 
350H Starting address of table 305 
360H Starting address of table 306 
370H Starting address of table 307 
380H Starting address of table 308 
390H Starting address of table 309 
3A0H Starting address of table 310 
3B0H Starting address of table 311 
3C0H Starting address of table 312 
3D0H Starting address of table 313 
3E0H Starting address of table 314 

06H 10H 1AH 24H 

3F0H Starting address of table 315 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 316 
010H Starting address of table 317 
020H Starting address of table 318 
030H Starting address of table 319 
040H Starting address of table 320 
050H Starting address of table 321 
060H Starting address of table 322 
070H Starting address of table 323 
080H Starting address of table 324 
090H Starting address of table 325 
0A0H Starting address of table 326 
0B0H Starting address of table 327 
0C0H Starting address of table 328 
0D0H Starting address of table 329 
0E0H Starting address of table 330 
0F0H Starting address of table 331 
100H Starting address of table 332 
110H Starting address of table 333 
120H Starting address of table 334 
130H Starting address of table 335 
140H Starting address of table 336 
150H Starting address of table 337 
160H Starting address of table 338 
170H Starting address of table 339 
180H Starting address of table 340 
190H Starting address of table 341 
1A0H Starting address of table 342 
1B0H Starting address of table 343 
1C0H Starting address of table 344 
1D0H Starting address of table 345 
1E0H Starting address of table 346 
1F0H Starting address of table 347 
200H Starting address of table 348 
210H Starting address of table 349 
220H Starting address of table 350 
230H Starting address of table 351 
240H Starting address of table 352 
250H Starting address of table 353 
260H Starting address of table 354 
270H Starting address of table 355 
280H Starting address of table 356 
290H Starting address of table 357 
2A0H Starting address of table 358 
2B0H Starting address of table 359 
2C0H Starting address of table 360 
2D0H Starting address of table 361 
2E0H Starting address of table 362 
2F0H Starting address of table 363 
300H Starting address of table 364 
310H Starting address of table 365 
320H Starting address of table 366 
330H Starting address of table 367 
340H Starting address of table 368 
350H Starting address of table 369 
360H Starting address of table 370 
370H Starting address of table 371 
380H Starting address of table 372 
390H Starting address of table 373 
3A0H Starting address of table 374 
3B0H Starting address of table 375 
3C0H Starting address of table 376 
3D0H Starting address of table 377 
3E0H Starting address of table 378 

07H 11H 1BH 25H 

3F0H Starting address of table 379 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 380 
010H Starting address of table 381 
020H Starting address of table 382 
030H Starting address of table 383 
040H Starting address of table 384 
050H Starting address of table 385 
060H Starting address of table 386 
070H Starting address of table 387 
080H Starting address of table 388 
090H Starting address of table 389 
0A0H Starting address of table 390 
0B0H Starting address of table 391 
0C0H Starting address of table 392 
0D0H Starting address of table 393 
0E0H Starting address of table 394 
0F0H Starting address of table 395 
100H Starting address of table 396 
110H Starting address of table 397 
120H Starting address of table 398 
130H Starting address of table 399 
140H Starting address of table 400 
150H Starting address of table 401 
160H Starting address of table 402 
170H Starting address of table 403 
180H Starting address of table 404 
190H Starting address of table 405 
1A0H Starting address of table 406 
1B0H Starting address of table 407 
1C0H Starting address of table 408 
1D0H Starting address of table 409 
1E0H Starting address of table 410 
1F0H Starting address of table 411 
200H Starting address of table 412 
210H Starting address of table 413 
220H Starting address of table 414 
230H Starting address of table 415 
240H Starting address of table 416 
250H Starting address of table 417 
260H Starting address of table 418 
270H Starting address of table 419 
280H Starting address of table 420 
290H Starting address of table 421 
2A0H Starting address of table 422 
2B0H Starting address of table 423 
2C0H Starting address of table 424 
2D0H Starting address of table 425 
2E0H Starting address of table 426 
2F0H Starting address of table 427 
300H Starting address of table 428 
310H Starting address of table 429 
320H Starting address of table 430 
330H Starting address of table 431 
340H Starting address of table 432 
350H Starting address of table 433 
360H Starting address of table 434 
370H Starting address of table 435 
380H Starting address of table 436 
390H Starting address of table 437 
3A0H Starting address of table 438 
3B0H Starting address of table 439 
3C0H Starting address of table 440 
3D0H Starting address of table 441 
3E0H Starting address of table 442 

08H 12H 1CH 26H 

3F0H Starting address of table 443 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 444 
010H Starting address of table 445 
020H Starting address of table 446 
030H Starting address of table 447 
040H Starting address of table 448 
050H Starting address of table 449 
060H Starting address of table 450 
070H Starting address of table 451 
080H Starting address of table 452 
090H Starting address of table 453 
0A0H Starting address of table 454 
0B0H Starting address of table 455 
0C0H Starting address of table 456 
0D0H Starting address of table 457 
0E0H Starting address of table 458 
0F0H Starting address of table 459 
100H Starting address of table 460 
110H Starting address of table 461 
120H Starting address of table 462 
130H Starting address of table 463 
140H Starting address of table 464 
150H Starting address of table 465 
160H Starting address of table 466 
170H Starting address of table 467 
180H Starting address of table 468 
190H Starting address of table 469 
1A0H Starting address of table 470 
1B0H Starting address of table 471 
1C0H Starting address of table 472 
1D0H Starting address of table 473 
1E0H Starting address of table 474 
1F0H Starting address of table 475 
200H Starting address of table 476 
210H Starting address of table 477 
220H Starting address of table 478 
230H Starting address of table 479 
240H Starting address of table 480 
250H Starting address of table 481 
260H Starting address of table 482 
270H Starting address of table 483 
280H Starting address of table 484 
290H Starting address of table 485 
2A0H Starting address of table 486 
2B0H Starting address of table 487 
2C0H Starting address of table 488 
2D0H Starting address of table 489 
2E0H Starting address of table 490 
2F0H Starting address of table 491 
300H Starting address of table 492 
310H Starting address of table 493 
320H Starting address of table 494 
330H Starting address of table 495 
340H Starting address of table 496 
350H Starting address of table 497 
360H Starting address of table 498 
370H Starting address of table 499 
380H Starting address of table 500 
390H Starting address of table 501 
3A0H Starting address of table 502 
3B0H Starting address of table 503 
3C0H Starting address of table 504 
3D0H Starting address of table 505 
3E0H Starting address of table 506 

09H 13H 1DH 27H 

3F0H Starting address of table 507 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 508 
010H Starting address of table 509 
020H Starting address of table 510 
030H Starting address of table 511 
040H Starting address of table 512 
050H Starting address of table 513 
060H Starting address of table 514 
070H Starting address of table 515 
080H Starting address of table 516 
090H Starting address of table 517 
0A0H Starting address of table 518 
0B0H Starting address of table 519 
0C0H Starting address of table 520 
0D0H Starting address of table 521 
0E0H Starting address of table 522 
0F0H Starting address of table 523 
100H Starting address of table 524 
110H Starting address of table 525 
120H Starting address of table 526 
130H Starting address of table 527 
140H Starting address of table 528 
150H Starting address of table 529 
160H Starting address of table 530 
170H Starting address of table 531 
180H Starting address of table 532 
190H Starting address of table 533 
1A0H Starting address of table 534 
1B0H Starting address of table 535 
1C0H Starting address of table 536 
1D0H Starting address of table 537 
1E0H Starting address of table 538 
1F0H Starting address of table 539 
200H Starting address of table 540 
210H Starting address of table 541 
220H Starting address of table 542 
230H Starting address of table 543 
240H Starting address of table 544 
250H Starting address of table 545 
260H Starting address of table 546 
270H Starting address of table 547 
280H Starting address of table 548 
290H Starting address of table 549 
2A0H Starting address of table 550 
2B0H Starting address of table 551 
2C0H Starting address of table 552 
2D0H Starting address of table 553 
2E0H Starting address of table 554 
2F0H Starting address of table 555 
300H Starting address of table 556 
310H Starting address of table 557 
320H Starting address of table 558 
330H Starting address of table 559 
340H Starting address of table 560 
350H Starting address of table 561 
360H Starting address of table 562 
370H Starting address of table 563 
380H Starting address of table 564 
390H Starting address of table 565 
3A0H Starting address of table 566 
3B0H Starting address of table 567 
3C0H Starting address of table 568 
3D0H Starting address of table 569 
3E0H Starting address of table 570 

0AH 14H 1EH 28H 

3F0H Starting address of table 571 
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 Axis 1 Axis 2 Axis 3 Axis 4   
Bank No. Address Descriptions 

000H Starting address of table 572 
010H Starting address of table 573 
020H Starting address of table 574 
030H Starting address of table 575 
040H Starting address of table 576 
050H Starting address of table 577 
060H Starting address of table 578 
070H Starting address of table 579 
080H Starting address of table 580 
090H Starting address of table 581 
0A0H Starting address of table 582 
0B0H Starting address of table 583 
0C0H Starting address of table 584 
0D0H Starting address of table 585 
0E0H Starting address of table 586 
0F0H Starting address of table 587 
100H Starting address of table 588 
110H Starting address of table 589 
120H Starting address of table 590 
130H Starting address of table 591 
140H Starting address of table 592 
150H Starting address of table 593 
160H Starting address of table 594 
170H Starting address of table 595 
180H Starting address of table 596 
190H Starting address of table 597 
1A0H Starting address of table 598 
1B0H Starting address of table 599 
1C0H Starting address of table 600 
1D0H - 
1E0H - 
1F0H - 
200H - 
210H - 
220H - 
230H - 
240H - 
250H - 
260H - 
270H Starting address of table 10001 
280H Starting address of table 10002 
290H Starting address of table 10003 
2A0H Starting address of table 10004 
2B0H Starting address of table 10005 
2C0H Starting address of table 10006 
2D0H Starting address of table 10007 
2E0H Starting address of table 10008 
2F0H Starting address of table 10009 
300H Starting address of table 10010 
310H Starting address of table 10011 
320H Starting address of table 10012 
330H Starting address of table 10013 
340H Starting address of table 10014 
350H Starting address of table 10015 
360H Starting address of table 10016 
370H Starting address of table 10017 
380H Starting address of table 10018 
390H Starting address of table 10019 
3A0H Starting address of table 10020 
3B0H Starting address of table 10021 
3C0H Starting address of table 10022 
3D0H Starting address of table 10023 
3E0H Starting address of table 10024 

0BH 15H 1FH 29H 

3F0H Starting address of table 10025  
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18.1 FP2 Positioning Unit (Interpolation Type) 
2-axis type 

 
(Unit: mm) 

 

4-axis type 

 
(Unit: mm) 
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19.1 Basic Configuration and Contact Allocations of 
Sample Programs 
In the sample programs, the internal relays are used for the start-up contacts of each operation. 
If necessary, reconnect them to the input contacts that switches, etc are connected. 
 
Basic Configuration 
 

 
 
The positioning unit is installed in the slot 0. Stepping motors are connected to the first and second axes 
of the positioning unit, and the linear interpolation of 2 axes is designated as a sample operation.  
Also, the parameters for each axis are specified by Configurator PM, and they will be stored in the 
positioning unit. 
 
Used contacts and data registers 

Number Descriptions 
R2 Request home return 
R3 Request positioning start 
R4 Request forward JOG for axis 1 
R5 Request reverse JOG for axis 1 
R6 Request forward JOG for axis 2 
R7 Request reverse JOG for axis 2 
R10 Error clear 
R11 Request setting value change 
R100 Operation enabled flag for axis 1 
R101 Off edge of forward JOG for axis 1 
R102 Off edge of reverse JOG for axis 1 
R200 Operation enabled flag for axis 2 
R201 Off edge of forward JOG for axis 2 
R202 Off edge of reverse JOG for axis 2 
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Number Descriptions 

X0 Unit preparation ready 
X4 Tool operation for all axes 
X7 Recalculation done flag 

X18 Busy flag for axis 1 
X19 Busy flag for axis 2 
X60 Error occurrence annunciation for axis 1 
X61 Error occurrence annunciation for axis 2 
Y87 Request recalculation 
Y90 Positioning start for axis 1 
Y98 Home return for axis 1 
Y99 Home return for axis 2 

Y100 Forward JOG for axis 1 
Y101 Reverse JOG for axis 1 
Y102 Forward JOG for axis 2 
Y103 Reverse JOG for axis 2 
Y140 Error clear for axis 1 
Y141 Error clear for axis 2 

 
Number Descriptions 

DT0 Starting table number 
DT101 Number of errors of axis 1 
DT102 to DT115 Error contents of axis 1 
DT121 Number of errors of axis 2 
DT122 to DT135 Error contents of axis 2 
DT10 to DT25 Positioning data (of 1 table) of axis 1 
DT30 to DT45 Positioning data (of 1 table) of axis 2 

 
 



19-4 

19.2 Sample Programs 
There are 3 patterns for setting positioning data. 
1. When the positioning data has been already set in the standard area with the Configurator PM. 
2. When setting the positioning data in the extended area with the program. 
3. When setting the positioning data in the standard area with the program. 
 
Sample program 
The positioning start is the setting that has been already set in the standard area by the Configurator 
PM. 
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19.2.1 When Setting Positioning Data in Extended Area Using Program 
Write positioning data in the extended area using the program. 
Recalculating the positioning data is not necessary as the extended area is used. 
 
Replace the part of the positioning start program in the sample program 
Positioning start program 
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19.2.2 When Setting Positioning Data in Standard Area Using Program 
Write positioning data in the standard area using the program. 
Recalculating the positioning data is necessary after setting the positioining data. 
 
Replace the part of the positioning start program in the sample program 
Positioning start program 
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Chapter 20 
 Driver Wiring 



20.1 Wiring for Motor Driver 

20.1.1 Panasonic MINAS A/A4 Series 

 
 
* When connecting the CW drive disabled and CCW drive disabled input, the servo ready output, and the 

servo alarm output on the motor driver side, the circuits recommended by the various motor 
manufacturers should be used. 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 

 
The above wiring is for the line driver output type. 
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20.1.2 Panasonic MINAS S Series / E Series 
 

＋24V

GND

＋24Ｖ

GND

DC

A1(A10)

B1(B10)
A2(A11)

B2(B11)
A4(A13)

B3(B12)
A7(A16)

B7(B16)

B4(B13)
COM

DOG
A5(A14)

A6(A15)

B6(B15)

A20

B20

PULS 1
22

PULS 2
23

SIGN 1
24

SIGN 2
25

OZ ＋

19

OZ －

20

COM ＋

1

CL
4

SRV－ON

2

A－CLR

3

※CWL

7

※CCWL
8

※ALM
9

COIN
10

COM－

13

220Ω

220Ω

4.7kΩ

4.7kΩ

4.7kΩ

4.7kΩ

4.7kΩ

Limit (+)

Limit (-)

Positioning unit

Pulse output A

Pulse output B

Home input

Deviation counter clear

Near home
input

Power
supply for
driving the
internal
circuit

Power
supply
circuit

24 V DC Power supply

Over limit
input

Over limit
input

(+)

(-)

Input to PLC

Input to PLC

Output from PLC

Output from PLC

Positioning
done signal

Servo alarm
output

CCW drive
disable

CW drive
disable

Alarm clear

Servo ON

Deviation
counter clear

Z phase
output

CCW pulse input

CW pulse input

Servo amplifier

 
 
* When connecting the CW drive disabled and CCW drive disabled input and the servo alarm output on 

the motor driver side, the circuits recommended by the various motor manufacturers should be used. 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 

 
The above wiring is for the line driver output type.  



20.1.3 Panasonic MINAS EX Series 
 

 
 
 
* When connecting the CW drive disabled and CCW drive disabled input and the servo alarm output on 

the motor driver side, the circuits recommended by the various motor manufacturers should be used. 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 

 
The above wiring is for the line driver output type. 
 
As of October 2008, this is the end-of-life (EOL) product. 
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20.1.4  Panasonic MINAS X（XX）Series 

  
* When connecting the CW drive disabled and CCW drive disabled input, the servo ready output, and the 

servo alarm output on the motor driver side, the circuits recommended by the various motor 
manufacturers should be used. 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 

 
The above wiring is for the line driver output type. 
 
As of October 2008, this is the end-of-life (EOL) product. 
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20.1.5  Panasonic MINAS X (V) Series 

  
* When connecting the CW drive disabled and CCW drive disabled input, the servo ready output, and the 

servo alarm output on the motor driver side, the circuits recommended by the various motor 
manufacturers should be used. 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 

 
The above wiring is for the line driver output type. 
 
As of October 2008, this is the end-of-life (EOL) product. 
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20.1.6 Combination with MINAS Motor 

When using FP2 Positioning Unit with MINAS Motor, an easy-connectable “Motor driver I/F 
terminal” is recommended.  
 

 Reference: < Motor driver I/F terminal catalog > 
 
Unit type and available MINAS motor 

 
Motor driver 
I/F terminal 

Connection 
cable used 

with a 
positioning 

unit 

MINAS 
A series 

MINAS 
S series 
E series 

MINAS 
A series 

FP2 positioning 
unit 
(Interpolation 
type) 
AFP243711, 
243721 

Motor driver 
I/F terminal Ⅱ 
1-axis type:  
AFP8503 
2-axis type:  
AFP8504 
 

FP2 positioning
connection 
cable 
 
0.5 mm: 
AFP85100 
 
1 mm: 
AFP85101 

Dedicated cable 
for AⅢ series 
1 m:  
AFP85131 
2 m: 
AFP85132  

Dedicated cable 
for S series 
1 m:  
AFP85141 
2 m: 
AFP85142 

Dedicated cable 
for AⅢ series 
1 m:  
AFP85131 
2 m: 
AFP85132 

 
 



20.1.7 Oriental Motor UPK-W Series 
 

 
 
 
 
Numbers in parentheses after the unit side indicate the pin number for the second or fourth axis. 
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